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Level 1 - Beginner Training

STK Level 1 - Beginner training is designed to familiarize first-time users with STK workflow and provide a basic
understanding of STK software capabilities. This training is designed to enable you to model and incorporate
your own systems and missions throughout the lessons.

Evaluation license
This training covers the basics of STK that can be completed with an Evaluation license.
The Level 1 - Beginner training is a series of tutorials designed to get you started using STK.

Once you have completed these tutorials, you will be ready to take the free Level 1 STK Certification test! Visit
www.agi.com/training-and-certification#cert/.

Tutorial Capabilities Required Required
License Install
Lesson One: Build Scenarios STK Pro STK Pro, STK STK Pro
(Design Reference Missions Premium (Air or
(DRM)) Learn how to create a Space), or STK
scenario in STK. Enterprise
Lesson Two: Objects and STK Pro STK Pro, STK STK Pro
Properties Learn how to add Premium (Air or
STK objects to a scenario and Space), or STK
modify them. Enterprise
Lesson Three: Access Report STK Pro STK Pro, STK STK Pro
and Graphs Learn how to Premium (Air or
compute access between objects Space), or STK
and generate reports on scenario Enterprise
data.
Lesson Four: Movies and STK Pro STK Pro, STK STK Pro
Visual Data Files Learn how to Premium (Air or
make a movie in STK. Space), or STK
Enterprise
Lesson Five: Introduction to STK Pro STK Pro, STK STK Pro

Connect Learn how to send
Connect commands in STK.

Note: For the STK 10 version of this training, visit

http://help.agi.com/StartTraining/StartTraining1013.htm
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Part 1: Build Scenarios

§ Note: Visit help.agi.com/stk/#training/Day10Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Engineers and operators need an environment to quickly model and simulate their missions both analytically
and visually.

Solution

Systems Tool Kit (STK) provides a physics-based simulation environment for digital mission engineering. Your
system and component models can interact in STK, enabling you to measure their performance in the context of
the complete mission.

Setting up a new STK scenario

Create a new STK Scenario (ﬁ) object using the STK: New Scenario Wizard tool. The Scenario object defines
the context in which the properties and behavior of other objects are defined.

1. Click &8 Create a Scenario in the Welcome to STK dialog box.
2. You can use the Central Body: selection, which defaults to Earth, to change the scenario's central body.

3. Enter the following in the STK: New Scenario Wizard:

Option Description

Name STK_NewScenario

Description This is my first STK scenario.

Location STK Default Directory (e.g., C:\Users\username\Documents\12).
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Start Default Start Time

Stop + 24 hrs

4. Click OK when you finish.

Saving the scenario
When the scenario first opens or when you complete a set of steps, you should Save (=l) the scenario.

—
1. Click Save () when the scenario loads. STK creates a folder with the same name as your scenario for
you.

2. Verify the scenario name and location in the Save As window.
3. Click Save.

4. Click Close inthe Insert STK Objects tool.

The STK workspace

The STK workspace offers many ways for you to organize and interact with its many varied windows. At the
completion of this tutorial, practice workspace customization.

1. Extend the View menu.
2. Hover over Toolbars to extend the menu. This is one way to choose the toolbars you require.

3. Right-click in the empty space to the right of the currently available toolbars. This is another way to quickly
enable and disable Menu selections and toolbars.

Understanding the 2D Graphics window

The 2D Graphics window graphically displays information about your scenario. The 2D Graphics window gives
you one giant advantage: you can see the whole central body at one glance.
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Grab Globe

When activated, Grab Globe enables you to move or pan the central body in grab mode. Grab Globe is enabled
by default.

1. Click Grab Globe (imﬂ") in the 2D Graphics Defaults toolbar if it's not enabled.
2. To pan, place your cursor on the 2D Graphics window map.

3. Hold the left mouse button and drag the mouse around the 2D Graphics window.

Zoom In

Zoom In brings the view closer to the selected area and changes the map center. Each time you zoom in, it adds
one zoom level to the zoom stack.

1. Click Zoom In (E’l) in the 2D Graphics Defaults toolbar.
Place your cursor on the 2D Graphics window map.

Hold down the left mouse button.

> N

Drag your mouse cursor across the area of the 2D map window you want to zoom. This draws a box around
the area of interest.

5. Release the left mouse button.

Zoom Out

Zoom Out widens the view of the 2D Graphics window one zoom level per click.
1. Click Zoom Out (EL) in the 2D Graphics Defaults toolbar to zoom out of the 2D window one zoom level.

2. You can continue to click Zoom Out (El) until the 2D map fills the display window.

Mouse scroll wheel

You can zoom in and zoom out using the mouse scroll wheel. Using the mouse scroll wheel does not add any
zoom levels to the zoom stack, so after zooming in using the mouse scroll wheel, hitting Zoom Out zooms all the
way out to a global view.
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1. Place your cursor on the 2D Graphics window map.
2. Move the mouse scroll wheel up to zoom in on the 2D Graphics window map.

3. Move the mouse scroll wheel down to zoom out on the 2D Graphics window map.

Microsoft Bing™ Maps

The Microsoft Bing™ Maps tool displays a background image (Microsoft Bing™ map or Basic.bmp) in 2D
Graphics windows.

1. Click Microsoft Bing™ Map (ﬂ).
2. Try different map styles.

3. When finished, reset the map style to Aerial.

Understanding the 3D Graphics window

STK enables you to view complex information in a 3D Graphics window. You can observe relationships among
space, air, land, and sea objects as they exist in the present as well as in the past and future. Like you did with
the 2D Graphics window, you'll practice using selected tools.

Using the Mouse

In addition to tools available in toolbars, the 3D Graphics window has additional mouse controls that manipulate
the 3D Graphics window. Get familiar with the mouse controls.

1. Double-click the left mouse button on any spot on the globe to display the latitude and longitude of the
selected spot.

Place your cursor on the 3D Graphics window globe.
Hold down the left mouse button and move the mouse around to rotate the globe.
In one motion, hold down the right mouse button and push the mouse away from you to Zoom out.

While holding down the right mouse button, pull the mouse closer to you to Zoom in.

© oA N

Hold down the Shift key and left mouse button while moving the mouse around. This will pan and tilt the
virtual camera.

7. After you pan and tilt in the previous step, release the Shift key and left mouse button.
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8. Hold the left mouse button down and move the mouse around to keep the camera in a fixed point in space
and change its orientation.

3D Graphics window default tools

You can use the mouse to interact with the 3D Graphics window. Most of the tools have functions similar to the
2D Graphics window Defaults Toolbar. You will focus on the Grab Globe and Zoom In tools, but this toolbar also
gives access to Properties, Snap Frame, and Snap Properties.

Zoom In

Zoom In enables you to zoom into a portion of the 3D Graphics window. The camera is then fixed on the center
point of the zoomed in area.

1. Click Home View (%) in the 3D Graphics window toolbar to reset your view. You will become familiar with
Home View (%) in the 3D Graphics Toolbar section of this lesson.

2. Rotate the globe by holding down the left mouse button and moving the mouse around to obtain a view of a
landmass in the 3D Graphics window, such as North America.

3. Click Zoom In (E—l) in the 3D Graphics window Defaults toolbar.

4. Hold down the left mouse button and drag your mouse cursor across the area of the 3D globe you want to
zoom in to, such as the west coast of the United States.

5. Continue to zoom in using the mouse scroll wheel until you're fairly close to the ground.

Grab Globe

Although it is similar to the Grab Globe tool in the 2D Graphics window, there's one important difference. You
need to turn Grab Globe on and use the Shift key along with the left mouse button.

1. Click Grab Globe ({fr?) in the 3D Graphics Defaults toolbar.

2. Hold down the Shift key and the left mouse button and drag the mouse around the 3D Graphics window to
grab the globe and pan.

3. Release the Shift key and left mouse button.

4. Use the mouse scroll wheel to zoom in or out depending on the detail you are trying to obtain.
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5. Hold down the left mouse button and move the mouse around to rotate and tilt the globe. The globe pivots
on the center point of the zoomed in area.

Home View

Home View displays the default view. If you are lost in your view, this is one of your best friends. It will bring you
back to your home view with one click.

1. Use the scroll wheel to zoom in close to the surface of the central body (Earth).

2. Click Home View (@) in the 3D Graphics toolbar to reorient the 3D Graphics camera back on the default
Earth-centered view.

Animation toolbar

The animation tool bar helps you control the progression of your scenario. With a few clicks, you can control the
start time, stop time, and how quickly the scenario progresses from start to stop. Use the animation controls to
play through the scenario.

1. Select the Window menu.
2. Select Tile Vertically.

3. Click Home View (@) in the 3D Graphics toolbar.

4. In the Animation toolbar, click Start ( .' ) to have the scenario animate forward in time from the current
point.

5. Click Pause (Il) to stop the scenario animation.
6. Click Step Forward (I') or Step Backward ('I) to progress one step at a time through the scenario.
7. Click Reverse ( " ) to have the scenario animation rewind from the current point.

%
8. Experiment with increasing (‘) and decreasing (E) the speed of the animation, which by defaultis 10
seconds. This will also affect the time step of Step Forward and Step Backward as well.

9. Atany point, click Reset (I') to have the scenario return to the start time. This does not reset the speed of
the animation.
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Timeline View

Use Timeline View to visualize a variety of time intervals within your scenario. The user interface of the Timeline
View is comprised of a toolbar, three timelines, and rows of time components.

Time Display

The Time Display is the largest and most granular of the timelines. Use the gray pointer to adjust the animation
time to any point within the Time Display's current boundary to visualize time events.

1. Click Home View (%) in the 3D Graphics toolbar to rest the view.
2. Click Zoom Out (EL) in the 2D Graphics Defaults toolbar to zoom out of the 2D window. Click Zoom Out (
EL) as many times as needed until the 2D map fills the display window.

3. While looking at the 2D Graphics or 3D Graphics window, put your cursor on the Gray Pointer (~-') in the
Timeline View.

4. Hold down the left mouse button and slide the Gray Pointer to the right.

5. Notice the globe rotating and the day-night shading on the 2D Graphics window moving as you scroll
through the scenario time period.

6. Click Save ().

Summary

You got a thorough introduction of the STK: New Scenario Wizard and a brief outline of STK tools and windows
such as the Object Browser and the Timeline View. The bulk of the information in this tutorial helped you to
become familiar with the functions and tools of the 2D and 3D Graphics windows. These windows are important
for your situational awareness while using STK.
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Part 2: Objects and Properties

§ Note: Visit help.agi.com/stk/#training/Day10Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Engineers and operators need to quickly add realistic analytical and visual properties to objects in STK. They
may need a realistic satellite attitude, analysis of an enclosed area in a deep canyon, a mission plan for an
aircraft flight route, a sensor footprint, or a briefing with detailed visuals and analysis.

Solution

Use STK to insert STK objects into your scenario. Then update the object's properties to define its
characteristics relevant to your scenario.

Modifying the Scenario object's properties
The Scenario (ﬁ) object defines the context that influences the properties and behavior of other objects.
1. Right-click on the Scenario (ﬁ) object in the Object Browser.

2. Select Properties (E).

Insert STK Objects tool

The Insert STK Objects tool provides an easy, convenient way to populate a scenario. The Insert STK Objects
tool, by default, displays the most commonly-used scenario objects. You can customize the tool to display all the
scenario objects or a user-defined subset of objects.
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There are two ways to reopen the Insert STK Objects tool:

L
* Click Insert Object (##r) located in the Default toolbar.

e Expand the Insert menu and select New.

Objects and Methods

In the Insert STK Obijects tool, you will see Scenario Objects, Attached Objects, and Methods. Scenario objects

are children of the larger Scenario (ﬁ) (e.g. STK_Objects_Properties). Attached objects are the children of
scenario objects. You must add scenario objects before you can add attached objects.

To insert an object, you must choose a particular method. These methods determine the starting properties of
each object and you can change these properties later. For instance, when this training says to "Insert a Default
Object," that means insert an object using the default method. You should pick the method for the demands of
your scenario, as we will show later in this training.

For instance, you could insert an Aircraft (%) object (a Scenario object) using the Insert Default (%) method.

Then, you could insert a Sensor (E) object (an Attached object) onto that aircraft.

Satellite object

The Satellite object models the properties and behavior of a vehicle in orbit around a central body.

From Standard Object Database

1. Select Satellite (%) in the Insert STK Objects tool.

Select the From Standard Object Database (Q) method.

Click Insert... .

In the Name or ID: field, enter 25544 (the SSC number or Satellite Catalog Number)
Click Search .

In the Results: field, select ISS (Zarya).

N o ok ob

Click Insert .

The ISS (Zarya) is downloaded from AGl's Standard Object Data Service. If you were to choose ISS or
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Zarya using Local Database, you would need to ensure you've updated your satellite database.

8. Click Close to close the Search Standard Object Data window.

View in 2D

1. Bring the 2D Graphics window to the front.

2. Zoom Out (El) if needed to see the entire earth and the current orbit track of ISS_ZARYA_25544 (% )-

3. Using the Animation Toolbar, make any adjustments to the time step.
4. Click Start ( [ ) to animate the scenario.

5. When finished, click Reset (I').

View in 3D

1. Bring the 3D Graphics window to the front.
Click Home View (%).

Right-click on ISS_ZARYA_25544 (%) in the Object Browser.
Select Zoom To.

Using the Animation Toolbar, make any adjustments to the time step.

o a ko N

Click Start ( .' ) to animate the scenario.

7. When finished, click Reset (I').

ISS_ZARYA_25544's Properties
1. Right-click on ISS_ZARYA 25544's (% ) in the Object Browser.

2. Select properties (IEI).

3. Note that the Propagator is set to the SGP4 Propagator. The Simplified General Perturbations (SGP4)
propagator is used with two-line mean element (TLE) sets.
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4. Inthe TLE Source frame, click Preview... . Here, you can preview or modify the two-line element (TLE)
information that is used to propagate the SGP4 satellite.

5. Close the TLE Preview window.

6. Click OK to close ISS_ZARYA_25544's (%) properties (IE).

Orbit Wizard

The Orbit Wizard is a satellite-level tool designed to assist you in creating any one of several standard orbits, or
designing your own satellite orbit. The configurable options available depends on the orbit type selected.

1. Select Satellite (%) in the Insert STK Objects tool.
2. Select the Orbit Wizard (@P) method.

3. Click Insert... .

4. When the Orbit Wizard opens, set the following:

Option Value
Type: Repeating Ground Trace
Satellite Name: RGT_Sat
Approximate Altitude: 600 km
5. Click OK.

6. Justlike you did with ISS_ZARYA_ 25544 (%), view RGT_Sat (%) in the 2D Graphics and 3D Graphics
windows.

7. Click Start ( b ) to animate the scenario if desired.

8. When finished, click Reset (I').

RGT_Sat's Properties.
1. Right-click on RGT_Sat (%) in the Object Browser.

2. Select properties (IEI).

3. Note that the propagator is set to J2 Perturbation.
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vehSat_orbitProp_SGP4Preview.html

Unlike a Satellite (%) object propagated using TLEs, a Satellite (%) object propagated using the Orbit
Wizard can be edited using your own data.

Satellite Vectors and Attitude

Sometimes you need to understand your attitude.
1. Returnto RGT_Sat's (% ) properties (IEI).

Select the 3D Graphics - Vector page.

Select the Axes tab.

Enable Body Axes Show option.

Change the Body Axes color if desired.

o a0 kb

Click Apply .

View in 3D

1. Right-click on RGT_Sat (%) in the Object Browser.
2. Select Zoom To.

3. Bring the 3D Graphics window to the front.

Aircraft object

The Aircraft (%) object models the properties and behavior of a vehicle that travels in a great arc route,
generally above the surface of the earth.

1. Insert an Aircraft (%) object using the Insert Default (%) method.

Renaming objects

It's usual to rename objects in STK. If you choose not to rename your objects, STK will name them giving each
object a number.
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1. Right-click on Aircraft1 (3) in the Object Browser.
2. Select Rename in the shortcut menu.

3. Rename Aircraft1 () to My_Plane.

Aircraft Object's Properties

1. Open My_Plane's (%) properties (IEI).

2. Select the Basic - Route page.

Clicking on Map

1. Leave My _Plane's (%) properties (IEI) open.
2. Bring the 2D Graphics window to the front by clicking on the 2D Graphic tab below the Properties Browser.

3. Click somewhere in the Atlantic Ocean near the African coast and then click somewhere in the Indian
Ocean near the Indian coast.

4. Bring My_Plane's (%) properties (IEI) back to the front.

Modify a Waypoint Location

Select the first waypoint.

Select the Clicking on map changes current point check box.
Bring the 2D Graphics window back to the front.

Click somewhere in the Pacific Ocean near the United States coast.

Bring My_Plane's (%) properties (E) back to the front.
Click Delete Point until all waypoints are deleted.

Clear the Clicking on map changes current point check box.

©® N O 0 b=

Click Apply .
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Insert Point
You can insert waypoints manually. This is more precise than clicking on the map.

1. Click Insert Point .

2. Enter the following by clicking in the associated cell. Press the Enter key on the keyboard after each entry:

Option Value
Latitude 38.00 deg
Longitude -120.00 deg

3. Click Insert Point .

4. Enter the following for the second waypoint:

Option Value
Latitude 30.00 deg
Longitude -99.00 deg

5. Click Insert Point .

6. Enter the following for the third waypoint:

Option Value

Latitude 40.00 deg

Longitude -77.00 deg
7. Click Apply .

View the waypoints in the 2D and 3D Graphics windows

My_Plane's (%) flight route is located in the Continental United States.
1. Bring the 2D Graphics window to the front to view the flight route.

2. Bring the 3D Graphics window to the front to view the flight route.

3. Returnto My_Plane's (%) properties (IEI).
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Modify a Waypoint's Altitude
When modifying one waypoint, you need to know proper units. For instance, look at the first waypoint:
¢ The Altitude unit uses km (kilometers).
e The Speed unit uses km/sec (kilometers per second).
e The Turn Radius unit uses km.
Modify the first waypoint's altitude to 20000 ft (feet).
1. Select the first waypoint.

Click inside the Altitude cell.

Enter 20000 ft.

o

Press Enter on the keyboard.

Modify a Waypoint's Speed
Modify the first waypoint's speed to 450 mi/hr (miles per hour).
1. Click inside the Speed cell.

2. Enter 450 mi/hr,

3. Press Enter on the keyboard.

Modify a Waypoint's Turn Radius

Modify the first waypoint's turn radius to two (2) km.
1. Click inside the Turn Radius cell.
2. Enter 2 km.
3. Press Enter on the keyboard.

4. Click Apply .
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Set All Grid Values tool

—

. Click SetAll... .

2. Select Altitude, Speed, and Turn Radius in the Set All Grid Values dialog box.

To the right of each value is a shortcut menu. These appear throughout STK. By clicking on them here, you
can set units for Altitude, Speed, Acceleration, or Turn Radius. This comes in handy when you can't find or
don't know the acronym for the unit you are looking for.

. Extend the shortcut menu for Speed.

3

4. Select nm (nautical mile).

5. Inthe second shortcut menu, select hr (hour).
6

. Setthe value to 500. The aircraft flies from the first to the last waypoints at a speed of 500 nautical miles per
hour.

7. Setthe following for altitude and Turn Radius:

Option Value
Altitude: 45000 ft
Turn Radius: 3 km

8. Click OK to close the Set All Grid Values dialog box.

9. Click Apply .

Set the animation time

You can jump to a waypoint in the 2D and 3D Graphics windows.
1. Select the second waypoint.
Click inside the Time cell.
Copy (Ctrl + C) the Time of the second waypoint.
Right-click in the Current Scenario Time field in the Animation Toolbar.

Select Paste.

o a0 kv b

Click the Enter key on your keyboard.
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View in 3D

1. Bring the 3D Graphics window to the front.

. Right-click on My_Plane (%) in the Object Browser.

2
3. Select Zoom To.
4

. Using the left mouse button, create a head on view of My_Plane (%).

All three waypoints are using the same values. The units converted back to the default units. The aircraftis
flying the entire route at an altitude of 45000 feet MSL, at a speed of 500 nautical miles per hour and will

require a turn radius of 3 kilometers at waypoint two. My_Plane (%) is in the middle of the turn. Notice that
there is no roll (banking) associated with the attitude.

Attitude Profiles
STKis set at the Standard attitude option which allows you define a vehicle's attitude profile.

Attitude changes can be applied to all moving objects in STK (e.g. Aircraft, Ground Vehicles, Missiles, Satellites,
Ships).

1. Leave the view in the 3D Graphics window.
2. Returnto My_Plane's (%) properties (IEI).

3. Select the Basic - Attitude page.

Coordinated Turn Attitude

This profile computes the roll (banking) of an aircraft based on a balancing of the forces acting on the aircraft,
assuming a zero angle of attack and no slip condition.

1. Open the Type: shortcut menu in the Basic frame.
2. Select Coordinated Turn.
3. Leave the Time Offset at 10 sec.

4. Click Apply .
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View in 3D

1. Bring the 3D Graphics window back to the front.

2. Click Reset (l') in the Animation Toolbar.

2D Graphics properties

1. Returnto My_Plane's (%) properties (E).
Select the 2D Graphics - Attributes page.

Change Color, Line Style, and Line Width to whatever selections you want.

o

Click Apply .

3D Graphics properties
3D Graphics Properties - Vector is used to do the following:

* Control the display of vectors and other geometric elements, such as axes and angles, related to the Earth
or other central body in the selected 3D Graphics window.

¢ Control the display of vectors and other geometric elements related to the selected object.
1. Returnto My_Plane's (%) properties (IEI).

Select the 3D Graphics - Vector page.

Ensure the Vectors tab is selected.

Select the Show check box for Sun Vector.

Select the Axes tab.

Select the Show check box for Body Axes.

e L

Click Apply .
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View in 3D

1. Bring the 3D Graphics window to the front.

2. Ifneeded, Zoom To My_Plane (%).

Animate the scenario

The body axes remain fixed throughout the flight. Even when the Sun drops below the horizon, the sun vector
continuously stays locked on the Sun.

1. Decrease Time Step (E) to five (5.00) seconds in the Animation Toolbar.
2. Click Start ( .' ) to animate the scenario.

3. Click Reset (“) when finished.

3D Graphics Model

The 3D Graphics - Model page is used to specify a model to represent a given vehicle, facility, place, or target in
the 3D Graphics window.

1. Returnto My_Plane's (%) properties (IEI).

2. Select the 3D Graphics - Model page. The current model you see in the 3D Graphics window is the
aircraft.glb.

3. Click the Model File: ellipses (|Z|) in the Model frame. All the models shown in the File dialog box come with
the STK install.

4. Select any model (DAE File or Simulink Model) you'd like to use in the scenario.
5. Click Open .
6

. Click OK.

7. Bring the 3D Graphics window to the front. You have a new model type representing the Aircraft (%)
object.
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Area Target object

Insert Default Method

Insert Default adds the selected object and applies the default settings to the newly added object.

1. Insertan Area Target () object using the Insert Default () method.

2. Rename AreaTarget3 () to Local_Airfield.

Define the Area Target

Define the Area Target.

1. Open Local_Airfield's () properties (E).

The Basic - Boundary page is similar to the Area Target Wizard except you don't get a small 2D Graphic
view. Now you'll outline a local airfield. Maybe you're trying to determine when a Satellite (%) object or an

Aircraft (%) object sees the airfield.
2. Select the Basic - Boundary page.
3. Click Add four (4) times.

4. Setthe following Latitude and Longitude values for the Points in the order shown (simply copy and paste
from the tutorial):

Latitude Longitude

38.4345 deg -105.116 deg

38.4267 deg -105.0999 deg

38.4256 deg -105.1008 deg

38.4333 deg -105.117 deg
5. Click OK.
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View in 3D

1. Bring the 3D Graphics window to the front.

2. Zoom To Local_Airfield (E").

3. Use your mouse to get a good view of the area target outlining the airfield.

AREA TARGET LOCAL AIRFIELD

Facility Object

The Facility object (ﬂ) models a ground station or other facility on the surface of the central body. Similar to

Place (F ) and Target (E) objects property wise, what makes a Facility (ﬂ) object stand out is when you
insert one using the standard object database.

1. Inserta Facility (ﬂ) object using the From Standard Object Database (Q) method.

Enter White Sands - SULF
1. Change Network: back to no selection (-).
Enter White Sands in the Name: field.

Click Search .

@D

In the Results: list, select White - Sands - SULF.
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5. Click Insert.

6. Click Close to close the Search Standard Object Data dialog box.

Missile object

The Missile (ﬂ) object models the properties and behavior of a vehicle following an elliptical path that begins
and ends at the surface of the central body.

1. Inserta Missile (ﬂ) object using the Insert Default (ﬂ) method.
2. Rename Missile1 (Q) to Sounding_Rocket.

3. Open Sounding_Rocket's (ﬂ) properties (IEI).

4. Select the Basic - Trajectory page.

5. Notice the Propagator is Ballistic.

Ballistic Propagator

The Ballistic Propagator defines an elliptical path that begins and ends at the Earth's surface. Specifying a fixed
flight time, initial velocity or altitude can further refine the shape of the trajectory.

1. Return to Sounding_Rocket's (Q) properties (EI) Basic - Trajectory page.

2. Set the following:

Option Value

Launch Latitude - Geodetic 33.7212 deg

Launch Longitude -106.7364 deg

Launch Altitude 4750 ft (compensate for terrain)

Change Fixed Delta-V to Fixed Apogee Alt 100 km

Impact Latitude - Geodetic 32.9 deg

Impact Longitude -106.3 deg

Impact Altitude 3910 ft (compensate for terrain)
3. Click OK.
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View in 3D

—

. Bring the 3D Graphics window to the front.

2. Zoom To Sounding_Rocket (f).

3. Click Increase (ﬂ) Time Step in the Animation Toolbar to set the X Real Time Multiplier to 8.00.
4. Click Start ( .' ) to animate the scenario.

5. Click Reset (I') when finished.

Place object
1. InsertaPlace (@ ) object using the Insert Default (@ ) method.

2. Zoom To Place1 (@ ).

3. Bring the 3D Graphics to the front.

A Place (@ ) object or a Facility (ﬁ) object will default to AGI Headquarters.

Move Place1 by Clicking on the 2D Graphics Window

1. Bring the 2D Graphics window to the front.

2. Zoom to Place1 (9 ). Remember, in the 2D Graphics window, you have to use your mouse to center and
zoom to an object!

3. OpenPlacel's (9 ) properties (IEI).
4. Return to the 2D Graphics window.

5. Click the upper left corner of the building.

Set the height above ground of the facility

Set Placel (@ ) 30 feet above the ground to model the sensor on the roof of the building.
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1. Returnto Place1's (@ ) properties (IEI).
2. Enter 30 ft in the Height Above Ground: field.

3. Click OK.

3D Object Editor

Use the 3D Object Editor to define and modify the position of an area target, facility, place, aircraft, ground
vehicle, ship, or target in the 3D Graphics window.

=

. Bring the 3D Graphics window to the front.
2. Click Orient from Top (Q) in the 3D Graphics window toolbar.

. Zoom To Place1 (@ ).
. Open the 3D Editing Object shortcut menu.

. Select Place/Place1.

. Press the Shift key on your keyboard.

3
4
5
6. Click Object Edit Start/Accept (ﬂ) to start the editing process.
7
8. Left-click in the center of the building.

9

. Click Object Edit Cancel (@E) because that is not where you want to object to go.

Fix the location

1. Click Object Edit Start/Accept (&1) to start the editing process.
2. Press the Shift key on your keyboard.

3. Left-click in the upper right hand corner of the building.

4. Click Object Edit Start/Accept (Eﬁblél) to accept the change.
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Sensor object

2
The Sensor (ﬁ:l) object models the field-of-view and other properties of a sensing device attached to another
STK object.

= T
1. Inserta Sensor (ﬁ:') object using the Insert Default (ﬁi ) method.

2. Select White_Sands-SULF (ﬂ) in the Select Object dialog box.
3. Click OK.

4. Rename Sensor1 () to WS_Sensor.

Sensor Orientation

2|
1. OpenWS_Sensor's (Eil) properties (IEI).
Select the Basic - Definition page.

In the Simple Conic frame, enter 90 deg in the Cone Half Angle: field.

> 0N

Click Apply .

Basic Constraints
1. Select the Constraints - Basic page.

2. Note the currently used constraints.

e Line of Sight: Access to the object is limited to lines of sight not obstructed by the ground. In this
instance, the central body.

» Field-of-View (Sensors only): Access is denied if the associated object is not within the field-of-view
as defined by the angle settings for the sensor.

3. Select the Max: check box in the Range frame.
4. Enter 1000 km Max: field.
Range is measured as the distance between the two objects.

5. Click OK.

\nsys Page 25 of 292

ssssssssssssssssssssssssss


ObjectMap_Sensor.htm

Summary

This tutorial began with understanding the purpose of the Insert STK Objects tool. Next, the Scenario (ﬁ)
object and its properties were discussed. This was followed by an in depth discussion of commonly used object
in the Insert STK Objects tool, how to insert objects into the scenario, and which method to use during that
insertion.
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Part 3: Access Reports and Graphs

§ Note: Visit help.agi.com/stk/#training/Day10Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Engineers and operators often need to determine the times one object can "access" (or see) another object. In
addition, they need to impose constraints on accesses between objects to define what constitutes a valid
access. These constraints could include elevation angle, sun light or umbra restrictions, gimbal speed, range,
and more. Engineers also require the ability to create reports and graphs that summarize static data or show
dynamic data during animation.

Solution

With STK, you can determine accesses between objects and generate reports to summarize your data. Building
on your fundamental understanding of STK, use two important tools in STK to solve this problem:

e The Access Tool

¢ The Report & Graph Manager

Inserting the satellite tracking station

A teleport is located in Castle Rock, Colorado. Enter the teleport into the scenario as a Facility (E) object.

1. Select Facility (E) in the Insert STK Objects tool.

2. Select the From Standard Object Database (Q) method.

3. Click Insert...

4. Type castle rock in the Name: field when the Search Standard Object Data dialog box opens.
5. Click Search .
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6. Select Castle Rock Teleport using the INTELSAT Network selection.
7. Click Insert.

8. Click Close to close the Search Standard Object Data dialog box.

Viewing the tracking station in 3D

1. Bring the 3D Graphics window to the front.

. Right-click on Castle_Rock_Teleport (Q) in the Object Browser.

2
3. Select Zoom To.
4

. Use your mouse to get a good view of Castle_Rock_Teleport (ﬂ) and surrounding terrain.

Streaming terrain from a Terrain Server

For the purposes of this scenario, disable Terrain Server.

1. Right-click on AccessReportsGraphs (ﬁ) in the Object Browser.
Select Properties (IEI).
Select the Basic - Terrain page when the Properties Browser opens.

Clear the Use terrain server for analysis check box in the Terrain Server frame.

Click OK to accept your changes and to close the Properties Browser.

o g kv N

Bring the 3D Graphics window to the front.

Editing Castle Rock Teleport's properties

Castle_Rock_Teleport (E) appears to be floating. STK is still referencing the altitude of Castle_Rock_Teleport
(ﬂ) based on terrain data.

1. Open Castle_Rock_Teleport's (ﬁ) properties (IEI).
2. Select the Basic - Position page when the Properties Browser opens.

3. Select the Use terrain data check box.
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4. Click Apply to accept your changes and to keep the Properties Browser open.

5. Return to the 3D Graphics window.

Restricting the field-of-view of Castle Rock Teleport

You can restrict Castle_Rock_Teleport's (ﬂ) field-of-view by setting basic constraints, or you can restrict and

visualize its field-of-view by using a Sensor (Ei‘) object.

1. Return to Castle_Rock_Teleport's (ﬂ) properties (IEI).
2. Select the Constraints - Basic page.

3. Click OK to close the Properties Browser.

Inserting a Sensor object onto Castle Rock Teleport
Use a Sensor (E?") object that mimics Castle_Rock_Teleport's (ﬁ) antenna field-of-view.
1. Inserta Sensor (E) object using the Insert Default (Eil‘) method.

2. Select Castle_Rock_Teleport (ﬂ) in the Select Object dialog box.

3. Click OK.

=
4. Rename the Sensor1 (Eﬁ ) to CR_FOV. It's an acronym for Castle Rock field-of-view.

Setting the half angle of the sensor
A simple conic sensor pattern is defined by a simple cone angle.
o
1. OpenCR_FOV's (Ei) properties (IEI).
Select the Basic - Definition page.

Enter 90 deg in the Cone Half Angle: field.

oD

Click Apply to accept your changes and to keep the Properties Browser open.
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Setting constraints

1. Select the Constraints - Basic page.

2. Select the Max: check box in the Range frame.
3. Enter 1000 km in the Max: field.
4

. Click OK to accept your changes and to close the Properties Browser.

View the sensor in 3D

1. Bring the 3D Graphics window to the front.
2. Zoom To Castle_Rock_Teleport (E).

3. Zoom out enough to see CR_FOV's (Eh‘) field-of-view.

Inserting three Satellites objects

Propagate three operational CUBESAT satellites using the Standard Object Database tool.

1. Insert a Satellite (%) object using the From Standard Object Database (Q) method.

2. Type cubesat in the Name or ID: field when the Search Standard Object Data dialog box opens.

3. Open the Operational Status: shortcut menu.

4. Select Operational.

5. Click Search .

6. Select all the operational satellites in the Results: list.

7. Click Insert .

8. Click Close to close the Search Standard Object Data dialog box after the Satellite (% ) objects have

been propagated.
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Using the Access Tool

An access is defined by two or more objects - a primary object and an associated object or objects- for which the

2
access is computed. You want to analyze when the CUBESAT satellites pass through CR_FOV's (E?') field-of-
view.

1. Click Access (E’) in the STK Tools toolbar.

2. Within the Access Tool, click Select Object... to the right of Access for: field.

2
3. Select CR_FOV (ﬁi ) in the Select Object dialog box.

4. Click OK .

"Access for:" now shows Castle_Rock_Teleport-CR_FOV. This is the object you're looking from.

5. Select all the Satellite (%) objects in the Associated Obijects list.

6. Click il “ompute

Generating an Access Report

In the Reports frame, clicking Access... generates a report that provides access times between one object and
one or more selected objects. Global statistics are provided if more than one object is selected.

1. Ensure all the satellites are selected in the Associated Objects list.
2. Click Access... in the Reports frame.
3. Scroll through the report to become familiar with the layout.

4. Close the access report once you are done.

Generating an Access Graph

In the Graphs frame, clicking Access... generates a graph that provides access times between one object and
one or more selected objects.
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1. Return to the Access Tool.
2. Click Access... inthe Graphs frame.
When you generate a graph, the zoom in function is automatically on.

3. Locate the first access in the graph and using your mouse, hold down the left mouse button, draw a box
around the access. This can be done multiple times until the graph is filled with the one access.

4. Place the cursor at the beginning of the access. A text box will appear with information about the access
start time.

ACCESS START TIME

Ju 1 Mgy 30 Tirm (UTCG)
CH_FOW. To-Cubeass sDON_ITH4S - Tavess (TN CR_FOV. To-CulbesalN_J0855 - Tumes (UTCO)

— =
CR_FOV- T KSULOUBESAT_4T554 - Times (UTCO CR_FONV-TaROSEVCUBESAT.1_SETIT - Temes (UTCG:

5. Click Zoom Out (EL) until you see the whole graph.

6. Close the access graph when finished.

Generating an Azimuth Elevation Range Report (AER)

In the Reports and Graphs frames, clicking AER... generates an access report or graph with azimuth,
elevation, and range data. In order to interpret the data correctly, you should understand the following:

1. Return to the Access Tool.
2. Ensure all the satellites are selected in the Associated Objects list.
3. Click AER... inthe Reports frame.

Since the access is taking place from an object on the ground, an azimuth of zero (0) degrees is True North.
The elevation is based on the central body (WGS84). The range is calculated from the center point of the

FROM object to the center point of the TO object. Remember, the Satellite (%) objects must enter the
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Sensor (E":‘) object's field-of-view in order to be accessed.
4. Scroll through the report to become familiar with the layout.

5. Close the AER report once you are done.

Extending CR_FOV's (&) range
Extend CR_FOV's (#=) range to see how it affects your data.
1. OpenCR_FOV's (E:") properties (E).

Select the Constraints - Basic page when the Properties Browser opens.

Enter 1500 km in the Range frame's Max: field.

o

Click OK to accept your change and to close the Properties Browser.

Refreshing the access report

The access report is showing the old data.

1. Click Refresh (F5) (@) in the access report toolbar. You also have the option of clicking F5 on your
keyboard to refresh a report.

2. Compare your new data to your old data. You have the same number of accesses but your durations are
longer.

Changing the reports units

Liw]
1. Click Report Units (** ) in the report toolbar.
Select the Time Dimension in the Units: Access dialog box.
Select Minutes (min) in the New Unit Value list.

Click OK.

a 0 b

Duration is now reported in minutes instead of seconds.
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Quick Reports

Unlike .txt and .csv files, a Quick Report is saved inside of STK.

-
1. Click Save as quick report () in the access report toolbar.

Click Quick Report Manager... (ﬁ) at the top of STK in the Data Providers Toolbar.
Change the quick report's name to Sensor to CUBESAT.

Click the Enter key on your keyboard.

Disable the Show on Load option.

Click OK..

Close the access report.

® N O O » N

Close the Access Tool.

Viewing the quick report

1. Return to the Quick Report Manager... (ﬁ).
2. Extend the shortcut menu.

3. Select Sensor to CUBESAT.

Using the Report & Graph Manager

You can generate the following types of output for most STK objects using the Report & Graph Manager which is
available from the Analysis menu or the Data Providers toolbar:

1. Click Report & Graph Manager () in the Data Providers toolbar.

2. Change the Object Type: to Satellite in the upper left corner of the Report & Graph Manager.

3. Select CubesatXIV_28895 (%) in the Object List.
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Object Type: |5atelite v

3% ASTROBIOCUBESAT_53107
3F CubesatXllv_27248

3# CubesatXIV_28895

3¢ KSU-CUBESAT 47954

¢ ROSEYCUBESAT-1_56212

Multiple objects can be selected, but for this scenario, focus on CubesatXIV_28895 (% ).

Managing report and graph styles

You can manage the report and graph styles.
1. Ensure (2) Installed Styles (F'——I ) in the Installed Styles list is expanded.

2. Select the Classical Orbit Elements (El) report.

3. Click Generate .

Using Data Providers, Groups and Elements

Data Providers, Groups and Elements are the organizing principles of the Data Provider Functionality. STK
provides hundreds of prebuilt reports and graphs.

1. Close the report.

2. Return to the Report & Graph Manager.

3. Look at the very top of the styles field. The Classical Orbit Elements (El) report is now available in the My
Favorites (F‘——I ) folder.

4. Take a close look at Classical Orbit Elements located in the Installed Styles list. One is a graph style and
one a report style. Notice the locks.
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The reports and graphs located in the Installed Styles list cannot be customized. However, they can be
duplicated and the duplicate can be customized.

Data Providers by Object

1.

Right-click on the Classical Orbit Elements (El) report in the Installed Styles list.

2. Select Properties (EI ).
3.
4
5

Select the Content page when the Properties Browser opens.

. Inthe Report Contents list, select Classical Elements-J2000-Semi-major Axis.

. Return to the Data Providers list. You can see the hierarchy of Classical Elements (Data Provider)- J2000

(Group)- Semi-major Axis (Element).

Report Contents

As

previously stated, you will replace argument of perigee, true anomaly and mean anomaly data provider

elements with J2000 XY Z Cartesian Position elements.

1.

©

cccccc

@ N o o k0B

In the Report Contents list, select the following:
» Classical Elements-J2000-Arg of Perigee
o Classical Elements-J2000-True Anomaly

e Classical Elements-J2000-Mean Anomaly
Click Remove .
Remove the asterisk (*) at the top of the Data Providers list, in the Filter field.
Type Cartesian.
Click Filter . This narrows down your choices to only those data providers containing Cartesian elements.
Expand (=) Cartesian Position.

Expand (=) J2000.
Move () X, Y, and Z to the Report Contents list.

If desired, use the up (ﬂ) and down (u) arrows to place elements where desired.
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10. Click OK to accept your changes and to close the Properties Browser.

11. Click OK after reading the warning.

Generate the report
1. Expand (#) My Styles (F——') in the Styles list.

Right-click on Classical Orbit Elements ( ).

Select Rename.

Rename Classical Orbit Elements ( ) to My Classical Orbit Elements.

Click Generate...

SR S o

Close the report when you are finished.

Summary

Using the Access Tool, you computed an access report, an access graph and then an azimuth elevation range

=
report between the Sensor (ﬁ:' ) object and the satellites.

\nsys Page 37 of 292

vvvvvvvvvvvvvvvvvvvvvvvvvv



Part 4: Movies and Visual Data Files

§ Note: Visit help.agi.com/stk/#training/Day10Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem Statement

Engineers and operators often need resources to prepare visual presentations for briefings, talks, speeches and
demonstrations. In this scenario, an aircraft is flying an important mission that you wish to simulate using a video
and an STK Visual Data File.

Solution

Upon completion of this tutorial, you will learn how to:
¢ Create a simple movie that can be embedded in a PowerPoint presentation or played for an audience.
e Convert an STK scenario into a visual data file (VDF).
¢ Display the VDF in STK Viewer, which does not require an STK license.

¢ Create a first rate briefing experience to both the presenter and the audience.

Post-typhoon aerial photography flight route

You will simulate an aircraft's flight route across Japanese airspace. Your aircraft will fly over the following
islands and cities in the order shown:

* Naha, Okinawa
¢ Amami Oshima, Kagoshima
¢ Minamidaito, Okinawa

* Back to Naha, Okinawa
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Inserting Naha Airport as a Place object
1. Select Place (@ ) in the Insert STK Objects Tool.

2. Select the Search by Address (@ ) method.

§? Note: The Insert by Address option requires an internet connection. If you do not have an internet
connection you can select the Define Properties option and set the lat/lon manually.

3. Click Insert...

4. Type Naha Airport in the Enter an address or other search criteria below: field in the STK: Insert by Address
dialog box.

5. Select Naha Airport, Japan (latitude 26.19583, longitude 127.64583).

6. Click Insert Place(s) .

Inserting Amami Oshima as a Place object
1. Type Amami in the Enter an address or other search criteria below: field.
2. Select Amami, Japan (latitude 28.37724 longitude 129.49374).

3. Click Insert Place(s) .

Inserting Minamidaito as a Place object
1. Type Minamidaito in the Enter an address or other search criteria below: field.
Select Minamidaito, Japan (latitude 25.82889 longitude 131.23187).

Click Insert Place(s) .

Wb

Click Close to close the STK: Insert by Address dialog box.
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Inserting an Aircraft object
You will insert an Aircraft (%) object. Adjust the altitude, speed, turn radius and attitude.
1. Insert an Aircraft (%) object using the Insert Default (%) method.

Right-click on Aircraft1 (%) in the Object Browser.

Select Rename.

Rename Aircraft1 (%) to PhotoMission.

Bring the 2D Graphics window to the front.

o g~ DB

Maximize the 2D Graphics window.

7. Zoom in to the 2D Graphics window so that all three Place (@ ) objects are visible and centered.

Modifying the Aircraft object's properties

1. Right-click on PhotoMission (%) in the Object Browser.

Select Properties (IEI).
Select the Basic - Route page when the Properties Browser opens.
Open the Reference: shortcut menu in the Altitude Reference frame.

Select MSL (Mean Sea Level).

o g k0w b

Bring the 2D Graphics window to the front by clicking the 2D Graphic... tab near the bottom of STK.

Creating waypoints for the Aircraft object

To keep things simple and focus on movie making and creating VDFs, you'll use the clicking on the 2D Graphics

window method to create waypoints for PhotoMission (%). By clicking on the 2D Graphics window, you won't
fly to precise locations. You'll fly to the point you clicked. Start at Naha.
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1. Click as close as you can to the Naha Place (® ) object symbol's point in the 2D Graphics window.
Click as close as you can to the Amami Place (@ ) object symbol's point.

Click as close as you can to the Minamidaito Place (@ ) object symbol's point.

S

Click as close as you can to the Naha Place (@ ) object symbol's point.

Due to the default turn radius, your waypoints won't be overhead of Amami or Minamidaito. We'll fix that
shortly.

5. Return to PhotoMission's (%) properties by clicking on the PhotoMission... tab (IEI) below the 2D
Graphics window.

Adjusting the aircraft's altitude, speed, and turn radius
Adjust the altitude, speed, and turn radius using SetAll... .
1. Click SetAll....
2. Select the Altitude, Speed and Turn Radius check boxes in the Set All Grid Values dialog box.

3. Setthe following:

Option Value
Altitude: 10000 ft
Speed: 200 mi/hr
Turn Radius: 1 km

4. Click OK to close the Set All Grid Values dialog box.

5. Click Apply to save your changes and to keep the Properties Browser open.

6. Return to the 2D Graphics window.

Adjusting the attitude

Define the attitude profile for PhotoMission (%) by using a coordinated turn.
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1. Return to PhotoMission's (%) properties (IEI).
Select the Basic - Attitude page.
Open the Type: shortcut menu in the Basic frame.

Select Coordinated Turn.

a B Db

Click Apply to save your changes and to keep the Properties Browser open.

Changing the Aircraft object's model
1. Select the 3D Graphics - Model page.

Click the Model File: ellipsis (E) in the Model frame.

Select the commuter.mdl file in the File dialog box.

Click Open .

Click Apply to save your changes and to keep the Properties Browser open.

© oA w N

Select the Basic - Route page.

Preparing the Scene

There are many ways to create a movie inside of STK. For the purposes of this movie, you'll use one of many.

The second point (waypoint) is when PhotoMission (%) is overhead Amami_Japan (@ ). You will make a

movie that begins ten (10) seconds prior to and ends ten (10) seconds after the waypoint's time. Jump to the
waypoint's time. Your time will be different than the time showed in the example.

1. Go to the Time cell of point two.

Click in the cell to select the time.

Press Ctrl + C (copy) on your keyboard.

Highlight the time in the Current Scenario Time field in the Animation Toolbar.

Press Ctrl + V (paste) on your keyboard.

® o K 0 N

Press the Enter key on your keyboard.
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Viewing in 3D
1. Bring the 3D Graphics window to the front

. Right-click on PhotoMission (%) in the Object Browser.

2
3. Select Zoom To.
4

. Using your mouse, set up the view so that you can see both PhotoMission (%) and Amami_Japan (@ ).

Setting Animation Time

Earlier, you set your animation time to the second waypoint which is in the Current Scenario Time field. You will
start the movie 10 (ten) seconds prior to that time. The following is an example of what to do:

e Let's say the time in the Current Scenario Time field is: 1 Mar 2023 23:56:20.123

¢ Round down ten seconds earlier to the nearest integer: 1 Mar 2023 23:56:10.000
1. Round down the time by ten seconds in the Animation Toolbar Current Scenario Time field.
2. Press Enter on your keyboard.

3. Make sure you're satisfied with your view. Once you start recording the movie, do not touch the 3D
Graphics window.

Creating a Stored View

1. Click Stored Views (%) in the 3D Graphics window toolbar.
Click New in the Stored View: 3D Graphics 1 - Earth dialog box.

Set the View Name to Movie Time.

> N

Click OK to close the the Stored View: 3D Graphics 1 - Earth dialog box.

By creating this view, if you were to Reset (I') your scenario, you can quickly jump back to this time and
view in the 3D Graphics window.

5. Click X Real-time Animation Mode (E) in the Animation toolbar.
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Movie Timeline Plugin

The Movie Timeline Plugin helps you record animations from STK. You can also record a movie using 3D
Graphics window properties where It is found on the Record Movie page. In this scenario, use the Movie
Timeline Plugin. There are a lot of features in the Movie Timeline Plugin, but to keep things simple, you'll use the
Record from the Movie Timeline button.

1. Open the View menu at the top of STK.
2. Select Toolbars in the shortcut menu.

3. Select Movie Timeline in the second shortcut menu.

4. Click Record (@) in the Movie Timeline tool bar.

Movie Wizard

The Movie Wizard will help you walk through important steps in creating your movie.

On the left side are pages starting with Filename & Format. If you follow the sequence from top to bottom, you
will make a fairly effortless movie.

Filename and format
Save your movie in your scenario directory using H.264 format.
1. Select the Filename & Format page.
Click Save as... in the Choose the filename to use during movie recording: frame.
Browse to your scenario folder (e.g. C:\Users\username\Documents\STK 12\STK_Movies_VDFs).
Change the File name: to any name you desire (e.g. First Movie.h264).
Click Save.

Leave the format as a H.264 (.mp4).

N o o koo N

Click Next .

\nsys Page 44 of 292

ssssssssssssssssssssssssss



Selecting a graphics window to record
You can select which window you are recording. You're recording the 3D Graphics window.
1. Ensure 1-3D Graphics 1 - Earth option is selected.

2. Click Next .

Changing the resolution
Here, you resize the 3D Graphics window using preset sizes.

1. Open the Preset: shortcut menu in the Choose the resolution of the recorded movie: frame.
2. Select Large.

3. Click Next .

Video time and length
Take your time on this page. It's important to follow the following steps:
1. Clear the black lock (ﬂ) check box.
Copy (Ctrl + C) the time in the Current Scenario Time field.
Paste (Ctrl + V) it in the Movie time range: Start time: field.
Highlight the time and units in the Movie playback length Shorter / Longer field.

Enter the value 20 into the Shorter / Longer field.

o ok wbd

Press the Tab key on your keyboard. This will automatically enter sec (seconds) and change the Movie time
range: End Time: to twenty (20) seconds past the Start time.

7. Select the black lock (ﬂ ) check box.

8. Click Next.

Video size and quality

In the 3D Graphics window, aliasing is the process by which smooth curves and other lines become jagged
because the resolution of the graphics device or file is not high enough to represent a smooth curve. Anti-
aliasing is a technique for diminishing jagged - stair step-like lines that you want to be smooth.
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1. Extend the Anti-aliasing: pull-down menu to view the settings.

2. Leave the default setting of 3x3 - Good Quality.

3. Inthe Recorded image quality, and estimated file size: field, change Quality to High Quality @ 1080 if
required. This adjusts the bitrate and changes the estimated maximum size of the recorded movie.

4. Click Next.

Starting your recording

Here you can view the summary and go back to make any changes you feel are necessary. Remember, it's a
good idea not to manipulate the 3D Graphics window once the recording begins.

1. Click Begin Record (@) once you are prepared to record. Sit back and wait until the recording is
complete.

2. Click Yes when you are prompted to view the recording.

3. When you are finished admiring your Oscar winning creation, close the media player and return to STK.

4. Click Finish inthe Movie Wizard.

Resetting the Scenario Animation Time

Using the Movie Wizard, when you create the start and stop time of your movie, it sets those times in the
Scenario (!) objects Basic - Time Animation field. It's a good idea to reset these time so that you can animate
your complete analysis time (in this case four hours).

1. Open STK_Movies_VDFs (ﬁ) properties (IEI).

2. Select the Basic - Time page.

3. Select the following check boxes in the Animation frame:
e Use Analysis Start Time
e Use Analysis Stop Time

4. Click OK to select your changes and to close the Properties Browser.
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Visual Data File (VDF)

You can convert your STK 3D scenarios to Visual Data (.vdf) files that can be:
¢ Displayed in STK Viewer.
¢ Loaded and edited in STK Viewer.

¢ Loaded, edited and saved as a scenario file (.sc) in STK.

Creating a VDF

The VDF Setup tool is small, but there's a lot going on.

—

. Open the File menu at the top of STK.
2. Select VDF Setup...

3. Select the Exclude Install Files check box when the VDF Setup for Scenario STK_Movies_VDFs dialog box
opens.

4. Click Yes for each time the Question window appears.

5. Look at Custom/User data. Use this to select the scenario files and non-STK files (.doc and .XLS files, for
example) to be included with the VDF file.

6. Look at Quick Reports For STK Viewer. These reports will be available if using STK Viewer during your
presentation.

7. Click Create VDF...

0

Ensure Save in: points to your scenario folder.

9. Click Save.

Summary

You learned how to enable the Movie Timeline Plugin and use all of its functionality by recording a movie.
Finally, you were introduced to the functionality of STK Viewer and its power in delivering a top notch briefing to
your audience.
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Part 5: Introduction to Connect

§ Note: Visit help.agi.com/stk/#training/Day10Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Programmers, engineers, and operators often need resources to easily build applications that communicate with
STK. Having a spreadsheet containing data, they need to transfer the data into and out of STK quickly and
easily. Many of the engineers and operators are not programmers. They need a simple to understand language
and syntax with which to create ways to efficiently populate objects into STK and extract data from STK or create
automation.

Solution

You will learn what an STK Connect command is and how to find and use the Connect Command Library. Using
the STK Integration capability and the APl Demo Utility, explore the Connect Command Library and become
familiar with some simple connect commands used to quickly and easily populate objects into and obtain
analytical data from an STK scenario.

Create a new scenario

Create a new scenario.
1. Launch STK (M.

2. Click &% Create a Scenario in the Welcome to STK dialog box.

3. Enter the following in the STK: New Scenario Wizard:

Option Value
Name: STK_Connect
Location: Default
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Start: Default
Stop: Default
4. Click OK once you are done.

—
5. Click Save () once the scenario loads.

6. Close the Timeline View once STK opens.

The Web Browser

In STK, the Web Browser is a web browser that is an integrated part of the workspace.

1. Click New Integrated Web Browser (@) on the Default toolbar.

Click Browse (E’) in the Web Browser - AGI - Resources web browser toolbar.
Click Example HTML Utilities in the Open dialog box.

Select STK Automation.

Click Open .

Select API Demo.
Click Open .

Select API Demo Utility.

© © N o oA ® N

Click Open .

Using the New command
The New command allows you to create a new scenario or add a new object to the current scenario.
1. Select Add facility in the In the API Demo Utility's Examples list.

2. Break down the string of text located in the Code Sandbox:

String of Text in Add Facility Meaning

New Connect Command
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/ ApplicationPath
*/Facility ClassPath

MyFacility Con NewObjectName

3. Click Run Code .

A Facility (E) object has been entered into the scenario using its default properties.

Understanding the Connect Command Library

There is a whole section in STK Help devoted to Connect. You can use the commands in the Connect library to
easily build applications that communicate with STK.

1. Extend the Help menu.

2. Select STK Help.

3. Select Integrating with STK on the left.
4

. Select Connect Command Library.

Alphabetical listing

The Alphabetical listing includes all Connect commands, regardless of their groupings.
1. Select Alphabetical Listing of Connect Commands.
2. Select N at the top of the page.
3. Select the New command.

The page describes the command, syntax, related commands, options, and examples. Whenever you're
starting to write Connect commands, look at the examples. You'll have to change them to work with your
object types and such, but it's a great place to start.

SetPosition Command

Use the SetPosition command to set the position of a facility, place, target or area target.
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1. Return to the alphabetical listing.

2. Select S at the top of the page.

3. Select SetPosition (Facility, Place, Target & Area Target).
%

Ensure you have the correct syntax: SetPosition <ObjectPath> [{Type}] {CoordType}
<Parameters>

5. Scroll down the page until you find the {CoordType} <Parameters> chart.
6. Note the Geodetic <Parameters> <Lat> <Lon> {<Altitude> | Terrain} [MSL].

7. Returnto STK.

Understanding the SetPosition Connect Command
Before you run the code, look at the SetPosition command.

1. Select Modify facility in the In the APl Demo Utility's Examples list.
2. Right-click on MyFacility_Con (E) in the Object Browser.

3. Select Properties (E ).
4. Select the Basic - Position page.

5. Notice the SetPosition code in the Code Sandbox matches the Connect command syntax (e.g. Type,
Latitude, Longitude, Altitude).

6. Click Cancel to close the Properties Browser.

7. Return to the APl Demo Utility.

Modifying the SetPosition code
1. Remove 0.0 (altitude) at the end of the SetPosition Connect command.

2. Type Terrain at the end of the Connect command.

Since you have streaming terrain from Terrain Server, by removing the altitude and inserting Terrain, the
Facility object will be placed on top of the terrain at the coordinates in the command.
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The second command is another New command. Note the path. It follows the object type to object name like
you see it in the Object Browser. The New command inserts a Sensor (Ei‘) object and attaches it to the
MyFacility_Con (ﬂ).

3. Click Run Code .

MyFacility_Con (ﬂ) has new coordinates and an attached Sensor (E:.‘) object named MyFacSensor_Con.

Inserting a Satellite (¥¢) object

We won't keep jumping back and forth between STK and the Connect Command Library. However, feel free to

go there on your own as we proceed through the training. Add a Satellite (%) object to the scenario and name it
MySat.

1. Select Add satellite In the API Demo Utility's Example list.

2. Change the Satellite (%) object's name from MySatellite_Con to MySat.

3. Click Run Code .

MySat (%) has been added to the scenario but it needs to be propagated.

Propagating MySat (#¥)
1. Select Modify satellite in the APl Demo Utility's Examples list.

The SetState Classical command sets the orbit state of the satellite using classical coordinates.
Syntax: SetState <VehObjectPath> Classical {Propagator} {NoProp |

{TimeInterval}} <StepSize> {CoordSystem} "<OrbitEpoch>" <SemiMajorAxis>
<Eccentricity> <Inclination> <ArgOfPerigee> <RAAN> <MeanAnom>

2. Compare the text in the Code Sandbox to the syntax and change the following:

Option Value
Object name MySat
Inclination 45 (deg)
RAAN 180 (deg)
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3. Click Run Code .

Inserting an Aircraft (%) object
1. Select Add aircraft in the API Demo Utility's Examples list.

2. Look at the code in the Code Sandbox.

The New command inserts the Aircraft (%) object. Then you set the propagator to Great Arc, reference
mean sea level (MSL) and create waypoints.

Command Description

SetPropagator Set the propagator of a great arc vehicle.
AltitudeRef Set the altitude reference for a Great Arc vehicle.
AddWaypoint Add waypoints to a great arc vehicle.

3. Click Run Code .

Modifying MyAircraft_Con (¥¥)
1. Select Modify aircraft in the APl Demo Utility's Examples list.

2. Look at the code in the Code Sandbox.

The Waypoints command and the Clear WaypointOption clears the original waypoints and AddWaypoint
inserts new waypoints.

Command Description

Waypoints Clear all waypoints from a great arc vehicle.

3. Click Run Code .

Computing an access

Compute an access from MySat (%) to MyFacility_Con (ﬁ).
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1. Select Compute access in the API Demo Utility's Examples list.

2. Look at the code in the Code Sandbox.

Command Description

Access Calculate access intervals between two objects.

3. Change the Satellite name from MySatellite_Con to MySat.

4. Click Run Code .

5. Bring the 2D Graphics window to the front. You will see access lines above MyFacility_Con (E).

6. Look at the APl Demo Utility - Output.

You can see the full path to each object followed by individual accesses.

Adding vectors

Add a vector which points from the Facility (ﬂ) object to the Satellite object.
1. Select Add vectors in the API Demo Utility's Examples list.

2. Look at the code in the Code Sandbox.

Command Description

VO SetVectorGeometry Define the display
of geometric
components in the
3D Graphics
window.

VO View Set parameters for
the view in a 3D
window.

Change the Satellite name from MySatellite to MySat in the VO SetVectorGeometry code line.
View both lines of code.

Click Run Code .

o o oo

Bring the 3D Graphics window to the front.

7. Right-click on MyFacility_Con (E) in the Object Browser.
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8. Select Zoom To.

To view the vector pointing from MyFacility_Con (ﬁ) to MySat (%), you might have to set your view in the
3D Graphics window so that you're under the terrain. The vector is only visible above the terrain when

MyFacility_Con (ﬂ) has an access to MySat (%).
9. Click Start ( .' ) to animate the scenario.
10. Click Reset (l‘) when finished.

11. Save () your work.

Summary

This was an introduction to the STK Connect module and the Connect Command Library. You were introduced
to the API Demo Utility which is just one of a few tools that come with STK that you can use to send Connect
commands.

e STK Button Tool: The Button Tool is a Perl script with a graphical user interface (GUI) that you can use to
associate STK Connect commands with buttons.

e Send_A_Connect_Command.htm: Located in Example HTML Utilities. This is a utility that allows you to
send a Connect command to STK by typing it into a text field and submitting it. The alphabetical listing of
Connect commands can be displayed to help look up different commands.
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Become Level 1: STK Certified

Now that you have completed Fundamentals training, you are well-prepared to complete the STK Level 1: STK
Certification test. The STK Certification is the first level of certification and validates your ability to perform
fundamental skills needed to be productive with STK.

What's in the Test?

The STK Certification test consists of one exercise scenario and you have 14 days from registration date to
complete Certification. The following objectives are tested:

» Model Your Systems - KML, Aircraft, Satellite, Sensor, Constraints
* Analyze Your Systems - Access Tool, Report & Graph Manager, Quick Reports

¢ Visualize Your Data - 3D Models, Stored Views, Timeline View

Extend STK - Connect and Object Model
e Share Your Work - VDF, STK Data Federate, Movies, Snapshots

If you pass your L1 STK Certification, you will receive a personalized Level 1 STK Certification certificate, an
Ansys lanyard, and a custom STK pin. Register now to take the Level 1: STK certification test
(http://www.agi.com/training/#cert).
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STK Level 2 - Advanced

STK Level 2 - Advanced training builds off of STK Level 1 - Beginner. You will take simulations from STK
Fundamentals a step further with advanced analysis capabilities and tools to quantify and measure mission
effectiveness.

Evaluation License

You can obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
contacting AGI Support at support@agi.com or 1-800-924-7244.

The Level 2 - Advanced Training is a series of tutorials designed to take a user through STK's advanced
capabilities.

Once you have completed these tutorials, you will be ready to take the level 2 STK Master Certification test! Visit
www.agi.com/training-and-certification#cert/ (free for U.S. and Canada). Upon registration for the level 2 Master
Certification, you will receive an email confirmation with an attachment for a 14 day demo license. This license
provides you access to all the capabilities needed to complete the certification. This license is for use with

STK 12.2 or older. If you are using STK 12.3 or newer to complete the STK Certification test, please contact AGI
Support at support@agi.com or 1-800-924-7244 for an updated license file.

Optional third-party programs

Several of the tutorials use MATLAB, Python, and/or Excel. While not required to complete the tutorials, these
programs are very useful to have when using STK. If you do not have these programs, you can open example
files in a text editor to view the syntax.

Tutorial Capabilities Required Required
License Install

Introduction to the Pro STK Pro STK Pro, STK STK Pro

Capabilities Learn how to Premium (Air or

add terrain and imagery to a Space), or STK

scenario. Enterprise

Customize Analysis with STK Pro, Analysis STK Pro, STK STK Pro

Analysis Workbench Learn Workbench Premium (Air or

how to use STK's Analysis Space), or STK

Workbench capability to build Enterprise

custom geometric, temporal,
and logical operations
through STK.
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Compute Coverage Over
Regions Learn how to
analyze global and regional
coverage provided by various
assets.

Introduction to AzEl Mask
Tool and Volumetrics Learn
how to use the AzEl Mask
Tool and build a volumetric
object.

Perform Trade Studies with
Analyzer Learn how to use
STK's Analyzer capability to
automate STK trade studies
and parametric analyses.

Introduction to
Communications Learn how
to define and analyze
detailed communication
systems.

Introduction to Radar Learn
how to build radar system
models to simulate and
analyze system performance.

Integrating STK with
MATLAB Learn how to
control STK through an
external application like
MATLAB.

Integrating STK with Python
Learn how to control STK
through an external
application like Python.

Integrating STK with Excel
Learn how to control STK
through an external
application like Excel.

sssssssssssssssssssssssss

STK Pro, Coverage

STK Pro, Analysis
Workbench, Coverage

STK Pro, Analyzer

STK Pro,
Communications

STK Pro, Radar,

Coverage

STK Pro, Integration

STK Pro, Integration

STK Pro, Integration
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STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Premium
(Air or Space) or
STK Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro, STK
Premium (Air or
Space), or STK
Enterprise

STK Pro

STK Pro

STK Pro + STK

Premium

STK Pro

STK Pro

STK Pro

STK Pro

STK Pro



Model Aircraft Missions with
Aviator Learn how to model a
sequence of curves
parameterized by well-known
performance characteristics
of an aircraft.

Introduction to Advanced
CAT Tool Learn how to use
STK's Conjunction Analysis
capability to avoid a satellite
collision.

Design Trajectories with
Astrogator Learn how to use
STK's Astrogator capability to
place a satellite in orbit.

Ground-based SSA with
EOIR Learn how to set up an
EOIR sensor in STK to track
an object in space and
determine the attitude profile
of the target based on its light
signature.

Note: For the STK 10 version of this training, visit
http://help.agi.com/StartTraining/StartTraining1013.htm
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STK Pro, Aviator

STK Pro, CAT

STK Pro, Astrogator

STK Pro, EOIR, SatPro
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Part 6: Introduction to the Pro Capabilities

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Credits: ISERV, NASA

Problem statement

Engineers and operators require a quick way to determine if local terrain is affecting visibility between ground
sites and satellites for a variety of purposes such as communications, imaging, and general situational
awareness. In this tutorial, there is a GPS monitoring station in the vicinity of Mount St. Helens. A USGS Digital
Elevation Model (DEM) file contains terrain data for the area requiring analysis. Raw satellite imagery is
available of Mount St. Helens which will provide situational awareness of the analytical area when converted as
an inlay. A further need exists to create color elevation imagery of the area to be used in a briefing and in
documentation.

Solution

Using STK, load a DEM file to analyze the impact of local terrain on accesses between a ground station and
GPS satellites. Create a color elevation image, and convert a raw satellite image that can be used as an inlay for
visualization and situational awareness. Change the DEM file into a STK Terrain File (pdtt) which can be used to
visualize terrain in the 3D Graphics window.

Creating a new scenario

Create a new scenario with a run time of 24 hours.

1. Launch STK (H).

2. Click A Create a Scenario in the Welcome to STK dialog box.

3. Enter the following in the STK: New Scenario Wizard:
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Option Value

Name: STK_Pro
Start: Default
Stop: Default

4. When you finish, click OK .

s
5. When the scenario loads, click Save (). A folder with the same name as your scenario is created for you.
6. Verify the scenario name and location in the Save As window.

7. Click Save.

U.S. Geological Survey Data
1. Create a folder on your Desktop called Terrain.

2. Using File Explorer, browse to the location of the DEM file using the following:

e STK 11: C:\Program Files\AGN\STK
11\CodeSamples\CodeSamples.zip\SharedResources\Scenarios\Events

e STK 12: C:\Program Files\AGI\STK
12\CodeSamples\CodeSamples.zip\SharedResources\Scenarios\Events

3. Locate and copy the file named hoquiam-e.dem.

4. Paste the hoquiam-e.dem file into the Terrain folder you created on your desktop.

Analytical Terrain

The Pro capability adds realism to system models. Building on the fundamental capabilities of STK, Pro
introduces more sophisticated modeling through advanced access constraints, flexible sensor shapes, complex
visibility links, more object tracks and digital terrain data.

Load the locally available DEM terrain data file to be used for analysis and visualization into the scenario.
1. Rightclick on STK_Pro (ﬁ) in the Object Browser.

2. Select Properties (E).
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3. Select the Basic - Terrain page when the Properties Browser opens.
4. Clear Use terrain server for analysis.

You're using a local terrain file for both analysis and visualization. By turning off streaming terrain, you are
simulating what you'd see in a setting that doesn't have an Internet connection.

5. Click Add inthe Custom Analysis Terrain Sources: frame.

6. Open the file type shortcut menu.

7. Select USGS DEM (DEM).

8. Browse to the Terrain folder on your desktop that contains the hoquiam-e.dem file.
9. Select hoquiam-e.dem.

10. Click Open .

11. Click OK to accept your changes and to close the Properties Browser.

2D Graphics imagery
Display a background image and inlay in the 2D Graphics window.

1. Bring the 2D Graphics window to the front.

. Click Properties (IEI) in the 2D Window Defaults tool bar.

2
3. Select the Imagery page when the Properties Browser opens.
4. Select the Image File: option.

5

. Ensure Basic.bmp is selected (default).

2D Graphics details
The following will outline international borders and all the states of the United States and provinces of Canada.
1. Select the Details page.
2. Click on and highlight the following (leave RWDB2_Coastlines highlighted) in the Map Details field:
e RWDBZ2_International_Borders

e RWDB2_Provincial_Borders
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Create a yellow outline of the hoquiam-e.dem file's location.
3. Select the Show Extents check box in the Terrain Regions Display frame.

4. Click OK to accept your changes and to close the Properties Browser.

Viewing your changes in the 2D Graphics window

1. Bring the 2D Graphics window to the front.

2. Zoomin (El) to the state of Washington.

The yellow box in the southwest corner of the state is the location of the hoquiam-e.dem file. Analysis inside
the box can be done using local terrain. Analysis outside the box will take place on the WGS84.

3. Zoomin (&l) to the terrain extents and move it to the right of your map.

Creating Color Elevation Imagery utility

The Create Color Elevation Imagery utility allows you to create images from terrain data that show elevation
data colored by height (for example, blue for sea level, green for land, and white for mountain tops). This is
useful if you need to visualize terrain but lack imagery or if you want to put the emphasis on height rather than
the content of the image.

1. Open the Utilities menu.
2. Select Create Color Elevation Imagery.

3. Move the Create Color Elevation Imagery utility next to the terrain region display in the 2D Graphics
window.

4. Enter the following extents which match the hoquiam-e.dem extents:

Option Value
North Lat 47 deg
West Lon -123 deg
East Lon -122 deg
South Lat 46 deg

5. Click Get Min/Max Alt .
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6. Set the following Min Altitude: values in the Color Options frame:

Option Value
Hue 0.25
Saturation 0.75
Value 0.20

7. Select the JPEG 2000 Image (jp2) Format: in the Output File frame.

8. Click the Directory: ellipses (|Z|).

9. Browse to the location of your scenario (e.g. C:\Users\username\Documents\STK 12\STK_Pro).
10. Click Select Folder .

11. Type StHelensColor in the Filename: field.

12. Click Convert.

13. Close the Create Color Elevation Imagery utility.

2D Graphics imagery
2D Graphics Imagery is used to display a background image and inlay images in 2D Graphics windows.

1. Bring the 2D Graphics window to the front.

Open the 2D Graphics window properties (IEI).

Select the Imagery page.

Click Add... in the Inlay Images frame.

Select StHelensColor.jp2 in the Map Images dialog box.

Click Open .

N o o oo b

Click OK to accept your changes and to close the Properties Browser.

Viewing the inlay in the 2D Graphics window

1. Bring the 2D Graphics window to the front.
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Imagery converter

Convert an ISS SERVIR Environmental Research and Visualization System (ISERV) LEVEL-R (RAW) imagery
.Jjpg into JPEG 2000 Image (jp2) inlay.

1. Open the Utilities menu.
2. Select Imagery and Terrain Converter.

3. Select the Single Image page when the Properties Browser opens.

Input data
Select the image file to be converted.
1. Click the Image Filename: ellipsis (E|) in the Input Data frame.

2. Browse to the location of the ISERV imagery (Typically, <STK install
folder>\Data\Resources\stktraining\imagery\) in the File dialog box.

3. Select ISERV_Imagery.
4. Click Open.
5. Select the file named IPR201407092040194622N12217W.JPG.
6. Click Open .
The extents are automatically read from the metadata contained in the supporting files and entered into the
Image: fields located in the Image Extent frame.
Output data

You can select a JPEG 2000 image.
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1. Set the following in the Output Data / Image file frame:

Option Value

Format: JPEG 2000 Image (jp2)

Directory: Location of the scenario (e.g. C:\Users\username\Documents\STK 12\STK_
Pro

Filename: ISERV_StHelens

2. Click Convert .

Terrain converter

Use the Terrain Region converter to create terrain inlays (pdtt files) for a specific region. Select your input data.

1. Select the Terrain Region page.

2. Open the Terrain Source: shortcut menu in the Input Data frame.

3. Select the path to the hoquiam-e.dem file.

Output data

1. Set the following in the Output Data frame:

Option Value

Directory: Location of the scenario (e.g. C:\Users\username\Documents\STK 12\STK_

Pro

Filename: StHelensTerrain
2. Click Convert .

3. Click Close to close the Imagery and Terrain Converter when finished.
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Globe Manager

Globe Manager allows you to customize scenario globes with imagery and terrain data as well as manage that
data once it has been applied. The Hierarchy window is used to add central bodies, image and terrain items to a
scenario.

1. Bring the 3D Graphics window to the front.

2. Click Globe Manager (@) in the Globe Manager toolbar.
3. Click Add Terrain/Imagery (E'I}I) In the Hierarchy toolbar.

4. Select Add Terrain/Imagery... (ﬂ) in the shortcut menu.

Globe Manager: opening Terrain and Imagery Data

You can use the Globe Manager: Open Terrain and Imagery Data dialog box to select imagery and terrain data
to display in the 3D Graphics window.

1. Open the Path: shortcut menu when the Globe Manager: Open Terrain and Imagery Data dialog box opens.
2. Select the path to your scenario (e.g. C:\Users\username\Documents\STK 12\STK_Pro).
3. Select both the Image (ISERV_StHelens.jp2) and Terrain files (StHelensTerrain.pdtt).

4. Click Add .

5. Select No inthe Use Terrain for Analysis dialog box.

You're already using the hoquiam-e.dem file for analysis.

Viewing the Imagery and Terrain files in the 3D Graphics window
1. Right-click on ISERV_StHelens.jp2 in Globe Manager.
2. Select Zoom To.

3. Use your mouse to view the image and surrounding terrain.
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4.

You can see the satellite image ISERV_StHelens.jp2 which is placed on top of the StHelensTerrain.pdtt.
Terrain outside of the image is still visible. If desired, you can return to Globe Manager and turn Aerial.ve
back on to use Bing Maps. You can also, toggle ISERV_StHelens.jp2 or StHelensTerrain.pdtt on and off to
see the visual difference. The ISERV_StHelens.jp2 image can also be used as an inlay in the 2D Graphics
window.

When finished, ensure the ISERV_StHelens.jp2 and StHelensTerrain.pdtt are turned on.

Inserting the GPS Tracking Device

Insert a Place (@ ) object which will simulate the GPS satellite tracking device.

1.

2 S R

~

10.
11.

Select Place (@ ) in the Insert STK Objects tool.

Select the Insert Default (@ ) method.

Click Insert... .

Right click on Place1 (@ ) in the Object Browser.

Select Rename in the shortcut menu.

Rename Place1 (@ ) to TrackingDevice.

Open TrackingDevice's (@ ) properties (E).

Select the Basic - Position page when the Properties Browser opens.

Set the following:

Option Value
Latitude: 46.204 deg
Longitude: -122.188 deg

Set Height Above Ground: to 5 ft. This represents the height of the tracking device's stand.

Click Apply to accept your changes and to keep the Properties Browser open.

Defining an Azimuth-Elevation Mask

The

AzEIMask properties enable you to define an azimuth-elevation mask for the GPS tracking device.
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1. Select the Basic - AzEIMask page.

2. Setthe following:

Option Value
Use: Terrain Data
Use Mask for Access Constraint Select

3. Click Apply to accept your changes and to keep the Properties Browser open.

Selecting Terrain Data automatically creates and stores an azimuth-elevation (Az-El) mask file, which is an
ASCII text file that is formatted for compatibility with STK and ends in an .aem extension, into your scenario
folder. Turning on Use Mask for Access Constraint enables the Az-El Mask constraint located on the
Constraints - Basic page. Using the Az - El Mask constraint constrains access to the object by azimuth-
elevation masking which is a 360 degree field of view around the object being constrained.

Displaying the Azimuth-Elevation Mask

For situational awareness, you can display the Azimuth-Elevation Mask in both the 2D Graphics and 3D
Graphics windows.

1. Select the 2D Graphics - AzEIMask page.

2. Setthe following At Range properties:

Option Value
Show Select
Number of Steps: 10
Minimum Range: 0 km
Maximum Range: 50 km

3. Click OK to accept your changes and to close the Properties Browser.
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Viewing the Azimuth Elevation Mask in the 3D Graphics window

1. Bring the 3D Graphics window to the front.

2. Click Properties (E) in the 3D Window Defaults toolbar.

3. Select the Details page when the Properties Browser opens.
4. Select Enable in the Label Declutter frame.
5

. Click OK to accept your change and to close the Properties Browser.

Label Declutter is used to separate the labels on objects that are in close proximity for better identification in
small areas. It also keeps object labels from being hidden by terrain.

6. Right-click on TrackingDevice (@ ) in the Object Browser.
7. Select Zoom To in the shortcut menu.

8. Using your mouse, zoom out until you can see the visual representation of the Azimuth-Elevation Mask.

Each ring represents a 10 kilometer range out to 50 kilometers. Around the edge of the view, you can see
indications of North (N), South (S), East (E), and West (W). The view indicates that the view to the east,
west, and south are poor. Visibility to the north is good.

Constellation objects

Load the GPS Constellation using orbital elements from GPS almanac files. The Almanac files can be stored in
local directories or pulled from AGI Servers (internet connection required). STK creates a constellation that

*I.I.
includes all of the satellites in the almanac. Keep in mind, you can build Constellation ( %) objects yourself by

m.l.
loading an empty Constellation ( “#) object and assigning objects required for your analysis.

£

1. Insert a Satellite (%) object using the Load GPS Constellation () method.

H"I.I.
Once loaded, you will see each individual Satellite (%) object and a Constellation ( **) object containing
all of the satellites.

-UJ.
2. Open GPSConstellation's ( “*) properties (IEI).

3. Select the Basic - Definition page when the Properties Browser opens.
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You can see each GPS satellite has been moved to the Assigned Objects list. If required, you could remove
any satellites from the list that are non-operational or are not required for analysis.

4. Select the Constraints - Basic page.

For the purposes of this problem, you require access to at least four GPS satellites at any given time. It
doesn't matter which four. Also, take into account that when performing an access, the access will be
analyzed from the satellite to the GPS tracing device.

Open the Set 'From' access position: shortcut menu in the Logical Restriction frame.
Select At Least N.

Change the value to 4.

@ N O o

Click OK to accept your changes and to close the Properties Browser.

Chain objects
A Chain object is a list of objects (either individual or grouped into constellations) in order of access.
1. Inserta Chain (o") object using the Insert Default (0") method.

2. Rename Chain1 (¢°) to GPStoDevice.

Defining the start and end objects
Start by choosing the start object and end object in your chain.
1. Open GPStoDevice's (o") properties (@).
. Select the Basic - Definition page when the Properties Browser opens.

. Click the Start Object: ellipses (E).

2
3
m.l.
4. Select GPSConstellation ( %*) in the Select Object dialog box.
5. Click OK to close the Select Object dialog box.

6

. Click the End Object: ellipses (E).

~

Select TrackingDevice (@ ) in the Select Object dialog box.

8. Click OK to close the Select Object dialog box.
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Choosing the Chain object's connections
After you choose the start and end objects in your chain, you need to build the chain's connections.
1. Click Add in the Connections frame.

Click the From Object: ellipses (E).

Select GPSConstellation (uuij‘) in the Select Object dialog box.
Click OK to close the Select Object dialog box.

Click the To Object: ellipses (E|).

Select TrackingDevice (@ ) in the Select Object dialog box.

Click OK to close the Select Object dialog box.

©® N O a0 W N

Click OK to accept your changes and to close the Properties Browser.

Viewing the accesses in the 3D Graphics window
1. Bring the 3D Graphics window to the front.
2. Zoom To TrackingDevice ().

3. Using your mouse, zoom out until you can see accesses from the ground site to the GPS satellites.

4. Click Start ( .' ) in the Animation toolbar to animate the scenario.

Notice how the accesses don't appear until they're above the Az El Mask. Conversely, they disappear when
they reach the Az El Mask. Terrain is being taken into account for the accesses.

5. Click Reset (l') in the Animation toolbar to reset the scenario when you are finished.

Completing Chain Access Report

The Complete Chain Access report shows times during which access among all objects in a chain is possible
through one or more strands.
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1. Right-click on GPStoDevice (ﬁF) in the Object Browser.

Select Report & Graph Manager... () in the shortcut menu.

At the top of the Styles list clear Show Reports when the Report & Graph Manager opens.

Select the Complete Chain Access (F.“lj) graph in the Installed Styles list.

a o bd

Click Generate... .

The Complete Chain Access is telling you exactly what you need to know. If there is a solid line across the
report, that means you always have access to at least four or more GPS satellites during the entire
analytical period. If there is a break in the line, that's a period when three or less GPS satellites are being
accessed.

6. Close the Graph.

Individual Strand Access

A Individual Strand Access report represents one possible access pathway through the chain. For a chain that
consists of a series of individual objects, only a single strand is possible. If a chain contains one or more
constellations, multiple strands are possible, but constellation constraints (ANY OF, ALL OF, AT LEAST N,
EXACTLY N) can affect the possible number of strands.

1. Return to the Report & Graph Manager.

2. Select the Individual Strand Access (H-lli) graph.
3. Click Generate... .

This graph shows you when the ground site can see individual GPS satellites when that satellite is paired up
with at least three more satellites.

4. Keep the graph open.

Turning off the Azimuth Elevation Mask constraint

You can verify that analytical terrain is being used in your analysis.

1. Open TrackingDevice's (@ ) properties (IEI).
2. Select the Constraints - Basic page.

3. Clear Use in the Az - El Mask frame.
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4. Click Apply to accept your changes and to keep the Properties Browser open.

5. Return to the Individual Strand Access graph.

6. Click Refresh (F5) (@) in the graph toolbar.

Notice how the individual strands grow larger? The surrounding terrain is no longer being used in the
analysis.

7. Return to TrackingDevice's (@ ) properties (IEI).
8. Select Use in the Az - El Mask frame.
9. Click OK to accept your changes and to close the Properties Browser.

10. Return to the Individual Strand Access graph.

11. Click Refresh (F5) (@) in the graph toolbar.

The individual strands shrink because analytical terrain is being used in the analysis.

Saving your work
1. Reset (I') the scenario and close any reports or tools that are still open when you are finished.

—
2. Save () your work.

Summary

You began by loading a USGS DEM terrain file into your scenario which you used as analytical terrain. You used
the Create Color Elevation Imagery tool to create an image from the terrain data that showed elevation data
colored by height in the 2D Graphics window. You used the Imagery and Terrain Converter utility to create an
ISERV image which you displayed in the 3D Graphics window and the terrain converter to create a pdtt terrain
file from the USGS DEM file. You used this file to visualize the terrain features in the 3D Graphics window. You
inserted a Place object into the scenario that simulated a GPS tracking device. You set up the tracking device to
use the terrain analytically. You propagated GPS Satellites from GPS almanac and created a Constellation
object which contained the GPS Satellites. Finally, you inserted a Chain object into the scenario and created
accesses from the GPS Constellation to the tracking device. You required at least four or more satellites in your
analysis which you graphed using a Complete Chain Access graph and an Individual Strand Access graph.
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Part 7: Customize Analysis with Analysis Workbench

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem Statement

Engineers and technicians require additional capabilities when using STK to create custom functions and
calculations relative to times, positions, and reference frames. You work at a ground station that tracks a
recently launched satellite. The ground station's sensor must be turned off when its boresight is within 10
degrees of the Sun. You need a report that tells you when it's safe to track the satellite.

Solution

Use a combination of STK Pro and STK's Analysis Workbench capability to create vectors, custom angles,
calculations, time components and temporal constraints to determine when the sensor can safely track the
satellite.

Create a New Scenario
Create a new scenario.

1. Launch STK (H).

2. Click Create a Scenario (ﬁ).

3. Enter the following in the New Scenario Wizard:

Option Value

Name: STK_AnalysisWorkbench
Location: Default

Start: 1 Mar 2021 16:00:00.000 UTCG
Stop: + 2 days
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4. Click OK when you finish.

—
5. Click Save () when the scenario loads. A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location.

7. Click Save.

Disable Terrain Server

Terrain is not required for this analysis. Disable the Terrain Server.
1. Right- click on STK_AnalysisWorkbench (ﬁ) in the Object Browser.
. Select Properties (IEI).
. Select the Basic - Terrain page.

2
3
4. Clearthe Use terrain server for analysis check box.
5

. Click OK to accept the changes and close the Properties Browser.

Satellite Tracking Station

Insert a Facility object which will act as a satellite tracking station.
1. Select Facility (E) in the Insert STK Objects tool.

. Select the Insert Default (ﬂ) method.

. Click Insert... .

2
3
4. Right-click on Facility1 (E) in the Object Browser.
5. Select Rename.

6

. Rename Facility1 (ﬂ) Tracking_Station.
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Recently Launched Satellite

Insert a Satellite object which will be tracked by the tracking station.
1. Select Satellite (%) in the Insert STK Objects tool.
. Select the Orbit Wizard (@f) method.

2
3. Click Insert... .
4

. Set the following in the Orbit Wizard:

Option Value

Type: Circular

Satellite Name: New_Sat

Inclination: 50 deg

Altitude: 800 km

RAAN: -85 deg
5. Click OK.

Calculate Access

Calculate the times the tracking station can access or see the satellite using the Access tool. This access will be
used as a component when using the Analysis Workbench.

. Right-click on Tracking_Station (ﬂ) in the Object Browser.

—

2. Select Access (:’ ).

3. Select New_Sat (% ) in the Access Tool's Associated Objects list.
4. Click Compute( Compute )

5. Look at the Timeline View. By default the Timeline View is docked at the bottom of the STK GUI.
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6. Note the multiple accesses between Tracking_Station (ﬁ) and New_Sat (% )-

7. Click Close to close the Access tool.

Vector Geometry Tool

The Vector Geometry Tool (VGT) offers the ability to build custom geometric models from any combination of

7 & ), point (@ & [
out-of-the box or user-created Vector ( ), Axes ( ), Point ( ), System ( ), Angle ( )and
Plane ( *ﬁ* ) components.

Open Tracking Station's Properties

Open Tracking_Station's (ﬂ) 3D Graphics - Vector Properties page. We will select vectors to display in the 3D
Graphics window.

1. Open Tracking_Station's (ﬂ) properties (IEI).
2. Select the 3D Graphics - Vector page.

3. Select the Vectors tab.

Display Sun Vector

You will display the Sun Vector. In this scenario, the Sun Vector is anchored to tracking station's center point
and targets the Sun.

1. Select the Sun Vector Show check box.

2. Click Apply to accept the changes and keep the Properties Browser open.

Show Sun Vector

View the Sun Vector in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.

2. Right-click on Tracking_Station (ﬂ) in the Object Browser.

3. Select Zoom To.
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4. Zoom out far enough so that you can see the Sun vector.
5. Click Start ( .' ) to animate the scenario in the Animation toolbar. The Sun Vector follows the Sun.

6. Click the Reset (I') when you are finished.

Show To Vector

A To Vector is a displacement vector between origin and destination object points. To Vectors are automatically
generated by STK for all objects in your scenario. The vectors are stored in a separate folder labeled, To
Vectors, unless a vector with the same name already exists (Earth or Sun). In scenarios with many objects, the

To Vectors folder can be very large for each object. View the New_Sat's (% ) To Vector.
1. Return to Tracking_Station's (ﬂ) 3D Graphics - Vector properties (IEI) page.
Select the Vectors tab.

2.
3. Click Add....
4.

Click the Expand (=) button beside To Vectors (F——') in the Components for: list on the right of the Add
Components window.

5. Select New_Sat.

6. Click OK to close the Add Components window.

Show Magnitude

If Show Magnitude is selected, the magnitude value is displayed on the selected vector. This is only available for
vectors ( f ). Show the magnitude for New_Sat's (%) To Vector.

1. Return to Tracking_Station's (E) properties (IEI) .
Ensure New_Sat Vector is selected in the Vectors list on the 3D Graphics - Vector page.

Select Show Magnitude.

o

Click Apply .

View To Vector

View the To Vector and the Magnitude in the 3D Graphics window.
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1. Bring the 3D Graphics window to the front.

2. Click Start ( .' ) in the Animation toolbar to animate the scenario.

The New_Sat Vector may be below the surface of the central body because the satellite is below the horizon
but will eventually surface. The vector follows the satellite. Show Magnitude provides a constant distance
between the tracking station and the satellite, dynamically, in the 3D Graphics window.

3. Click the Reset (I') when you are finished.

Create a Custom Angle

Create an angle ( E‘b ) between the Sun Vector and the New_Sat To Vector. For the purposes of this scenario,
whenever the angle is 10 degrees or less, the satellite tracking system needs to be shut down.

Open Analysis Workbench Tools

Open the Analysis Workbench Tools, and select the Vector Geometry tab.
1. Right-click on Tracking_Station (ﬂ) in the Object Browser.
2. Select Analysis Workbench (E@).
3. Select the Vector Geometry tab.
4

. Ensure Tracking_Station (E) is selected in the Object list.

5. Click Create new Angle ( 1&'& ) to open the Add Geometry Component window.

Create a Between Vectors Angle

Select the Between Vectors angle type. You will create an angle between the Sun Vector and the New_Sat
Vector.

1. Ensure the Type: is set to Between Vectors. This is the default Type.

2. Enter TrackingAngle in the Name: field.
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Select the From Vector

Select New_Sat's (%) To Vector as the From Vector. The custom angle, TrackingAngle, will be measured
starting from New_Sat's To Vector.

1.

2
3
4.
5
6

Click the ellipsis button (E) beside the From Vector: field. The Select Reference Vector window opens.

. Select Tracking_Station (ﬂ) in the Objects list.

. Scroll up in the Vectors for: Tracking_Station list on the right.

Click the Expand (=) button beside To Vectors (F‘——I ).

. Select New_Sat.

. Click OK to close the Select Reference Vector window.

Select the To Vector

Select the Sun Vector as the To Vector. The custom angle, TrackingAngle, will be measured between the New_
Sat's To Vector and the Sun vector.

1.

a 0B

Return to the Select Reference Vector window.
Note that To Vector: already has the Tracking_Station Sun vector selected.
Click OK to close the Add Geometry Component window.

Note the TrackingAngle vector is in My Components (E7).

Keep the Analysis Workbench (E@) open.

Display the Custom Angle

Custom angles can be viewed in the 3D Graphics window. Add the custom tracking angle to Tracking_Station's (

1.

) 3D Graphics - Vector Properties page.

Return to Tracking_Station's (ﬂ) properties (IEI).

2. Select the 3D Graphics - Vector page.

3. Select the Angles tab.
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Click Add... .
Select TrackingAngle in the My Components (£2) folder in the the Components for: list.
Click OK to close the Add Components window.

Note Show is selected for TrackingAngle.

© N o o =

Click OK to accept the changes and close the Properties Browser.

View Tracking Angle
View the tracking angle in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.

2. Click Start ( .' ) in the Animation toolbar to animate the scenario.

3. Note as the scenario animates, the angle increases and decreases, updating dynamically.

4. Click the Reset (I') when you are finished.

Scalar

You will create a Scalar to return the tracking angle values. A scalar defines components that produce scalar
time-varying calculations. Scalar calculation components also have the ability to return minimum, maximum,

mean, and standard deviation values. You will start by creating a new Scalar Calculation ).

1. Return to the Analysis Workbench (E).

Select the Calculation tab to open the Calculation Tool.

Select Tracking_Station (Q) in the Object list.

=

Click Create new Scalar Calculation () to open the Add Calculation Component window.

Define Scalar Calculation

The default scalar calculation type is Angle. The Angle type is an angular displacement specified by an Angle
component from the Vector Geometry Tool.
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Ensure the Type: is set to Angle. This is the default Type.
Enter Scalar_TrackingAngle in the Name: field.

Click the ellipsis (E|) beside the Input Angle: field. The Select Reference Angle window opens.

Select Tracking_Station (ﬂ) in the Objects list.
Select TrackingAngle in the My Components (E2) folder in the Angles for: Tracking_Station list.
Click OK to close the Select Reference Vector window.

Click OK to close the Add Calculation Component window.

©® N O O R N2

Note Scalar_TrackingAngle is in My Components (£2).

Condition

Create a new Condition ( )
1. Return to the Analysis Workbench (E@) Calculation tab.
2. Select Tracking_Station (ﬂ) in the Object list.

+
3. Click Create new Condition ( ) to open the Add Calculation Component window.

Define Calculation Condition Type

The default Calculation type is Scalar Bounds. Scalar Bounds defines a condition by combining a specified
Scalar component with scalar bounds.

1. Ensure the Type: is set to Scalar Bounds. This is the default Scalar Bounds.

2. Enter Below_10_Degrees in the Name: field.

Define the Scalar
Set the Scalar Calculation, Scalar_TrackingAngle, as the Reference Scalar Calculation.

1. Click the ellipsis (E|) beside the Scalar: field. The Select Reference Scalar Calculation window opens.

2. Select Tracking_Station (E) in the Objects list.
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3. Select Scalar_TrackingAngle in the My Components (£2) folder in the Scalar_TrackingAngle for: Tracking
Station list.

4. Click OK to close the Select Reference Scalar Calculation window.

Define the Calculation Conditions

Define the calculation conditions.
1. Select Below Maximum in the Operation drop down list.
2. Enter 10 deg in the Maximum: field.

3. Click OK to close the Add Calculation Component window.

Create a Report

You can create reports and graphs directly inside the Calculation Tool. Create a report showing when the
tracking angle is below 10 degrees.

1. Return to the Analysis Workbench (E) Calculation tab.
2. Select Tracking_Station (E) in the Objects list.

3. Expand (%) Below_10_Degrees in the My Components (F'—-I ) Components for: list.
4. Right-click on SatisfactionIntervals.

5. Select Report.

The report shows when the tracking angle is 10 degrees or less during the entire scenario interval. However,
it doesn't restrict the report to those times when there are accesses between the tracking station and the
satellite.

6. Close (EI ) the report.

7. Keep the Analysis Workbench (E@) open.

View Accesses and Satisfaction Intervals in the Timeline View

The Timeline View can be used to visualize a variety of time intervals within your scenario. Use the Timeline
View to visualize the times Tracking_Station (
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ﬂ) has access to New_Sat (%) and the times the tracking angle is less than 10 degrees.
1. Return to the Analysis Workbench (E?).

2. Select Satisfactionlntervals under Below_10_Degrees in the My Components (F——') Components for: list.
3. Drag and drop SatisfactionIntervals into the Timeline View's Time Display.

4. Observe the Timeline View.

Time Tool
Using the Time Tool, you will create a custom Interval List ( Ell: ) by merging access times and the below 10
degree satisfaction intervals. Subtract the below 10 degree satisfaction intervals from the accesses to define

tracking opportunities.

1. Return to the Analysis Workbench (E@).

Select the Time tab.
Select Tracking_Station (ﬂ) in the Object list.

Click Create new Interval List ( :@: ) to open the Add Time Component window.

a & w0 BN

Enter Optimal_Tracking_Times in the Name: field.

Define the Interval List Type

Create a Merged Interval List. Merged Interval Lists are intervals merged from multiple Interval or Interval List
Time Components using a merge operation.

1. Click Select... beside the Type: field.

)
2. Select Merged ( :E: ) in the Select Component Type window list.

3. Click OK to close the Select Component Type window.

Define the Operation

Define the merge operation as Minus. Subtract the below 10 degree satisfaction intervals from the accesses to
define tracking opportunities. The Minus operation is available when there are only two Time Components in the
merge list.
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1. Return to the Add Time Component window.

2. Select MINUS in the Operation drop down list.

Remove Time Components

Remove default time components.
1. Select the first time component in the Time Components: list.
2. Click Remove .

3. Repeat the above steps until all time components are removed.

Define the Time Components

In this instance, there are two time components: the accesses between the tracking station and the satellite and
the below 10 degree satisfaction intervals.

1. Click Add... to open the Select Time Intervals window.
2. Select Facility-Tracking_Station-To-Satellite-New_Sat (C?IE] ) in the Object list.

Select Accesslntervals in the Installed Components (F——') Components for: list.
Click OK to close the Select Time Intervals window.

Click Add... onthe Add Time Component window.

o 0~

Select Tracking_Station (ﬂ) in the Object list.

7. Expand () Below_10_Degrees in the My Components (F——') Components for: list.
8. Select SatisfactionIntervals.
9. Click OK to close the Select Time Intervals window.

10. Click OK to close the Add Time Component window.

View Intervals in the Timeline View

You now have all the components for your analysis completed. View them in the Timeline View.
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1. Return to the Analysis Workbench (E@) Time tab.

Select Optimal_Tracking_Times in the My Components (F——l) Components for: list.

Drag and drop Optimal_Tracking_Times into the Timeline View's Time Display.

i\

Observe the Timeline View to see the merged intervals.

o

Return to the Analysis Workbench (E@ ).

6. Click Close .

Tracking Station Sensor

: 2 : . . :
Attach a Sensor object (ﬁ:' ) to the tracking station to track the satellite. Then, using the custom components
created in this lesson, model an outage on the sensor when the tracking angle goes below 10 degrees.

Insert a Sensor on Tracking Station

Insert a sensor object on the tracking station.
T
1. Select Sensor (Ei) in the Insert STK Objects tool.

. Select the Define Properties (IEI) method.

. Click Insert... .

2
3
4. Select Tracking_Station (ﬂ) on the Select Object window.
5

. Click OK .

Model Limited Field-of-View

Set a limited field of view for the sensor to provide situational awareness.
1. Select the Basic - Definition page.
2. Ensure the Sensor Type: is set to Simple Conic. This is the default type.
3. Enter 2 deg in the Cone Half Angle: field.

4. Click Apply .
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Target the Sensor

Use the Targeted pointing type to point the sensor at the satellite.

1.

2
3
4.
5
6

Select the Basic - Pointing page.

. Select Targeted in the Pointing Type: drop down list.

. Select New_Sat (%) in the Available Targets list.

Click Move () to move New_Sat (%) to the Assigned Objects list.

. Click OK.

. Rename Sensor1 (E:I‘) Tracking_Sensor.

Calculate Access

2
Compute an access between the sensor (E?') and the satellite (%).

1.

7.

2
3
4.
5
6

T
Right-click on Tracking_Sensor (ﬁi ) in the Object Browser.

. Select Access (E’).

. Select New_Sat (% ) in the Access Tool's Associated Obijects list.

Click Compute ( Ll ‘=0MPUEE )

. Click Access... inthe Reports section.

. Note the multiple accesses between Tracking_Station (ﬂ) and New_Sat (% ).

Keep the Access tool (D‘) and the report open.

Add Temporal Constraints

You want to know when the tracking station's sensor accesses the satellite, but restrict access when the
sensor's boresight is within 10 degrees of the Sun. You can do this by adding a Targeted pointing type to your
sensor object using the custom components created earlier in this lesson.

cccccc
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1. Open Tracking_Sensor's (E‘:‘) properties (IEI).
Select the Constraints - Temporal page.

Select Use in the Intervals section.

o

Click Import... to open the Select Time Intervals window.

Select Tracking_Station (ﬂ) in the Object list.

o

Select Optimal_Tracking_Times in the My Components (F——') Components for: list.
Click OK to close the Select Time Intervals window.

Note the intervals have populated in the Intervals list.

© ©® N &

Click OK to close the Properties Browser.

Create a New Access Report
Create a new access report to compare the original access report with the constrained report.

1. Return to the Access tool (D‘).

2. Click Access... inthe Reports section.

3. Compare your original access report's Total Duration with the constrained access report's Total Duration.
4. Note the temporal constraint shortens your access time.
5

. Note the times in the access report are the times your sensor can safely access the satellite.

Solar Exclusion Angle

What you have built and used in this lesson is a Solar Exclusion Angle. Set that directly in the sensor
constraints.

1. Open TrackingSensor's (E":‘) properties (IEI).
Select the Constraints - Temporal page.

Disable the Use option in the Intervals list.

DN

Select the Constraints - Sun page.
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5. Enable the Boresight - Solar Exclusion Angle.
6. Setthe value to ten (10) deg.

7. Click OK to close the Properties Browser.

The access times update and just like before, you can see the times that your sensor can safely access the
satellite.
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Part 8: Compute Coverage Over Regions

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Engineers and operators need to analyze global or regional coverage from one asset or from a collection of
assets. They might need to account for constraints such as sunlight and terrain. They may need to simply
analyze if a sensor footprint passes over a specific ground location, or they may need to analyze a large area of
ground or space and determine communication bit error rates in terms of area of interest, age of data, dilution of
precision, etc. In this lesson, you will analyze three satellites and their sensor footprints on the Earth's surface.
You need to determine what percentage of the Earth's surface is seen by all three sensors during a 24-hour
period while taking into consideration sunlight, umbra, and how many times points on the ground are accessed.
Then, you need to determine how long one satellite sensor covers Canada and the continental United States
during the same 24-hour period.

Solution

Use STK to model Earth-observing payloads attached to sensors located in three different orbits. Use STK's
Coverage capability to model and analyze the quality and quantity of coverage provided by the three payloads
to determine the following:

1. The percentage of the Earth's surface the satellite payloads survey during a 24-hour period and daylight
hours only

2. How many times the satellite payloads survey points on the ground during a 24-hour period and daylight
hours only

3. How long points on the ground are seen in Canada and the continental United States

Create a new scenario

Create a new scenario.
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intro.htm

1. Launch STK (H).

2. Click Create a Scenario (ﬁ) in the Welcome to STK window.

3. Enter the following in the STK: New Scenario Wizard:

Option Value

Name STK_Coverage

Location Default

Start 1 Jul 2020 16:00:00.000 UTCG
Stop 2 Jul 2020 16:00:00.000 UTCG

4. Click OK when you finish.

—
5. Click Save () when the scenario loads. A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location.

7. Click Save.

Viewing both the 2D and 3D Graphics windows

You can view coverage in both the 2D and 3D Graphics windows. Placing them side by side makes this simple
to do.

1. Close (EI ) the Timeline View at the bottom of STK.

2. Extend the Window menu.

3. Select Tile Vertically to evenly space the windows side-by-side in the integrated workspace.

Turning off Terrain Server

Analytical and visual terrain is not required in this analysis. Turn off the Terrain Server.
1. Right-click STK_Coverage (ﬁ) in the Object Browser.

2. Select Properties (IEI ).
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3. Select the Basic - Terrain page.
4. Clearthe Use terrain server for analysis check box.

5. Click OK to accept the changes and close the Properties Browser..

Creating a satellite in a circular orbit
Insert the first Satellite (%) and place itin a circular orbit. Circular orbits have a constant radius.

1. Select Satellite (%) in the Insert STK Objects tool.

2. Select the Orbit Wizard (@F) method.

3. Click Insert... .

4. Set the following in the Orbit Wizard window:
Option Value
Type Circular
Satellite Name Circ_Sat
Inclination 55 deg
Altitude 700 km

5. Click OK.

Creating a satellite in a repeating ground trace orbit

Insert the second Satellite (%) and place it in a repeating ground trace orbit. Orbits with repeating ground
traces are useful when you want identical viewing conditions at different times to detect changes. You can have
the ground trace repeat every day or interweave from day to day before repeating.

1. Select Satellite (%) in the Insert STK Objects tool.

2. Select the Orbit Wizard (@f) method.

3. Click Insert... .
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4. Setthe following in the Orbit Wizard window:

Option Value
Type Repeating Ground Trace
Satellite Name Repeat_Sat

5. Click OK.

Creating a satellite in a sun-synchronous orbit

Insert the third Satellite (%) and place it in a sun-synchronous orbit. These orbits are designed to utilize the
effect of the Earth's oblateness, causing the orbit plane to precess at a rate equal to the mean orbital rate of the

Earth around the Sun. Sun synchronous orbits have the property that their nodes maintain constant local mean
solar times.

1. Select Satellite (%) in the Insert STK Objects tool.

2. Select the Orbit Wizard (@P) method.
3. Click Insert... .

4. Setthe following in the Orbit Wizard window:

Option Value
Type Sun Synchronous
Satellite Name Sun_Sat

5. Click OK.

Adding payloads

All three satellites use the same sensor type and size. STK enables you to copy and paste objects from one
object to another. You will set up the first sensor and then copy and paste it to the other two. All you'll have to do
is rename them or STK will use the same name with a one-up number.
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Inserting a Sensor object

Insert a Sensor (8) on Circ_Sat (%). Define a rectangular sensor with a 20-degree vertical half-angle and 10-
degree horizontal half-angle.

1. Select Sensor () in the Insert STK Objects tool.

. Select the Define Properties (IEI) method.

. Click Insert... .

. Click OK.

2
3
4. Select Circ_Sat (%) in the Select Object window.
5
6. Go to the Basic - Definition page.

7

. Set the following:

Option Value
Sensor Type Rectangular
Vertical Half Angle 20 deg
Horizontal Half Angle 10 deg

8. Click OK.

Reusing the Sensor object

Copy and paste the rectangular sensor onto the other two satellites.
1. Select the Sensor (E:") attached to Circ_Sat (%) in the Object Browser .
2. Click Copy (Elh—h‘) in the Object Browser toolbar.
3. Select Repeat_Sat (% ) in the Object Browser.
4. Click Paste (E) in the Object Browser toolbar.

5. Select Sun_Sat (%) in the Object Browser.
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6. Click Paste (E) in the Object Browser toolbar.

7. Expand (1) Repeat_Sat (%) and Sun_Sat (%).

Renaming the Sensor Objects
Rename the three sensors.

1. Right-click the Sensor (E:I‘) object attached to Circ_Sat (%) in the Object Browser.
Select Rename.

Enter Circ_Sens.

o

Press Enter on your keyboard.

5. Repeat the steps above to rename Repeat_Sat's sensor (E‘:.‘) Repeat_Sens and Sun_Sat's sensor (E:I‘)
Sun_Sen.

Adding a Coverage Definition object

The Coverage Definition object defines a coverage area for analysis.

Inserting a Coverage Definition object
Insert a Coverage Definition (‘@) into your scenario.

1. Select Coverage Definition (“®) in the Insert STK Objects tool.
Select the Insert Default (‘@) method.
Click Insert... .
Right-click CoverageDefinition1 (“®) in the Object Browser.
Select Rename.

Enter World_Cov.

N o o A w N

Press Enter on your keyboard.
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Defining the coverage grid
Define the coverage grid to be global, with a 4-degree point granularity.

1. Right-click World_Cov' (‘@) in the Object Browser.

2. Select Properties (IEI ).
3. Go to the Basic - Grid page.

4. Setthe following parameters:

Option Value

Type Global

Point Granularity - Lat/Lon 4 deg
5. Click Apply .

6. Select the 2D Graphics window to bring it to the front. The grid now covers the entire Earth and the grid
spacing is 4 degrees instead of 6 degrees.

7. Select the 3D Graphics window to bring it to the front. Notice the grid covers the entire globe and the grid
spacing is 4 degrees.

Assigning coverage assets

Assets properties allow you to specify the STK objects used to provide coverage. Define the three sensors as
the Coverage Assets.

1. Returnto World_Cov's (‘@) properties (IEI).

. Select the Basic - Assets page.

2

3. Use the Ctrl key to select all three Sensor (Eﬁ‘) objects in the Assets field.
4. Click Assign .
5

. Click Apply .

Turning off automatic recomputation of accesses

STK automatically recomputes accesses every time you update an object on which the coverage definition
depends (such as an asset). If you want control as to when STK computes coverage, you need to turn this off.
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1. Go to the Basic - Advanced page.
2. Clear the Automatically Recompute Accesses check box.

3. Click OK .

Using the Compute Accesses tool

The ultimate goal of coverage is to analyze accesses to an area by using assigned assets and applying
necessary limitations upon those accesses. Compute coverage with the Compute Accesses tool.

1. Select World_Cov (“®) in the Object Browser.

2. Extend the CoverageDefinition menu.
3. Select Compute Accesses. There is a progress bar in the lower-right corner of STK.
4. Right-click World_Cov (“®) in the Object Browser when computing accesses is complete.
5. Select Report & Graph Manager (El).
6. Select Coverage By Latitude graph (H-hj) in the Installed Styles list.
7. Click Generate... .
The Coverage By Latitude graph is a quick way to see the percentage of time covered by latitude.
8. Close (5I ) the graph.

9. Click Close on the Report & Graph Manager window.

Figure of Merit

STK enables you to specify the method by which the quality of coverage is measured using a Figure Of Merit (

A ) object.

Inserting a Figure of Merit

Insert a Figure of Merit object.
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1. Select Figure Of Merit(#) in the Insert STK Objects tool.
Select the Insert Default (#) method.
Click Insert... .

Select World_Cov ("&) in the Select Object window.

Click OK .

o a ke w N

Rename the Figure Of Merit (#) to Simple_Cov.

Measuring Simple Coverage

Simple Coverage measures whether or not a point is accessible by any of the assigned assets during the
analysis period. Areas on the map that are shaded mean that the surface point is seen by at least one sensor
footprint during the 24-hour analysis period.

1. Right-click Simple_Cov's (#) in the Object Browser.

2. Select Properties (E).
3. Note the default Definition - Type is set as Simple Coverage on the Basic - Definition page.

4. Click Cancel .

Your 2D Graphics window may display different colors than the image above. You can change the color in

Simple_CovV's (#) 2D Graphics - Static properties page.

Reporting Percent Satisfied

Generate a Percent Satisfied report. This presents the percentage of the total grid area where the static value of
the Figure Of Merit meets the specified satisfaction criterion. In this scenario, the report shows the percentage of
the globe that is accessible by any of the three sensors during the analysis period.

1. Right-click Simple_Cov (#) in the Object Browser.

. Select Report & Graph Manager (El).

2

3. Select Percent Satisfied report ( ) in the Installed Styles list.
4. Click Generate....
5

. Note the % Satisfied value at the bottom of the report (e.g., 78%).
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78% of the globe is covered by at least one of the three sensors during the analysis time period.

6. Close (ﬁl ) the report when finished.

7. Close (il ) the Report & Graph Manager.

Creating a constraint

Once you have defined the grid area, you can specify an object class or a specific object for the points within the
grid. You are interested in the percentage of coverage during periods of direct sun.

Creating a Target object
Insert a Target (E) object and define a direct sun lighting constraint. This will be the grid constraint object.
1. Select Target (E) in the Insert STK Objects tool.

Select the Define Properties (IEI) method.
Click Insert... .

Go to the Constraints - Sun page.

Select Lighting.

Ensure Direct Sun is set.

Click OK .

Rename the Target (E) Constraint_Template.

© © N O O 0D

Clear the check box next to Constraint_Template (@) in the Object Browser. There is no need to see

Constraint_Template (E) on the 2D or 3D Graphics windows.

Applying the grid constraint
Set the Target (@) object as the grid constraint. It contains the constraint you want to apply to the coverage grid.

1. Right-click World_Cov' (&) in the Object Browser.

2. Select Properties (E).
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3.
4.

® N o o

Click Grid Constraint Options... on the Basic - Grid page.

Ensure Reference Constraint Class is set to Target on the Grid Constraint Options window. For all object
classes, the Basic properties of the object, excluding positional information, are applied to the grid points.

Select the Use Object Instance check box.
Select Constraint_Template.

Click OK to close the Grid Constraints Options window.

Click OK to accept the changes and close World_Cov's (®) properties (E).

Recomputing accesses

Since a change was made to the coverage grid, you need to recompute accesses.

1.

Select World_CoV' (®) in the Object Browser.

. Extend the CoverageDefinition menu.

2
3.
4

Select Compute Accesses. There is a progress bar in the lower-right corner of STK.

. Bring the 2D Graphics window to the front when finished.

Determining Coverage Loss

It's obvious from the view in the 2D Graphics window that you have less coverage using a Direct Sun constraint.
Due to the analysis time period, there is more sunlight in the northern hemisphere that you can see on the map.
Generate a Percent Satisfied report to determine the percent coverage loss.

1.

cccccc

Right-click Simple_Cov (#) in the Object Browser.

. Select Report & Graph Manager (El).

. Select Percent Satisfied report ( ) in the Installed Styles list.

2
3
4.
5

Click Generate... .

. Note the % Satisfied value at the bottom of the report (e.g., 45 %).

Since coverage is now being analyzed during periods of direct sun and not being analyzed during periods of
umbra, there's a significant loss of coverage.
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6. Close (X) the report when finished.

7. Close (¥) the Report & Graph Manager.

Measuring Number of Accesses

Insert a new Figure of Merit to measure Number of Accesses. This will measure the number of independent
accesses of points.

1. Clear the check box next to Simple_Cov (# ) in the Object Browser.
Select Figure Of Merit (#) in the Insert STK Objects tool.

Select the Define Properties (IEI) method.

Click Insert... .

Select World_Cov (J&) in the Select Object window.
Click OK .
Select Number Of Accesses as the Definition - Type on the Basic - Definition page.

Keep Compute set to the default Total.

© ©® N o g A N

Click OK .

10. Rename the Figure Of Merit (#) Num_Access.

Generating a Grid Stats report
Generate a Grid Stats report to see the smallest to largest number of accesses to any point in the grid.
1. Right-click Num_Access (#) in the Object Browser.

. Select Report & Graph Manager (£lI).

2

3. Select Grid Stats report ( ) in the Installed Styles list.
4. Click Generate... .
5

. Note the Maximum value (e.g., 8).
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That means at least one point in the grid was accessed on eight different occasions during the analysis
period.

6. Note the Minimum value (e.g., 0).

That means at least one point in the grid was never accessed by any of the three sensors during the
analysis period.

7. Close (ﬂ ) the report when finished.

8. Close (Xl) the Report & Graph Manager.

9. Clear the check box next to World_Cov ("&) in the Object Browser.

Creating an Area Target object for coverage

You can focus the coverage grid in a confined location using Area Target () objects. For this part of the
analysis, you will focus on the continental United States and mainland Canada. You will ignore islands and
territories.

Insert an Area Target () to model Canada and the continental United States.

1. Select Area Target () in the Insert STK Objects tool.

. Select the Select Countries and US States (H) method.

2

3. Click Insert... .

4. Clear US States on the Select Countries And US States window.
5

. Use the Ctrl key to select Canada and United_States_of America in the countries list on the left. You can

insert them individually if desired.
6. Click Insert.

7. Click Close .

Defining a new Coverage Definition
@

You want to determine coverage time inside the boundaries of the Area Targets (). You will use Repeat_

= .
Sens (Eﬁ ) as the asset. No constraints are necessary.
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Inserting a Coverage Definition
Insert a new Coverage Definition (“®).
1. Select Coverage Definition ('@) in the Insert STK Objects tool.
2. Select the Define Properties (IEI) method.
3. Click Insert... .
4

. Rename the new Coverage Definition (‘@) Country_Cov.

Define Coverage Grid

Define the coverage area of interest to be Canada and the continental United States using the Area Targets (

).

1. Open the Coverage Definition ('@) Properties (IEI).

2. Set Type as Custom Regions in the Grid Area of Interest section on the Basic - Grid page.

3. Select Area Targets in the drop-down menu below Custom Regions.

4. Use the Ctrl key to select Canda and United_States_of America in the Area Targets list on the left.
5. Click Move () to move the Area Targets to the Selected Regions list on the right.

6. Setthe Point Granularity - Lat/Lon to 1 deg.

7. Click Apply .

8. Bring the 2D Graphics window to the front.

9. ZoomIn (&l) so that you only see Canada and United States.

Your 2D Graphics window may display different colors than the image above. The grid point colors can be
changed by changing Country_Cov's ('@) color in the Object Browser or on Country_Cov's (‘@) 2D Graphics
- Attribute properties page.

10. Ifdesired, you can Zoom In (E—l) and center the 3D Graphics window to the same view as the 2D
Graphics window.
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Assigning a coverage asset
Define Repeat_Sens (Ei‘) as the Coverage Asset.

1. Return to Country_Cov's ('@) properties (IEI).

. Select the Basic - Assets page.

2

3. Select Repeat_Sens (E) in the Assets list.
4. Click Assign .
5

. Click Apply .

Turning off grid display
You will display Figure Of Merit graphics, so turn off the grid point display.
1. Select the 2D Graphics - Attributes page.

2. Clearthe Show Points check box in the Show - Grid field. This turns off the visual grid inside the Area
Target () objects. Analytically, they're still there.

3. Click OK .

Computing accesses

You can compute accesses from the Object Browser vice the CoverageDefinition menu.
1. Right-click Country_Cov ("3) in the Object Browser.
2. Select CoverageDefinition.

3. Select Compute Accesses. There is a progress bar in the lower-right corner of STK.

Defining a Figure Of Merit object

Use a Figure Of Merit (&%) object to determine the amount of time during which the grid points are covered by

Repeat_Sens (E).
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Inserting a Figure of Merit
Insert a Figure Of Merit (A") to measure the quality of coverage of Country_Time (J&).
1. Select Figure Of Merit (#) in the Insert STK Objects tool.

. Select the Define Properties (IEI) method.

. Click Insert... .

2
3
4. Select Country_Cov (’&) in the Select Object window.
5. Click OK .

6

. Rename the Figure Of Merit (#) Cov_Time.

Measuring Coverage Time

Set the Figure Of Merit to Coverage Time. It will measure the amount of time during which grid points are
covered.

1. Set the Definition - Type to Coverage Time on the Basic - Definition page.
2. Change Compute to Total Time Above.

Total Time Above computes the amount of time over the entire coverage interval during which a point is
covered by at least the specified number of assets based on the entire coverage interval.

3. Click Apply .

Generating a Grid Stats report

Generate a report to determine the minimum and maximum amount of time any of the grid points are covered by
)
Repeat_Sens (ﬁi ).

1. Right-click Cov_Time (#) in the Object Browser.

. Select Report & Graph Manager (&l).

2
3. Select Grid Stats report ( ) in the Installed Styles list.
4

. Click Generate... .
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5. Note the Maximum time (e.g., 49 seconds).

That means at least one point in the grid was accessed for a total of 49 seconds during the analysis period.

6. Returnto Cov_Time's (#) properties (IEI).

Defining static graphics for the Figure Of Merit
Define static graphics for the Figure Of Merit on the 2D Graphics - Static page.
1. Goto the 2D Graphics - Static page.

2. SetFilled Area - % Translucency to 30 in the Show Points As field.

3. Select Show Contours in the Display Metric field.
4. Click Remove All inthe Level Attributes field.
5

. Set the following in the Level Adding field:

Option Value
Start 0 sec
Stop round down to the nearest integer from the Maximum (sec) value in the Grid Stats

report (e.g. 49 sec)

Step 5sec

6. Click Add Levels .
7. Change the Color Ramp Start Color to red in the Level Attributes field.
8. Change the End Color to blue in the Level Attributes field.
Points with no coverage will be red and any points at or above your highest Level Attribute value will be blue.

9. Select Natural Neighbor in the Contour Interpolation (points must be filled) field. Color is applied smoothly
over all points in the grid to differentiate contour levels.

10. Click Apply

Set 2D and 3D Graphics windows legends

Once you have set the contours for coverage, you can set the display of the contour key, or legend.
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1. Returnto Cov_Time's (#) properties (IEI) 2D Graphics - Static page.
Click Legend... .

Click OK toclose Cov_Time's (#)properties (IEI).

Click Layout... inthe Static Legend for Cov_Time window.

a 0 b

Set the following on the Figure of Merit Legend Layout window:

Option Value

2D Graphics Window - Show at Pixel Location on

3D Graphics Window - Show at Pixel Location on

Text Options - Title: Coverage Time (seconds)
Text Options - Number Of Decimal Digits: 0

Range Color Options - Color Square Width (pixels): 50

Click OK .
Close (5I ) the Static Legend for Cov_Time window.

Bring the 2D and 3D Graphics windows to the front.

© © N O

Note Snap Frame () in both the 2D and 3D Graphics windows. You could use Snap Frame to take a
picture of the map to place in a PowerPoint slide or in a document.

Summary

You placed three Satellite (%) objects into the scenario using circular, repeating ground trace and sun-
synchronous orbits. All three satellites had similar Sensor (Eh‘) objects. You built a Coverage Definition (‘@)
object and set the grid definition to global. Using all three Sensor (ﬁh‘) objects, you computed access. Using a

Figure Of Merit (#) object, you learned about Simple Coverage and how to analyze the percentage of the

Earth accessed during a twenty four hour period. Next, you loaded a Target (E) object at the Prime Meridian
(default location), and set a direct sun constraint. Returning to the Coverage Definition (“®) object, you applied
the constraint across the coverage grid and recalculated coverage to see how the direct sun constraint affected
the percentage of coverage. The next step was to add a second Figure Of Merit (ﬁ") object and determine the
number of accesses against each point in the coverage grid. Switching gears, you loaded two Area Target (
) objects which outlined the continental United States and Canada. With a new Coverage Definition (®) object,

you focused coverage inside of the Area Target () objects using only the Sensor (El‘) object attached to the
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satellite in the repeating ground trace orbit. This time, you configured a new Figure Of Merit (A") object to focus
on how long each point in the coverage grid was covered by the Sensor (ﬁ:‘) object. Finally, you learned how to
apply static contours to both the 2D and 3D Graphics windows.
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Part 9: Introduction to the AzEl Mask Tool and
Volumetrics

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem

Engineers and operators require a quick way to determine if the Earth, local terrain, nature and man-made
structures affect visibility between ground sites and satellites for a variety of purposes such as communications,
imaging, radar and general situational awareness. A country's space program is planning to install a satellite
tracking radar in an area that has distant hills and a large mountain range. A communication antenna enclosed
by a large radome will be constructed close by. Engineers want to determine how much impact the Earth, terrain
and the radome will have on the radar's field of view.

Solution

Using STK, insert Facility objects which will simulate the radar and communication sites. Use a local terrain file
for analysis and determine access times between the radar field of view and five earth observation satellites.
Use the AzEI Mask Tool to determine if the communication site's radome further degrades the radar's access
times to the satellites. Insert an Area Target object to outline the approximate maximum distance that a satellite
can be observed by the radar site. Apply the Analysis Workbench's Spatial Analysis Tool to build a constrained
grid to determine how much of the radar's field of view is blocked by the Earth, terrain and the radome at a
selected distance and altitudes.

Creating a new scenario

Create a new scenario.
1. Launch STK (E).
2. Click Create a Scenario in the Welcome to STK window.

3. Enter the following in the STK: New Scenario Wizard:
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Option Value

Name: AzEIMask_Volumetrics
Location: Default

Start: 1 Aug 2022 12:00:00.000 UTCG
Stop: 2 Aug 2022 12:00:00.000 UTCG

4. Click OK when you finish.

s
5. Click Save () when the scenario loads. A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location.

7. Click Save.

Turning off terrain server

A local analytical terrain file will be used in this analysis. Disable the Terrain Server.
1. Right click on AzEIMask_Volumetrics's (ﬁ) in the Object Browser.
. Select Properties (IEI).
. Select the Basic - Terrain page.

2
3
4. Clear the Use terrain server for analysis check box.
5

. Click OK to accept the change and close the Properties Browser.

Adding analytical and visual terrain

An STK Terrain File (pdtt) located in the STK install area will be used for analysis and situational awareness in
the 3D Graphics window.

1. Bring the 3D Graphics window to the front.
2. Click Globe Manager (E) in the 3D Graphic window toolbar.

3. Extend the Add Terrain/Imagery (Q) menu on the Globe Manager toolbar.
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4. Select Add Terrain/Imagery (ﬂ) in the shortcut menu.
5. Click the Path: ellipsis (|I|) in the Globe Manager: Open Terrain and Imagery Data dialog box.

6. Navigate to <STK Install Folder>\Data\Resources\stktraining\imagery (e.g. This PC then C:\Program
Files\AGN\STK 12\Data\Resources\stktraining\imagery) in the Browse For Folder dialog box.

7. Click OK.
8. Select RaistingStation.pdit.
9. Click Add .

10. Click Yes to enable terrain for analysis in the Use Terrain for Analysis prompt.

Decluttering 3D Graphics window labels

Label Declutter is used to separate the labels on objects that are in close proximity for better identification in
small areas.

1. Bring the 3D Graphics window to the front.

2. Click Properties (IEI) in the 3D Windows toolbar.
3. Select the Details page.

4. Select Enable in the Label Declutter frame.

5

. Click OK.

Inserting the radar site

Use a Facility object as the radar site location.

A
. Bring the Insert STK Objects Tool (#tr) to the front.

—

2. Select Facility (ﬂ) in the Select An Object To Be Inserted: list.

3. Select Insert Default (ﬁ) in the Select A Method: list.

4. Click Insert...

5. Right click on the Facility1 (E) in the Object Browser.
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6. Select Rename in the shortcut menu.
7. Rename the Facility1 (ﬁ) to Radar_Site.

8. Open Radar_Site's (ﬁ) properties (IEI).

Moving the radar site to its location
The radar site is located in Germany.
1. Select the Basic - Position page.

2. Set the following:

Option Value

Latitude: 47.8996 deg

Longitude: 11.1142 deg
3. Click Apply .

Defining an Azimuth-Elevation Mask

Define an Azimuth -Elevation Mask (AzEl Mask) to use local terrain analytically. The AzEl Mask constraint
leverages a provided or computed AzEI Mask to determine visibility.

1. Select the Basic - AzEIMask page.

2. Set the following:

Option Value
Use: Terrain Data
Use Mask for Access Constraint on

3. Click OK .
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Using a Sensor Object to Define the Radar's Field of View

Use a Sensor object to simulate the radar system's field of view (FOV).
= T
1. Inserta Sensor (ﬁ:') object using the Insert Default (ﬁi ) method.

2. Select Radar_Site (ﬂ) in the Select Object dialog box.

3. Click OK.

=
4. Rename the Sensor1 (E:' ) to Radar_FOV.

Creating the radar field of view

Use a Complex Conic sensor pattern. Complex Conic sensor patterns are defined by the inner and outer half
angles and minimum and maximum clock angles of the sensor's cone.

1. OpenRadar_ FOV's (E:I‘) properties (IEI).

2. Select the Basic - Definition page.

3. Open the Sensor Type: shortcut menu.

4. Select Complex Conic.

5. Setthe Complex Conic - Half Angles - Outer: value to 180 deg.

6. Click Apply .

By setting the Half Angles - Outer: value to 180 deg (vertical angle) and leaving the default Clock Angles values
(horizontal angle), you've created a 360 degree FOV.

Raising the antenna's field of view

The radar's antenna is positioned twenty (20) feet above the ground's surface. Sensor Location properties
enable you to position a sensor with respect to its parent object. A Facility object's positive (+) Z body points to
the center of the earth. If you want to move the Sensor object up, you have to use a negative (-) Z value.
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Select the Basic - Location page.
Open the Location Type: shortcut menu.
Select Fixed.

Set the Fixed Lcoation - Z: field to -20 ft.

a 0 b~

Click Apply .

Using the AzEIl mask constraint

A Sensor object can use its parent object's AzEl Mask.
1. Select the Constraints - Basic page.
2. Select Az-El Mask.

3. Click Apply .

Visualizing the terrain constraint

2D Projection Graphics for sensors control the display of sensor projection graphics in the 2D and 3D Graphics
windows. In order to visualize the constraints that the Sensor object is using, you have to define which
constraints can be used to modify the field of view of the sensor.

1. Select the 2D Graphics - Projection page.
2. Select Use Constraints in the Field of View frame.
3. Select AzEIMask in the list.

4. Click Apply .

3D Graphics Projection Properties

3D Graphics Properties for Sensors - Projection is used to control the display of a sensor's cone into space as
well as the sensor's extension into space. Extension distances define the length of a sensor's projection. For a
constant space projection, enter the projection length in the Space Projection field. In this case, the distance is
computed so that the projection of the outermost point on the contour along the bore sight is equal to the
distance entered. This is a visualization property, not an analytical property.
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1. Select the 3D Graphics - Projection page.
2. Setthe Extension Distances - Space Projection: field 50 km.

3. Click OK.

Viewing the radar antenna's field of view
You are using a Sensor object to visualize the projected field of view of a radar antenna.

1. Bring the 3D Graphics window to the front.
2. Click Home View (%) in the 3D Graphics toolbar.

o
3. Change you view so that you can see Radar_FOV's (E:' ) field of view.

Your image might look different from the image in this tutorial. You can orient the 3D Graphics window to obtain
the same view but it's not required.

If you were only using the Line of Sight constraint, the sensor field of view would be round. In this instance, you
are taking into account the central body (Earth) and terrain which is causing the blockage of the sensor's field of
view.

Inserting Earth Observation Satellites

The radar site's primary purpose is to track five (5) Earth observation satellites.

1. Insert a Satellite (%) object using the From Standard Object Database (Q) method.

2. Set the following in the Standard Object Database tool:

Option Value

Owner: Germany

Mission: Earth Observation
Click Search.

Press Ctrl on your keyboard and select TanDEM-X and TerraSAR-X in the Results: list.

Click Insert .

AR

Click Close to exit the Standard Object Database tool after both satellites are propagated.
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Removing unneeded objects

For your scenario, you won't be using the Sensor objects attached to your satellites.

1.

@b

o

2]
Select all the Sensor (E:') objects attached to TanDemX_36605 (% ) in the Object Browser.

Click Delete ()() in the Object Browser toolbar.

Click Delete in the Delete Objects dialog box.
T
Select all the Sensor (E:') objects attached to TerraSarX_31698 (%) in the Object Browser.

Click Delete (x) in the Object Browser toolbar.

Click Delete in the Delete Objects dialog box.

Determining Access

Determine the total time each satellite appears within the sensor's field of view. That is considered access time.
You will use this value as a benchmark to see if the radome affects accesses to the satellites.

1.

N o oo A w N

Right click on Radar_FOV (E) in the Object Browser.

Select Access (E’ ).

Select both Satellite (% ) objects in the Access Tool's Associated Objects list.
Click [E Compute

Click Access... inthe Reports frame.
Scroll to the bottom of the report.

Note the Total Duration value in the Global Statistics section (e.g. ~ 6429 seconds).

Saving access report as an external text file

Save the access report outside of STK. This is a safe way to retain the original analysis values.
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1. Return to the access report.

Click Save as text () in the Access report toolbar.

Ensure your scenario folder displays in the in Address bar in the Save Report dialog box.
Enter Sensor to Satellites Terrain Only in the File name: field.

Click Save.

Close the access report.

N o g oo N

Close the Access Tool.

Inserting Communication Site Radome

Construction crews will build a large communication site radome less than one half a kilometer from the
proposed radar site. Use a Facility object as the radar site location.

§ Note: In this scenario, you're using a Facility object to simulate the communication site's radome. If you

were actually performing this analysis against an actual building, you would need to consider creating
your own 3D model built to specifications.

1. Insert a Facility (ﬂ) object using the Insert Default (E) method.
Rename Facility2 (ﬂ) to Comm_Radome.

Open Comm_Radome's (ﬂ) properties (IEI).

Select the Basic - Position page.

a k o b

Set the following:

Option Value
Latitude: 47.9020 deg

Longitude: 11.1135 deg

6. Click OK.
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Viewing the Communication Radome
View the radome in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.

2. Right click on Comm_Radome (ﬂ) in the Object Browser.
3. Select Zoom To.
4. Change your view so that you can see the communication site radome and the and radar site.

2
5. Use your mouse to set the view so that you can see how Radar_FOV's (ﬁ:') projection cuts through

Comm_Radome's (ﬂ) 3D Model.

If you look closely, you can see that the sensor's projection cuts through the communication site's radome. The
Facility object's 3D Graphics model is not being used as an obstruction during analysis. In order to use the
Facility object's 3D graphics model as an obstruction, you use the AzEl Mask tool.

Opening the AzEIl Mask Tool

Use the AzEI Mask tool to create a body masking file (.bmsk) that can be used in access computations and
visualization. The static body masking files (.bmsk) that are created are used to restrict visibility to a sensor.

1. Maximize your 3D Graphics window.

2. Select Radar_FOV (E:I‘) in the Object Browser.
3. Open the Sensor menu item at the top of STK.

4. Select AzEI Mask.

The Az/El Mask View window allows you to see the obscuring objects in the six views used in generating the
contours. The views will be shown in successive fashion when the Compute button is clicked.

The AzEI Mask window enables you to identify obscuring objects and define the instant in time at which
obscuration contours are computed.

\nsys Page 120 of 292

ssssssssssssssssssssssssss



Preparing the AzEl Mask Tool

Start by setting up the AzEIl Mask Tool prior to creating a .bmsk file. Set Comm_Radome (E) as the obsurring
object and the window dimension to 700.

1. Move the AzEI Mask window (AzEIMask for Radar_FOV) to the right so that it isn't on top of the Az/El Mask
View window.

Select Comm_Radome (ﬂ) in the AzEI Mask window's Obscuring Objects list.
Set the Window Dim: value to 700 in the Data frame.
Click Apply .

Click Compute...

o gk w N

Ensure your .bmsk file (use the default file name) is being saved in your scenario folder in the Select Body
Mask File dialog box.

7. Click Save.

8. Close the AzEI Mask window and the Az/El Mask View window when the computation is complete.

Constraining the sensor with the AzElI Mask
You can use the body mask file (.bmsk) as a Sensor object's access constraint.
1. OpenRadar_FOV's (E:I‘) properties (E).
Select the Basic - Sensor AzEI Mask page.
Open the Use: shortcut menu.
Select MaskFile.
Click the Mask File: ellipsis ().
Browse to your scenario folder if required when the Select File dialog box opens.

Select Radar_FOV.bmsk in the list.

©® N o g R 0N

Click Open .
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9. Select Use Mask for Access Constraint.

10. Click Apply .

Visualizing the sensor AzEI Mask constraint

In order to visualize the Sensor AzEIl Mask constraint, follow the same procedure as you did to visualize the
terrain Az-El Mask.

1. Select the 2D Graphics - Projection page.

2. Leave AzEIMask selected in the Field of View - Use Constraints frame.

3. Scroll down the Field of View - Use Constraints list until you locate SensorAzEIMask.
4. Press Ctrl on your keyboard and select SensorAzEIMask.
5

. Click OK.

Viewing the sensor AzE|l Mask constraint in the D Graphics window

You can view the constraint in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.
2. Zoom To Radar_Site (E).

3. Change your view so that you can see Radar_Site (E), Comm_Radome (E), and Radar_FOV's (E)
field of view being affected by Comm_Radome (ﬁ).

Determining Access

Determine the total time each satellite appears within the sensor's field of view.
T
1. Right click on Radar_FOV (ﬁi ) in the Object Browser.
2. Select Access... (:’)_

3. Select both Satellite (% ) objects in the Access Tool's Associated Objects list.
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4. Click Access... inthe Reports frame.
5. Scroll to the bottom of the report.

6. Note the Total Duration value in the Global Statistics section (e.g. ~ 6232 seconds).

Comparing data

Compare access data between the access using terrain and the access using terrain and a .bmsk file. The best
result would be that you don't lose any access duration.

1. Open Windows File Explorer (F‘——I ).
2. Browse to your scenario folder (e.g. C:\Users\username\Documents\STK 12\AzEIMask_Volumetrics).
3. Open the Sensor to Satellites Terrain Only.txt file.

4. Returnto STK.
5

. Compare the Global Statistics Total Duration time in the text file to the Total Duration time in the Access
Report.

» Did the communication site radome affect your total duration access time?
6. Close both reports and the Access Tool when finished.
7. Open the Analysis menu.

8. Select Remove All Accesses.

Analyzing the radar field of view

Based on the curvature of the Earth and that both satellites being tracked by the radar are in a low Earth orbit
(LEO), you want to determine how much of the radar's field of view is blocked by the Earth, terrain and the
radome in a 360 degree circle using a radius of 3000 kilometers from the radar site. A 3D volume of space will be
analyzed inside the sphere between 10 to 700 kilometers in altitude. In order to determine how much the radar
field of view is affected, you will use an Area Target object, a Volumetric object, and the Analysis Workbench
Spatial Analysis Tool.
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Inserting an Area Target
Insert an Area Target () to model the 300 km circle on the ground.
1. Insertan Area Target () object using the Area Target Wizard (@) method.

2. Setthe following in the Area Target Wizard (@):

Option Value

Name: OpsArea

Area Type: Ellipse

Semi-Major Axis: 3000 km

Semi-Minor Axis: 3000 km

Centroid: 47.8996 deg (Latitude)

Centroid: 11.1142 deg (Longitude)
3. Click OK.

Viewing the Area Target Object in the 3D Graphics window
View the Area Target in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.
2. Click Home View (%).

3. Move your view so that you can see OpsArea ().

Opening the Analysis Workbench Time Tool

There is no need to calculate the radar field of view for the entire analysis period of 24 hours. You can use the
Analysis Workbench Time tool to create a one (1) second interval. You will use this interval when analyzing the
radar's field of view.
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1. Right click on AzEIMask_Volumetrics (ﬁ) in the Object Browser.

Select Analysis Workbench (E) in the shortcut menu.

Select the Time tab when the Analysis Workbench opens.

=

Ensure AzEIMask_Volumetrics (ﬁ) is selected in the object list on the left.

Creating a Fixed Time Interval

You want a time interval of one (1) second.

1. Click Create New Interval ( g ) which is an icon located between the object list on the left and the
components list on the right.

2. Set the following in the Add Time Component dialog box:

Option Value

Type: Fixed Interval

Name: One_Second

Stop Time: 1 Aug 2022 12:00:01.000 UTCG

3. Click OK to close the Add Time Component dialog box.

Creating the Spatial Analysis Reference Grid Component

The Anslysis Workbench's Spatial Analysis tool enables you to create calculations and conditions that depend
on locations in 3D space which are, in turn, provided by user-definable volume grids. You need to create two (2)
grids: a Cartographic grid and a Constrained grid. The reference grid will be used to create a 3D volume of
space encompassing the Area Target object's sphere between 10 to 700 kilometers in altitude.

1. Select the Spatial Analysis tab at the top of the Analysis Workbench Tools interface.

. Select OpsArea () in the object list.

2

3. Click Create New Volume Grid ( ﬂ* ).

4. Ensure the Type: is Cartographic in the Add Spatial Analysis Component dialog box.
5

. Change the Name: to Ref_Grid.
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6. Click Set Grid Values...

7. Set the following in the Altitude frame when the Grid Values dialog box opens:

Option Value
Minimum: 10 km
Maximum: 700 km
Number of Steps: 20

The number of steps determines how many grid points are added to the volume for computation and
analysis.

8. Click OK to close the Grid Values dialog box.

9. Click OK to close the Add Spatial Analysis Component dialog box.

Creating the Spatial Analysis Constrained Grid Component

A constrained volume grid is one in which the grid points from the reference grid are available only when the
spatial condition is satisfied.

1. Ensure OpsArea () is selected in the object list in the Spatial Analysis tool.

2. Click Create New Volume Grid ( ﬁ ).

3. Setthe following in the Add Spatial Analysis Component dialog box:

Option Value
Type: Constrained
Name: OpsArea_Constrained

Selecting the Reference Grid

Select the Ref-Grid ( ﬁ ) created previously as the Reference Grid.

1. Click the Reference Grid: ellipsis ().

2. Select OpsArea () in the object list when the Select Reference Volume Grid dialog box opens.
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3. Select Ref_Grid ( ﬁ ) in the Volume Grids for: OpsArea list.

4. Click OK to close the Select Reference Volume Grid dialog box.

Setting the Spatial Condition

2
Select the Radar_FOV's (ﬁi) Visibility as the Spatial Condition.
1. Click the Spatial Condition: ellipsis (E).

o
2. Select Radar FOV (Eﬁ) in the object list when the Select Reference Spatial Condition dialog box opens.

3. Select Visibility (@ ) in the Spatial Conditions for: Radar_FOV list. This will apply the constrained visibility
=
of Radar_FOV (ﬁ:' ) to the 3D volume grid.

4. Click OK to close the Select Reference Spatial Condition dialog box.
5. Click OK to close the Add Spatial Analysis Component dialog box.

6. Click Close to close the Analysis Workbench.

Inserting Volumetrics Object

The Volumetric object defines a 3-dimensional grid of points using various coordinate definitions, with respect to
various reference coordinate systems from the Vector Geometry tool. It also defines the conditions and
calculations that depend on locations in 3D space and evaluates these conditions and calculations across grid

points.

1. Inserta Volumetric (&E) object using the Insert Default (&‘E) method.

2. Click Save ().

Defining the Volume grid

The default volume grid encircles the Earth up to an altitude of 1000 kilometers. Change it to the constrained
grid.
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1. Open the Volumetric1's (&E) properties (IEI).
Select the Basic - Definition page.

Click the Volume Grid: ellipsis (E|).

> WD

Select OpsArea () in the object list when the Select Volume Grid for Volumetric1 dialog box opens.

o

Select OpsArea_Constrained ( ﬂ* ) in the Volume Grids for: OpsArea list.

6. Click OK to close the Select Volume Grid for Volumetric1 dialog box.

7. Click Apply .

Selecting the Spatial Calculation
A Spatial Calculation is a scalar calculation that depends on both time and location.
1. Select the Spatial Calculation: check box.

2. Click the Spatial Calculation: ellipsis ().

3. Select OpsArea () in the object list when the Select Spatial Calculation for Volumetric1 dialog box
opens.

4. Select Altitude ( ) in the Spatial Calculations for: OpsArea list.

5. Click OK to close the Select Spatial Calculation for Volumetric1 dialog box.

6. Click Apply .

Volumetric Basic Interval
Apply the one second time interval created in the Analysis Workbench Time Tool.
1. Select the Basic - Interval page.

Click the Analysis Interval: ellipsis (E).
Select AzEIMask_Volumetrics (ﬁ) in the object list when the Select Interval or List dialog box opens.

Select One_Second ( g ) in the Components for: AzEIMask_Volumetrics list.

a k0B

Click OK to close the Select Interval or List dialog box.
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6. Click Apply .

—
7. Save () the scenario.

Computing Visibility Inside the Grid

The best case scenario would have 100 percent visibility inside the grid. However, the curvature of the Earth,
terrain, and the radome will reduce this percentage.

1. Select Volumetric1 (&E) in the Object Browser.
2. Open the Volumetric shortcut menu.

3. Select Compute.

Generating a report

Generate a report that shows how much of the radar's field of view is visible.
1. Right click on Volumetric1 (&‘E) in the Object Browser.
2. Select Report & Graph Manager... ().

3. Select the Satisfaction Volume (El) report in the Installed Styles list when the Report & Graph Manager
opens.

4. Click Generate... .

You can see in the report that the radar field of view's percent satisfied is approximately 45 percent.
Remember, you computed this starting at a low altitude of only 10 kilometers. There will be more losses at
lower altitudes due to the central body (Earth), terrain and the radome.

5. Close the Satisfaction Volume report and the Report & Graph Manager when finished.

Displaying Visibility Inside the Grid

The Volumetric 3D Graphics Grid page is used to define the 3D Graphics Volumetric grid properties for the
Volumetric Definition.
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1. Return to Volumetric1's (&E) properties.
2. Select the 3D Graphics - Grid page.

3. Clear Show Grid. This will make the grid look better for a briefing or presentation. If you were analyzing
something like Bit Error Rates per grid point you might leave this on. By clicking on a point in the 3D
Graphics window, you will receive a value for that point. In this scenario, they are on or off.

4. Click Apply .

Viewing Volumetric 3D Graphics Volume

The Volumetric 3D Graphics Volume page is used to show active grid points or spatial calculation levels. Focus
on spatial calculation levels. These levels represent straight line distances from the parent object.

1. Select the 3D Graphics - Volume page.
2. Select the Spatial Calculation Levels radio button.
3. Click Insert Evenly Spaced Values... atthe bottom of the page.

4. Setthe following in the Insert Evenly Spaced Values dialog box:

Option Value
Units km

Start Value: 10 (km)
Stop Value: 700 (km)
Step Size: 100 (km)

B. Click Create Values .

Adjusting translucency

You can adjust translucency of the colors in order to make the levels stick out or fade depending on your desired
view. In this case, you want to be able to see the lower altitude colors more than the higher altitude colors. The
Earth, terrain, and radome affect the lower altitude colors more than the higher altitude colors. You can use the
Translucency slider or manually type in the percentage. In this case, type them in.

\nsys Page 130 of 292

ssssssssssssssssssssssssss



1. Set the following in the % column which is located in the Fill Levels list.

Value km %
10 10
110 20
210 40
310 40
410 50
510 50
610 60
700 60
2. Click Apply .

Displaying Volumetric 3D Graphics Legends

The Volumetric 3D Graphics Legends page allows you to place a legend in the 3D Graphics window which
explains what the colors mean.

1. Select the 3D Graphics - Legends page.
2. Select the Fill Legend tab.

3. Setthe following:

Option Value
Show Legend on
Title: Altitude (km)
Number Of Decimal Digits: 0
Color Square Width (pixels): 40
4. Click OK .
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Viewing the contours
1. Bring the 3D Graphics window to the front.

2. Use your mouse to change your view and get an idea of how obscurations affect the different levels of
altitude.

Summary

A new radar site is being proposed that will track LEO satellites. You loaded analytical terrain into your scehario
that covers the area in which the radar site is going to be built. You then used a Sensor object to create the field
of view of the radar. You propagated two satellites and generated an access between the sensor and the
satellites to create a benchmark access time. Next, you placed a Facility object where a new communications
radome will be constructed. You used the AzE| Mask tool to determine if the radome affects the sensor's field of
view. Generating another access report, you determined that the radome will affect your overall access time to
the satellites. Next, you used the Analysis Workbench Time tool to create a one second interval to be used with
a Volumetric object's compute time. Then, using the Analysis Workbench Spatial Analysis tool, you created a
reference grid inside of an Area Target object and a constrained grid which then applied the Sensor object's
constraints to the 3D volume of space. You determined that a significant amount of your volume is obscured by
the Earth, terrain and the radome.
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Part 10: Perform Trade Studies with Analyzer

Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem

Engineers and operators require a quick way to determine how various orbital parameters such as semi-major
axis, eccentricity, inclination, argument of perigee, right ascension of the ascending node or true anomaly will
effect the ability of a sensor or camera to view the surface of the Earth. In this lesson, you want to quickly run
multiple trade studies to determine how inclination, eccentricity or a combination of both will effect the
percentage of coverage over the entire Earth during a 24 hour period.

Solution

Use STK Pro and STK's Coverage and Analyzer capabilities to run Parametric and Carpet Plot analyses. The
studies will determine the best combination of inclination and eccentricity that provides the highest percentage
of global coverage.

Create a New Scenario

Create a new scenario.

1. Launch STK (H).

2. Inthe Welcome to STK window, click Create a Scenario (ﬁ).

3. Enter the following in the New Scenario Wizard:

Option Value
Name: STK_Analyzer
Location: Default
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Start: 1Jul 2020 16:00:00.000 UTCG

Stop: 2 Jul 2020 16:00:00.000 UTCG
4. When you finish, click OK.

—
5. When the scenario loads, click Save (). A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location and click Save.

View Both the 2D and 3D Graphics Windows

You can view coverage in both the 2D and 3D Graphics windows. Placing them side by side makes this simple
to do.

1. Close the Time Line at the bottom of STK.
2. Click Window in the STK menu bar.

3. Select Tile Vertically.

Turn Off Terrain Server

Analytical and visual terrain is not required in this analysis.
1. Open STK_Analyzer's (ﬁ) properties (IEI).

Select the Basic - Terrain page.

Clear the Use terrain server for analysis option.

> N

Click OK to accept the changes, and close the Properties Browser.

Design a Satellite Orbit

Insert a Satellite (%) object, and place it in a retrograde orbit. Use the Orbit Wizard Orbit Designer which allows
you to create a custom orbit.
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1. Using the Insert STK Objects tool, insert a Satellite (%) object using the Orbit Wizard (@P)method.

2. Set the following:

Option

Type:

Satellite Name:
Semimajor Axis:
Eccentricity:

Inclination:

Argument of Perigee:

RAAN:

True Anomaly:

3. Click OK.

Sensor Object

Value

Orbit Designer
MySat

10600 km
0.363

116 deg

270 deg

104 deg

90 deg

Use a Sensor (E:I‘) object that provides a simple conic, 20 degree, field-of-view. The field of view will simulate a
camera's field-of-view.

1.

cccccc

o o e NN

When the Select Object window opens, select MySat (%).

Click OK.

Using the Insert STK Objects tool, insert a Sensor (Ei‘) object using the Define Properties (IEI) method.

On the Basic - Definition page, change the Simple Conic - Cone Half Angle: value to 10 deg.

Click OK to accept the changes, and close the Properties Browser.

2 I .
Rename the Sensor (ﬁi ) object Camera_View.

NNNNNNNNNNNNNNNNNNN
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Coverage Definition Object

The Coverage Definition object defines a coverage area for analysis. In this instance, you require global
coverage.

1. Using the Insert STK Objects tool, insert a Coverage Definition (J&) object using the Insert Default method.
2. Rename the Coverage Definition (J&) object Global_Grid.

3. Open Global_Grid's ('ﬁ) properties (IEI).

Coverage Grid

Global Coverage grid type creates a grid that covers the entire globe.
1. On the Basic - Grid page, change Grid Area of Interest - Type: to Global.

2. Click Apply to accept the changes, and keep the Properties Browser open.

Coverage Assets

Assets properties allow you to specify the STK objects used to provide coverage.

1. Select the Basic - Assets page.

=
2. Inthe Assets list, select Camera_View (E:' ).
3. Click Assign.

4. Click OK to accept the changes, and close the Properties Browser.

Figures of Merit

A Figure of Merit (#) object allows you to specify the method by which the quality of coverage is measured.

The default Coverage type for a Figure Of Merit (#) object is simple coverage.
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1. Using the Insert STK Objects tool, insert a Figure Of Merit (#) object using the Insert Default method.

When the Select Object window opens, select Global_Grid ("&).

Click OK.

=

Rename the Figure Of Merit (#) object Simple_Cov.

Compute Accesses Tool

The ultimate goal of Coverage is to analyze accesses to an area using assigned assets.
1. Right-click Global_Grid ('ﬁ) in the Object Browser.
2. Select CoverageDefinition.

3. Select Compute Accesses.

Percent Satisfied

Percent Satisfied is the percentage of coverage grid area which is satisfied. It's computed by summing the areas
associated with all satisfied grid points, dividing by the total grid area and multiplying by 100. In this scenario,
you're interested in the Percent Coverage static value of Simple Coverage, meaning the percent of the coverage
grid area covered by at least one asset at some point during the coverage interval.

1. Right-click on Simple_Cov (#) in the Object Browser.

2. Select Report & Graph Manager ().

3. When the Report & Graph Manager opens, select the Percent Satisfied report in the Installed Styles list.
4. Click Generate.
5.

Note the % Satisfied value at the bottom of the report (e.g. 749 percent). The value you see is the scenario
benchmark.

6. When finished, close the report and the Report & Graph Manager.
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Analyzer

Analyzer provides a set of analysis tools that:
¢ Enable you to understand the design space of your systems.
¢ Enable you to perform analyses in STK easily, without involving programming or scripting.
¢ Introduce trade study and post-processing capabilities.

¢ Can be used with all STK scenarios, including those with STK Astrogator satellites.

Determine the Impact of Satellite Inclination on Percent Satisfied

The first study you will perform varies inclination and its effect on global coverage. You need to select input and
output variables from the main Analyzer window to pass to the Parametric Study tool.

1. Click View on the STK menu bar.
2. Select Toolbars.

3. Select Analyzer.

4. Click the Analyzer ( 4 ) button on the Analyzer Tool Bar.

Analyzer Layout

Use the Analyzer Main Form to configure input and output variables available for further analysis. You will first
select an object in the STK Variables tree on the left. When an object is selected, all possible input variable

candidates are listed under the STK Property Variables - General tab and the Active Constraints tab. All output
variable candidates are listed under the Data Provider Variable - Data Providers tab and Object Coverage tab.

Input Inclination

Start by selecting Inclination as the Input variable.
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1. Select MySat (%) in the STK Variables tree.
2. Expand (=) Propagator (TwoBody) in the STK Property Variables - General tab.

3. Double-click on Inclination to move it to the Analyzer Variables field as an Input.

Output Percent Satisfied

The same data providers that are in the Report & Graph Manager are available in the Data Provider Variables
list. Select Percent Satisfied as the Output variable.

1. Inthe STK Variables tree, expand (&) Global_Grid (’&).

2. Select Simple_Cov (#).
3. Expand (®) Static Satisfaction in the Data Provider Variables - Data Providers tab.
4

. Double-click on Percent Satisfied to move it to the Analyzer Variables field as an Output.

Parametric Study Tool
1. Click Parametric Study... (TE:) on the Analyzertoolbar to open the Parametric Study Tool.

2. Drag and drop the Design Variable, Inclination, from the Component Tree on the left to the Parametric
Study Tool on the right.

3. Set the following:

Option Value
starting value: 112
ending value: 120
step size: 1

Notice the number of samples is automatically calculated as nine based on the values we set.
Drag and drop the Percent Satisfied data provider element into the Responses field.

Click Run...

N o o &

Notice nine runs are performed since the number of samples is set to nine.
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Running the data explorer

The Data Explorer is a Trade Study tool used to display data collected from STK. While data is being collected in
the Table, the Data Explorer window displays a progress meter, a halt button, and the data. Once the Parametric
study is complete, the Table page and 2D Scatter Plot display the collected data.

1. When the Parametric study is finished, close the 2D Scatter Plot.

Select the Table Page - Trade Study 1 - Data Explorer window to bring it to the front.

Notice nine runs were performed at 1 deg increments from 112 deg to 120 deg inclination.
Notice the second row shows the global coverage percentage for each change in inclination.
Note that an inclination of 120 deg provides the highest percentage of global coverage.

On the Table Page tool bar, click Add View.

Select 2D Line plot.

Click Axes.

© ©® N o g k0 Dd

Select the Ticks tab.
10. Change the Max # value to 20.
11. Click anywhere on the plot to close the Axes menu.

12. Looking at the 2D Line Plot, you see that 120 deg inclination (basing the analysis on one degree
increments) gives you the best choice for global coverage during the 24 hour period.

13. Close the 2D Line Plot and the Table Page.
14. Select No when the Save window appears.

15. Close the Parametric Study (%) window.

16. Return to the Analyzer (“* ) window.

Input Eccentricity

Eccentricity could have an impact on the sensor's footprint. However, you have to take into consideration the
possibility of the satellite impacting the Earth's surface when changing the eccentricity.
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1. Select MySat (%) in the STK Variables tree.
In the STK Property Variables - General tab, expand (=) Propagator (TwoBody).

Double-click on Eccentricity to move it to the AnalyzerVariables field as an Input.

N

Click the Parametric Study Tool (TF“_?) button on the Analyzertoolbar.

Eccentricity Parametric Study
Let's set up a Parametric Study with Eccentricity as the Design Variable and Percent Satisfied as the Response.

1. Drag and drop the Design Variable, Eccentricity, from the Component Tree on the left to the Parametric
Study Tool on the right.

2. Setthe following:

Option Value
starting value: .362
ending value: .364
number of samples: 10

3. Notice the step size is automatically calculated based on the values we set.
4. Drag and drop the Percent Satisfied data provider element into the Responses field.

5. Click Run...

Running the data explorer
1. When the Parametric study is finished, close the 2D Scatter Plot.
Select the Table Page - Trade Study 2 - Data Explorer window to bring it to the front.
On the Table Page tool bar, click Add View.
Select 2D Line plot.

Click Axes.

o g kw0 b

Select the Ticks tab.
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7. Change the Max # value to 40.
8. Click anywhere on the plot to close the Axes menu.

9. Place your cursor over one of the points. A small window will appear with analytical information concerning
the point.

10. Close the 2D Line Plot and the Table Page.
11. Select No when the Save window appears.

12. Close the Parametric Study (I#) window.

13. Return to the Analyzer ( 4 ) window.

Carpet Plot Tool
1. To access the Carpet Plot Tool (), click Carpet Plot... on the Analyzertoolbar.

2. Drag and drop Inclination from the Component Tree on the left to the first Design Variable field on the right.

3. Drag and drop Eccentricity from the Component Tree on the left to the second Design Variable field on the
right.

4. Setthe following Inclination Design Variable:

Option Value
From 119
To 121
Step Size 1

5. Set the following Eccentricity Design Variable:

Option Value
From .361
To .365
Step Size 0.001

6. Drag and drop the Percent Satisfied data provider element into the Responses field.

7. Click Run.
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The Best Combination

Using the Carpet Plot Tool, look for the best combination of Inclination and Eccentricity. First, you will make the
Carpet Plot easier to read, then look at the data.

1. Click Axes.
2. Select the Lines tab.
3. Change the Grid Lines value to 10.

4. Click anywhere on the plot to close the Axes menu.

The original benchmark of global coverage was approximately 49 percent. In this study, an Inclination of 120
degrees and an Eccentricity of 0.361 provided the best percentage of global coverage of approximately 51.6
percent.

5. When finished, close the Carpet Plot and the Table Page.
6. Select No when the Save window appears.

7. Close the Carpet Plot Tool () window.

o

8. Close Analyzer (™).

Summary

You began the scenario by placing a Satellite (%) object in a retrograde orbit. You attached a Sensor (E‘:‘)
object to the Satellite (%) with a 20 degree field of view and orientated to point straight down below the Satellite
(%) to the Earth's surface. Using a Coverage Definition ("&) object, you created a global grid and assigned the
Sensor (E:I‘) object as the asset. Using a Figure Of Merit (#) object and Simple Coverage, you determined that
approximately 49 percent of the Earth's surface was accessed by the Sensor (E) object during a 24 hour

analysis period. The Satellite's (%) original Inclination was 116 degrees and its Eccentricity was 0.363. Using
Analyzer, you ran two Parametric studies changing Inclination and Eccentricity and studied their effects on
global coverage. You ended the analysis by running a Carpet Plot study which determined the best combination
of Inclination and Eccentricity that provided the highest percentage of global coverage. Your final value for
Inclination was 120 degrees and Eccentricity was 0.361. This combination raised global coverage percentage
from the benchmark of approximately 49 percent to 51.6 percent.
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Part 11: Introduction to Communications

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem Statement

Engineers and operators need to quickly determine communication link budgets. Factors such as
communications unobstructed or obstructed by terrain, trees or man made structures need to be taken into
consideration. Other factors that need to be included and analyzed are rain models, atmospheric losses, and RF
interference sources. In this scenario, a team of scientists is monitoring glacial meltwater in a remote,
mountainous location. Prior to setting up camp, they need to determine how their location will impact a link
budget between them and a low earth orbit (LEO), Earth observation satellite which is downloading data to the
team.

Solution

Use STK Pro and STK's Communications capability to model and analyze a link budget between the ground site
and the Earth observation satellite. The satellite transmitter will be analyzed using an isotropic, omnidirectional
antenna pattern. The ground team will employ a small parabolic antenna steered by a servo motor that can track
the satellite. After establishing a link budget based on line of sight only, terrain obstruction, rain, atmospheric
absorption and system noise temperature will be factored in until the final link budget analysis is complete.

Create a New Scenario
Create a new scenario for a twenty four (24) hour time period starting 1 Jul 2020 06:00:00.000 UTCG.

1. Launch STK (EH).
2. Inthe Welcome to STK window, click Create a Scenario.

3. Enter the following in the New Scenario Wizard:

Option Value
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Name: STK_Communications

Location: Default

Start: 1 Jul 2020
06:00:00.000 UTCG

Stop: 2 Jul 2020
06:00:00.000 UTCG

4. When you finish, click OK.

—
5. When the scenario loads, click Save (). A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location and click Save.

Add Analytical and Visual Terrain

An STK Terrain File (pdtt) located in the STK install area will be used for analysis and situational awareness in
the 3D Graphics window.

1. Right-click on STK_Communications (ﬁ) and select Properties (IEI).
Select the Basic - Terrain page.

Disable Use terrain server for analysis.

Click OK to accept the changes and close the Properties Browser.

Bring the 3D Graphics window to the front.

S S

In the 3D Graphic window toolbar, click Globe Manager (E).
7. Inthe Globe Manager's Hierarchy toolbar, click Add Terrain/Imagery (Q’).

8. Select the Add Terrain/Imagery (ﬂ) option in the drop-down.

9. Inthe Globe Manager: Open Terrain and Imagery Data window, click the ellipsis button (E|) in the Path
field.

10. Navigate to <STK Install Folder>\Data\Resources\stktraining\imagery (e.g. This PC then C:\Program
Files\AGI\STK 12\Data\Resources\stktraining\imagery).

11. Click OK.

12. Select RaistingStation.pdtt.
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13. Click Add .

14. When the Use Terrain for Analysis prompt displays, click Yes to enable terrain for analysis.

Declutter the Labels

Label Declutter is used to separate the labels on objects that are in close proximity for better identification in
small areas.

1. Bring the 3D Graphics window to the front.

2. Open the 3D Graphics window properties (IEI).

3. On the Details page, locate the Label Declutter section.
4. Select Enable.
5

. Click OK to accept the changes and close the Properties Browser.

Insert the Earth Observation Satellite

The Earth observation satellite is in a sun-synchronous orbit. Sun-synchronous orbits are designed to utilize the
effect of the Earth's oblateness, causing the orbit plane to precess at a rate equal to the mean orbital rate of the
Earth around the Sun. Sun synchronous orbits have the property that their nodes maintain constant local mean
solar times.

1. Using the Insert STK Objects tool, insert a Satellite (%) object using the From Standard Object Database
method.

In the Search Standard Object Data window, enter Rapideye in the Name or ID: field.
Click Search.
In the Results: field, select RapidEye 2 using the AGlI's Standard Object Data Service Data Source.

Click Insert.

o a0 kv b

Close the Search Standard Object Data window.

Insert the Scientists' Camp Site

The camp site sits in a valley next to a river being fed by mountain glaciers.
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1. Using the Insert STK Objects tool, insert a Place (@ ) object using the Define Properties method.

2. On the Basic - Position page, set the following:

Option Value
Latitude: 47.5605 deg
Longitude: 11.5027 deg
Height Above Ground: 6 ft (simulates

antenna height)
3. Click OK to accept the changes and close the Properties Browser.

4. Rename the Place (@ ) object Camp_Site.

Simple Transmitter Model

The Simple Transmitter model is convenient when you do not have all the information necessary to model the
transmitter in detail; for example, during the system engineering process.

1. Using the Insert STK Objects tool, insert a Transmitter ( [@) object using the Insert Default method.

. When the Select Object window appears, select Rapideye2_33312 (%).

2
3. Click OK.
4

. Rename the Transmitter (@) object Download_Tx.

Transmitter Model Specs

Using a Simple Transmitter Model type, the Model Specs tab allows you to set the transmitter's frequency, EIRP
(Effective Isotropic Radiated Power), data rate, and polarization. The Simple Transmitter model defaults to an
isotropic antenna pattern. An isotropic antenna pattern is an ideal spherical pattern antenna with constant gain.

1. Open Download_Tx's (@) properties.
2. On the Basic - Definition page, ensure the Model Specs tab is selected.

3. Setthe following:
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Option Value

Frequency: 1.7045 GHz
EIRP: 10 dBW
Data Rate: 4.2 Mb/sec

4. Select Use in the Polarization field.

5. Set the polarization to Right-hand Circular.

6. Click OK to accept the changes and close the Properties Browser.

Receiver Antenna Orientation

)
The receiver antenna is steerable. To create a steering device (e.g. servo motor) in STK, you use a Sensor (E:')
object.

1.

5.

2
3.
4

Zoom To Camp_Site (@ ).

‘1
. Using the Insert STK Objects tool, insert a Sensor (ﬁ:I ) object using the Insert Default method.

When the Select Object window appears, select Camp_Site (@ )-

. Click OK.

=
Rename the Sensor (E:' ) object Servo_Motor.

Half Power Sensor Patterns

Half Power sensor patterns are designed to visually model parabolic antennas. The sensor half angle is
determined by frequency and antenna diameter.
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Half Angle =

21.0

2 frequency (GHz) x Diameter ()

Cross-section 3D View

HALF POWER SENSOR

1. Open Servo_Motor's properties (IEI).

2. On the Basic - Definition page, set the following:

Option Value
Sensor Type: Half Power
Frequency: 1.7045 GHz
Diameter: 1.6m

3. Click Apply to accept the changes and keep the Properties Browser open.

Targeted Sensor
The Targeted pointing type causes the sensor to point to other objects in the scenario.

1. Select the Basic - Pointing page.
. Setthe Pointing Type: to Targeted.

. Setthe Track Mode: value to Receive.

2
3
4. Move () Rapideye2_33312 (%) from the Available Targets list to the Assigned Targets list.
5

. Click Apply to accept the changes and keep the Properties Browser open.

Target Times

Use Target Times to schedule or view access times from the sensor to the selected targets. This is a quick way
to determine an access without using the Access Tool.
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Click Target Times.
There are seven (7) opportunities to download data from the satellite to the ground site.

Click Cancel to close the Target Times window.

Click OK to close Servo_Motor's (E) properties.
Bring the 3D Graphics window to the front.

In the Timeline View, slowly move the gray pointer until the sensor accesses the satellite. Use your mouse
to change the view so that you can view the access between Servo_Motor (E:I‘) and Rapideye2_33312 (%
).

You can see that Servo_Motor (E:I‘) is targeting Rapideye2_33312 (%). Rapideye2_33312 (%) has two

(2) Sensor (Eﬁ‘) objects attached to it that were downloaded with the Satellite (% ) object if the satellite was
inserted from AGl's Standard Object Data Service Data Source.

Complex Receiver Model

The Complex Receiver model allows you to select among a variety of analytical and realistic antenna models,
and to define the characteristics of the selected antenna type.

K
1. Using the Insert STK Objects tool, insert a Receiver (h

) object using the Insert Default method.

‘1
2. When the Select Object window appears, select Servo_Motor (ﬁi ).

3. Click OK.

4. Rename the Receiver (h ) object Download_RXx.

Receiver Model Specs

N

cccccc

['4°4
. Open Download _Rx's (Eﬂ') properties (IEI).

On the Basic - Definition page, click the ellipsis button (Component Selector) (E) beside the Type field.
Select Complex Receiver Model.

Click OK.
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By default, the frequency is set to Auto Track. The Frequency Auto Track option allows a receiver to track and
lock onto the transmitter's carrier frequency with which it is currently linking, including any Doppler shift. LNA
refers to Low Noise Amplifier. If you have those specifications, you can add them.

Receiver Antenna

You can select to embed an antenna model from the Component Browser or you can link to an antenna object.
You will use a parabolic antenna.

1. Select the Antenna tab.
2. Click the ellipsis button (Component Selector) (E|) beside the Type field.
3. Select Parabolic.
4. Click OK.
5. Setthe following:
Option Value
Design Frequency: 1.7 GHz

Diameter: 1.6 m

6. Click Apply to accept the changes and keep the Properties Browser open.

Receiver Antenna Polarization

The receiver polarization type is the same as the transmitter's polarization.
1. Select the Polarization sub-tab.
2. Select Use.
3. Change the polarization to Right-hand Circular.

4. Click OK to accept the changes and close the Properties Browser.
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Simple Link Budget

Creating a Link Budget in the Access tool is referred to as a Simple Link Budget. The Link Budget Reportis a
specialized Access Report for basic link budget analysis and is available using the Link Budget button in the
Reports frame of the Access window.

1.
2.

6.

i
In the Object Browser, right click on Download_Rx (h ) and select Access (E’).

When the Access Tool opens, in the Associated Objects list, expand ( ) Rapideye2_33312 (% ).
Select Download_Tx (@ )-

Click Compute ( Ll “OMPULE )

In the Reports section, click Link Budget...

Take some time to look at the Simple Link Budget report. As the satellite rises over the horizon of the central
body (WGS84) you receive transmissions. When the satellite falls below the horizon, you lose
transmissions.

Leave the Link Budget Report open.

Take Terrain Into Consideration

Use Terrain Mask. If this check box is selected, access to the object is constrained by any terrain data in the line
of sight to which access is being calculated.

1.

5.

6.
7.

cccccc

i
Open Download_Rx's (E) properties (IEI).

. Select the Constraints - Basic page.

2
3.
4

Select Terrain Mask.

. Click OK to accept the changes and close the Properties Browser.

Return to the Link Budget Report and click Refresh (F5) (@).

You'll see that all accesses blocked by analytical terrain (RaistingStation.pdtt) have been removed from the
report. You began with seven (7) accesses but taking terrain into account you now have four (4) accesses.

Close the Link Budget Report.

Return to the Access Tool.
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Detailed Link Budget

The Detailed Link Budget Report is a modified Link Budge Report with added Access Data Provider Elements.

1.

In the Access Tool, click Report & Graph Manager...

2. When the Report & Graph Manager opens, go to the Styles - Installed Styles list and select Link Budget -

Detailed.

. Click Generate.
. Change the report Step: to 30 sec.

. Press Enter on your keyboard.

Take some time to look at the report. Looking at the first access, note the values for Atmos Loss (dB) and
Rain Loss (dB). They're currently zero (0). You haven't loaded any RF Environment models. Also note the
values in the C/N (dB) (carrier to noise ratio), Eb/No (dB) (energy per bit to noise ratio), and BER (Bit Error
Rate) columns. For the purposes of your analysis due to downloading data, you require a BER equal to or
lower than 1.000000e-13. You can see from the report that you only have a few minutes during each pass to
download data.

6. Leave the report open.

Rain Model

Environmental factors can affect the performance of a communications link. Apply rain and atmospheric
absorption models to the analysis. Rain models are used to estimate the amount of degradation (or fading) of
the signal when passing through rain.

1.

o

S.

ccccc

Open STK_Communications (ﬁ) properties (E).
Select the RF - Environment page.
Select the Rain & Cloud & Fog tab.

Select Use In the Rain Model section. Leave the default ITU (International Telecommunication Union)
model.

Click Apply to accept the changes and keep the Properties Browser open.
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Atmospheric Absorption Model

Atmospheric Absorption models estimate the attenuation of atmospheric gases on terrestrial and slant path
communication signals.

1. Select the Atmospheric Absorption tab.

Select Use. Leave the default ITU model.

Click OK to accept the changes and close the Properties Browser.
Return to the Link Budget - Detailed report.

Observe the C/N (dB), Eb/No (dB) and BER columns.

Click Refresh (F5) (@). There was a slight change in the C/N (dB) and Eb/No (dB) values.

N o o r 0N

Scroll to the Atmos Loss (dB) and Rain Loss (dB) columns.
Losses were minimal, therefore the slight losses in C/N (dB) and Eb/No (dB) values.

8. Leave the report open.

System Noise Temperature

The Receiver's System Noise Temperature allows you to specify the system's inherent noise characteristics.
1. Open Download_Rx's (ﬁ:) properties (E).

On the Basic - Definition page, select the System Noise Temperature tab.

Select Compute.

Select Compute in the Antenna Noise section.

Select Sun, Atmosphere, Rain and Cosmic Background.

Click OK to accept the changes and close the Properties Browser.

Return to the Link Budget - Detailed report.

® N O g r @ N

Observe the C/N (dB), Eb/No (dB) and BER columns.
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9. Click Refresh (F5) (@). There were increases in the C/N (dB) and Eb/No (dB) values and decreases in
BER.

10. Look at the following columns and observe their values:
e Tatmos (K)
e Train (K)
e Tsun (K)
e Tearth (K)
e Tcosmic (K)
e Tantenna (K)
e Tequivalent (K)

These are the calculated noise temperatures. Calculating system noise temperature improved your Link Budget
Report and extended the time available for downloading data.

Summary

You inserted a Place (@ ) object into the scenario which simulated the location of a scientific team monitoring
glacial meltwater in mountainous terrain. You used a local terrain file both analytically and visually for your

analysis and situational awareness. You inserted and propagated an actual Earth Observation Satellite (%)
object which the scientists need to communicate with for data download. You were introduced to the Simple

Transmitter Model which was attached to the Satellite (%) object. The Simple Transmitter uses an isotropic

. - - . :
antenna. Next, you created a servo motor using a Sensor (Eﬁ ) object which was used to steer the ground site

K
receiver antenna by locking onto the Satellite (% ) object. The Receiver (E‘) object used a Complex Receiver
Model. This model allowed you to input a Parabolic Antenna Pattern. The first analysis, using the Access Tool,
focused on a Simple Link Budget. The only constraint applied was line of sight which is basically horizon to
horizon using the central body. Next, using Terrain Mask, you took into account local terrain and lost multiple

accesses to the Satellite (%) object. You moved to the Report & Graph Manager and generated a Detailed Link
Budget. You enabled an ITU rain model and atmospheric absorption model which had a slight detrimental
impact on the Link Budget Report. Finally, you added System Noise Temperature analysis to the Link Budget
Report which had a positive impact to the link budget.
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Part 12: Introduction to Radar

Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem Statement

Engineers and operators need to determine how various radar settings will affect its ability to track different
sized targets.

They want to know how the following settings affect a radar's ability to track multiple target types:
e Radar Cross Section
¢ Pulse Repetition Frequency
¢ Gain

¢ Pulse integration

Solution
Use STK Pro and STK's Radar capability to:
1. Create an airfield radar site
2. Model an airport surveillance radar
3. Build a monostatic radar
4. Testvarious settings against multiple targets
5

. Determine probability of detection

Create a new scenario

Create a new scenario.
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1. Launch STK (H).

2. Click Create a Scenario (ﬁ) in the Welcome to STK window.

3. Enter the following in the New Scenario Wizard:

Option Value

Name: STK_ Radar

Location: Default

Start: 1 Oct 2020 03:00:00.000 UTCG
Stop: +30 min

4. When finished, click OK .

—
5. When the scenario loads, click Save (). A folder with the same name as your scenario is created for you
in the location specified above.

6. Verify the scenario name and location in the Save As window.

7. Click Save.

Turn Off Terrain Server

This is an introduction to Radar. Terrain will not be used in this analysis.
1. Open STK_Radar's (B) properties (IEI).

Select the Basic - Terrain page.

Clear Use terrain server for analysis.

N

Click OK to accept the changes and close the Properties Browser.

Turn On Label Declutter

Turn on Label Declutter to reposition object labels so they do not obstruct one another while in close proximity.

1. Open the 3D Graphics Window's properties (IEI).

2. Select the Details page.
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3. Select Enable for Label Declutter.

4. Click OK .

Insert the Target Aircraft
Insert an Aircraft (%) object. We will use the aircraft to analyze the airfield surveillance radar.

1. Select Aircraft (%) in the Insert STK Objects tool.
. Select the Insert Default method.

2
3. Click Insert... .
4

. Rename the Aircraft (%) Target_Acft.

Create the Target Aircraft's Route

Create Target_Acft's (%) route, then modify it's altitude and speed.
1. Open Target_Acft's (%) properties (lEI).

Select the Basic - Route page.

Click Insert Point two times.

N

Set the following:

Waypoint Latitude Longitude
One 37 deg 139.7 deg

Two 34 deg 139.1 deg

5. Click SetAll... .
6. Select Altitude: and Speed: in the Set All Grid Values window.

7. Set the following:

Option Value
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Altitude: 25000 ft

Speed: 330 mi/hr

8. Click OK to close the Set All Grid Values window.

9. Click Apply to accept the changes and keep the Properties Browser open.

Specify the Radar Cross Section

Before setting up and constraining a radar system, Radar allows you to specify an important property of a
potential radar target - its radar cross section (RCS). Use the RCS of a popular four engined transport turboprop
aircraft.

1. Select the RF - Radar Cross Section page.
2. Atthe top of the page, clear Inherit. This allows you to set the RCS settings for the Aircraft (%) instead of
inheriting the settings from the Scenario (ﬁ) object.

3. Setthe Constant RCS Value: to 19 dBsm (decibels referenced to a square meter).

Ideally, you would want to use an Aspect Dependent RCS file. Since you don't have one, you will use a
constant value. The constant value we set is the RCS of a sphere that radiates isotropically.

4. Click Apply .

Display Radar Cross Section Graphics
The 3D Graphics RCS page allows you to control the 3D display of Radar Cross Section contour lines.
1. Select the 3D Graphics - Radar Cross Section page.
2. Select Show Volume in the Volume Graphics section.
3. Click OK.
4

. Bring the 3D Graphics window to the front.

Right-click on Target_Acft (%) in the Object Browser.

g

6. Select Zoom To.

7. Use your mouse to zoom out until you can see the RCS sphere.
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Insert the Radar Site

Use a Place (@ ) object as the radar site location.

1. Select Place (@ ) in the Insert STK Objects tool.
. Select the Insert Default method.

2
3. Click Insert... .
4

. Rename the Place (@ ) Radar_Site.

Define the Radar Site's Location

Define the location of Radar_Site (@ ), and raise its height above ground 50 ft to model the radar antenna
height.

1. Open Radar_Site's (@ ) properties (@).
2. Select the Basic - Position page.

3. Setthe following:

Option Value
Latitude: 35.7517 deg
Longitude: 139.3562 deg
Height Above Ground: 50 ft

4. Click OK.

Raising the Place (@ ) object 50 feet above the ground simulates the height of the radar antenna.

Bring the 3D Graphics window to the front.

Right-click on Radar_Site (@ ) in the Object Browser.

Select Zoom To.

©® N O o

Use your mouse to obtain situational awareness of the radar site's location.
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Insert the Antenna Servo System

Insert a Sensor (Eil‘) object to simulate a servo system for antenna positioning. In STK, you could create a
spinning sensor to simulate a spinning radar antenna normally seen at an airfield. However, you will lock the
sensor onto the aircraft and constrain the sensor to point in a limited area. This simulates the actual field of view
of the airfield surveillance radar both horizontally and vertically.

)
1. Select Sensor (Ei) in the Insert STK Objects tool.
. Select the Insert Default method.

. Click Insert... .

2
3
4. Select Radar_Site (@ ) in the Select Object window.
5. Click OK.

6

2
. Rename the Sensor (ﬁi ) Servo_System.

Define the Sensor Field of View

Define Servo_System's (Ei‘) 3 degree field of view using a Simple Conic sensor pattern. You will use the

, . I =
sensor's field of view for situational awareness when Servo_System(Eil) points the antenna at a target.

1. Open Servo_System's (Ei‘) properties (@).

2. Select the Basic - Definition page.

3. Setthe Simple Conic - Cone Half Angle: value to 3 deg.
4

. Click Apply .

Target the Aircraft

"'l
Use the Targeted pointing type to point Servo_System (E:' ) to Target_Acft(%).
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Select the Basic - Pointing page.

Set the Pointing Type: to Targeted.
Select Target_Acft (%) in the Available Targets list.

Move () Target_Acft (%) to the Assigned Targets list.

a kw0 bdp =

Click Apply .

Set Range and Elevation Angle Constraints

There are many types of radar systems. A typical airport surveillance radar's nominal range is 60 miles and the
elevation angle of the beam can track from 0 to 30 degrees. Anything higher than 30 degrees is the cone of

: : . . 0 .
silence in which the radar cannot track the aircraft. Extend the Servo_System's (ﬁi ) maximum range further
than 60 miles in order to lock onto the aircraft when it's above the horizon.

1. Select the Constraints - Basic page.

Select Min: and Max: in the Elevation Angle section.
Set the Min: value to 0 deg.

Set the Max: value to 30 deg.

Select Max: in the Range section.

Set the value to 150 km.

N o o ke b

Click OK.

Determine Access

. T L .
Determine when Servo_System (E:I) accesses Target_Acft (%). This will give you a good idea of when the
radar may be able to track the aircraft.

1. Right-click on Servo_System (E:I‘) in the Object Browser.
2. Select Access(l:’ ).

3. When the Access Tool opens, select Target_Acft (%) in the Associated Obijects list.

4. Click Compute .
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Click Access... inthe Reports section.

Click Report Units (@) in the Access report's toolbar.
Select Time Dimension in the Units: Access window.

Select Minutes (min) in the New Unit Value list.

© © N o o

Click OK to close the Units: Access window.
There are two accesses with a total duration of approximately 31 minutes.

10. Close the report.

Generate an Azimuth Elevation Range Report

You have three constraints: a maximum elevation angle of 30 degrees, a minimum elevation angle of 0 degrees,
and a maximum range of 150 km. Generate an azimuth-elevation-range (AER) report to see what affect these
constraints have on your access report.

1. Return to the Access Tool.
2. Click AER... inthe Reports section.
3. Look at the Elevation (deg) column.

4. Notice that the first access ends and the second access begins at an approximate elevation angle of 30
degrees.

There is a break in access when the elevation angle exceeds 30 degrees due to the modeled cone of
silence.

5. When finished, close the AER report.

6. Close the Access Tool.

Look at the Sensor's Field of View

Animate through the scenario to get a visual idea of when Servo_System (E) tracks Target_Acft (%).

1. Bring the 3D Graphics window to the front.

2. Click Reset (l‘) in the Animation Toolbar.
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3. Right-click on Radar_Site ('@ ).
4. Select Zoom To.

5. Use your mouse to zoom out until you can see the entire aircraft flight route, the radar site, and the sensor's
field of view.

6. Click Decrease Time Step (E) in the Animation Toolbar until Time Step: is 3.00 sec.

7. Click Start ( ' ) in the Animation Toolbar to animate the scenario.

8. Watch the animation. You can see the sensor turn off when the elevation angle exceeds 30 degrees, and
turn back on when it returns to 30 degrees.

9. When finished, click Reset (I') in the Animation Toolbar.

Insert an Airport Surveillance Radar

Inserta Radar(;) object to create an airport surveillance radar. We will model actual airport surveillance radar
specifications that are easily available to the public.

1. Select Radar(;) in the Insert STK Objects Tool.
. Select the Insert Default method.

2
3. Select Servo_System (#&4) in the Select Object window.
4

. Click OK.

5. Rename the Radar(;) ASR.

Model a Monostatic Radar

Model a Monostatic radar with a Search/Track mode. This will model a common antenna for both transmitting
and receiving, and detect and track point targets.

1. OpenASR's (;) properties ().
Select the Basic - Definition page.

Note that Type: defaults to Monostatic.

> 0N

Note that Mode - Type: defaults to Search Track.
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RadarMonostatic.htm
CommRadar05-02.htm

Define the Waveform

The waveform in our system will use a fixed pulse repetition frequency (PRF), with a PRF of “1000 Hz. Radar
systems often use multiple pulse integration to increase the signal-to-noise ratio. The PRF is the number of
pulses of a repeating signal in a specific time unit. After producing a brief transmission pulse, the transmitter is
turned off in order for the receiver to hear the reflections of that signal off of targets.

1. Returnto ASR's ('ﬂ) properties (@), Basic - Definition page.
2. Note the Waveform is set to Fixed PRF.

3. Note the default value of 0.001 MHz. We will keep that value since our system's PRF is ~1000 Hz.

Define the Pulse Width

Pulse width is the width of the transmitted pulse (the uncompressed RF bandwidth can also be taken as the
inverse of the Pulse Width). Set the pulse width to one microsecond.

1. Returnto ASR's ('ﬂ) properties (@), Basic - Definition page.

2. Click the units (@) drop down next to Pulse Width.
3. Select usec.

4. Setthe Pulse Width value to 1 usec.
5

. Click Apply .

Define the Antenna Pattern

Model the antenna using the cosine squared aperture rectangular antenna pattern. The antenna transmit
frequency for this radar is between 2.7-2.9 GHz.

1. Select the Antenna tab on ASR's (;) properties (@), Basic - Definition page.
2. Click the ellipsis button (Component Selector) (E|) beside the Type field.
3. Select Cosine Squared Aperture Rectangular.

4. Click OK.
5

. Select Use Beamwidth.
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RectangularCosineSquaredApertureAntenna.htm

6. Set the following:

Option Value
X Dim Beamwidth: 5 deg
Y Dim Beamwidth: 1.4 deg
Design Frequency: 2.8 GHz
Main-lobe Gain: (if required, turn off Computed) 34 dB
Efficiency: 55 %

7. Click Apply .

Define the Radar Transmitter

The transmitter has a frequency range of 2.7-2.9 GHz, a peak power of 20 kW, and uses either linear or circular
polarization. We will model linear polarization.

1. Select the Transmitter tab on ASR's (a) properties (@), Basic - Definition page.
Select Frequency.

Set the value to 2.8 GHz.

Set the Power: value to 20 kW.

Select the Polarization sub-tab.

Select Use.

Keep the default setting of Linear.

® N O O kN

Click Apply .

Set the Radar Receiver's Polarization

You don't have specific values regarding the low noise amplifier settings. These would be applied on the
Receiver's Specs sub-tab. However, you know the polarization and want to add the receiver's system noise
temperature. Let's set the polarization model type to Linear now.

1. Select the Receiver tab on ASR's (;) properties (E), Basic - Definition page.
2. Select the Polarization sub-tab.

3. Select Use.

\nsys Page 166 of 292

ssssssssssssssssssssssssss



4. Keep the default setting of Linear.

5. Click Apply .

Add the Radar Receiver's System Noise Temperature

Next, let's add the receiver's system noise temperature to your analysis. You will compute system noise
temperature using the default values, and take into account Sun and Cosmic Background noise.

1. Select the System Noise Temperature sub-tab.
Select Compute.

Select Compute in the Antenna Noise section.
Select Sun.

Select Cosmic Background.

® o K 0 N

Click OK.

—
7. Save () your scenario.

Probability of Detection

You will base the probability of detection (Pdet) on a value of 0.800000 or higher, one (1) being the highest
value. You will also look at signal-to-noise ratio (SNR) and pulse integration. You will start by determining the

Pdet of the large turboprop aircraft. Then, you will change Target_Acft's (%) constant RCS value to simulate a
medium sized aircraft, then a small aircraft, and then a bird. Finally, you'll load a notional Aspect Dependent
RCS file to see the difference between that and the constant value RCS sphere.

Compute Access

Compute Access (E’) between ASR (;) and Target_Acft (%).
1. Right-click on ASR (';) in the Object Browser.
2. Select Access... (:’)_

3. Select Target_Acft (%) in the Access Tool's associated objects list.

4. Click Compute .
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Generate a Radar SearchTrack Report

Now that you calculated Access between ASR (i) and Target_Acft (%), generate a Radar SearchTrack
report.

1. Return to the Access Tool.
Click Report & Graph Manager... under the Reports section.

Expand (&) the Installed Styles list if necessary when the Report & Graph Manager opens.
Select Radar SearchTrack report (El).
Click Generate... .

Click Show Step Value .Show Step Value At the top of the report.

Change the Step: value to 30 sec.

© N O O R~ DN

Press Enter on the keyboard or click Refresh (@) at the top of the report.

Understanding the Data

The content of a report or graph is generated from the selected data providers for the report or graph style. The
data provider you'll focus on in this analysis is Radar SearchTrack.

Observe Pdet

Look at the difference between S/T Pdet1 and S/T Integrated Pdet in the report. S/T Pdet1 is based off of a
single pulse. S/T Integrated PDet uses multiple pulses.

1. Look at the first line in the report.
2. Locate the two columns S/T Pdet1 and S/T Integrated Pdet.

3. Note the difference in the values.

Pulse integration improves the ability of the radar to detect targets by combining the returns from multiple
pulses. You can see this in the S/T Pulses Integrated column in the report.

4. Notice that overall tracking is good when using pulse integration (Pdet of 0.8 or higher).

5. Keep the report open.
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../../Subsystems/dataProviders/Content/dpIntro.htm
../../Subsystems/dataProviders/Content/html/dataProviders/SearchTrack_Properties.htm

Observe SNR

Look at the difference between S/T SNR1 (dB) and S/T Integrated SNR (dB) in the report. S/T SNR1 (dB) is
based on a single pulse and S/T Integrated SNR (dB) on pulse integration.

1. Locate the two columns S/T SNR1 (dB) and S/T Integrated SNR (dB).
2. Note the differences in the values.

3. Again, the pulse integration allows for a better SNR.

Observe S/T Ambig Tgt Range

Look at the report to determine if distance from the radar has an effect on the data.

1. Click Report Units (@) in the Radar SearchTrack report's toolbar.
Select Distance Dimension in the Units: Radar SearchTrack window.
Select Statute Miles (mi) in the New Unit Value list.

Click OK to close the Units: Radar SearchTrack window.

Scroll over to the right in the Radar SearchTrack report.

© o & N

Locate the S/T Ambig Tgt Range (mi) column. This column tells you how far the aircraft is from the radar
site.

7. You see improvement in values discussed above when the aircraft is closer to the radar site.

8. Keep the report open.

Medium Sized Aircraft
Next, simulate a medium sized aircraft.

1. Open Target_Acft's (%) properties (IEI).
2. Select the RF - Radar Cross Section page.

3. Change the Constant RCS Value: to 10 dBsm.
4. Click Apply .
5

. Return to the Radar SearchTrack report.
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6. Click Refresh (@) at the top of the report.

7. Note the S/T Pdet1, S/T Integrated Pdet, S/T SNR1 (dB), and S/T Integrated SNR (dB) changes.

The radar's ability to track this aircraft has diminished due to the aircraft's smaller RCS.

Small Sized Aircraft

Simulate a small sized aircraft.

1. Returnto Target_Acft's (%) properties (IEI)..
Change the Constant RCS Value: to 0 dBsm.
Click Apply .

Return to the Radar SearchTrack report.

Click Refresh (@) at the top of the report.

S o

Note the S/T Pdet1, S/T Integrated Pdet, S/T SNR1 (dB), and S/T Integrated SNR (dB) changes.

The radar's ability to track this aircraft has again diminished due to the aircraft's smaller RCS.

Birds and Stealth

Simulate a bird and a large, somewhat stealthy aircraft.
1. Returnto Target_Acft's (%) properties (IEI).

Change the Constant RCS Value: to -20 dBsm.

Click Apply .

Return to the Radar SearchTrack report.

Click Refresh (@) at the top of the report.

Note the S/T Pdet1, S/T Integrated Pdet, S/T SNR1 (dB), and S/T Integrated SNR (dB) changes.

N o a DN

Looking at the results, you can only track birds within 10 miles of the airfield.
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Aspect Dependent RCS Files

If you have an aspect dependent RCS file built for a specific target aircraft, your data will be much more realistic.

Load External File

Load an installed Aspect Dependent RCS file.

1. Returnto Target_Acft's (%) properties (E )

2. Change Compute Type: to External File.

3. Click the ellipsis button (E|) beside the Filename field.

4. Browse to <STK install folder>\Data\Resources\stktraining\samples\SeaRangeResources\X-47B
5. Select X-47B_Notional_Sample.rcs.

6. Click Open .

7. Click Reload .

8. Click OK.

Visualize RCS Pattern

View the RCS pattern in the 3D Graphics window.

1. Bring the 3D Graphics window to the front.

2. Right-click on Target_Acft's (%) in the Object Browser.
3. Select Zoom To.

4. Use your mouse to get a good view of the aspect dependent RCS pattern.

View Data

Refresh the Radar SearchTrack report to see the changes in SNR, PDet and Pulse Integration.
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1. Return to the Radar SearchTrack report.

2. Click Refresh (@) at the top of the report.

3. Note the S/T Pdet1, S/T Integrated Pdet, S/T SNR1 (dB), and S/T Integrated SNR (dB) changes.

Depending on the reflection from the aircraft back to the radar, you could see fluctuation in your values. This
is noticeable in the S/T Pulses Integrated column.

View RCS Data

Use the RCS graph style to visualize changes to RCS Decibel (dBsm). Note the cone of silence in the middle of
the graph.

1. Return to the Report & Graph Manager.
2. Ensure the Object Type: is set to Access.

3. Select Place-Radar_Site-Sensor-Servo_System-Radar-ASR-To-Aircraft-Target_Acft in the Object Type:
list.

Select Radar RCS graph (hlj) in the Installed Styles folder.
Click Generate... .
Click Show Step Value .Show Step Value At the top of the graph.

Change the Step: value to 1 sec.

© N o 0 &

Press Enter on the keyboard or click Refresh (@) at the top of the report.

—
Save () your scenario.

©

Summary

You created a scenario that used the surface of the WGS84 as the central body obstruction. You created a
simple flight route of an aircraft and changed its RCS value to simulate a large, four engined turboprop using a
constant analytical RCS value. You created an airfield radar site and inserted a Sensor to create a servo system
that was used to steer a radar antenna pattern inside its field of view in order to analyze various targets. You
built a Radar using specifications typically found on air surveillance radars. You analyzed Pdet values for large,
medium, small, and very small targets focusing on Pdet, SNR, and Pulse Integration. Finally, you used a
notional aspect dependent RCS file that demonstrated both analytical and visual differences when compared to
a constant RCS sphere.
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Part 13: Integrating STK with MATLAB

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement
If you are a developer, engineer, or operator, you need to do the following tasks quickly and easily:
e Automate repetitive tasks from outside of the STK application
¢ Integrate STK with other applications, such as MATLAB, Microsoft Excel, and Python
¢ Develop custom applications
¢ Leverage the AGI Object Model collection of COM libraries from other applications

You want to be able to create, drive, and extract data from an STK scenario using MATLAB. To do so, you need
to understand access to the following Application Programming Interfaces (API): the STK Object Model and
Connect. You also need a basic understanding of the structure and contents of the STK Programming Help.

Solution

Using STK, including the STK Integration capability, and MATLAB, create a new instance of STK and expose

the object root. Next, build a new scenario, populating it with a Satellite (%) object and a Target (E) object.
Create an access between the Satellite object and the Target object, extracting access times from STK and
moving them into MATLAB. Use the correct data providers, both groups and elements, to determine a precision
pass value at a specific time in the scenario. Learn the benefits of the STK Programming Help.

Accessing the STK Programming Help

The STK Programming Help offers a wide variety of options to automate and customize STK and to integrate its
technology into other applications. This tutorial covers only a small portion of the STK Programming Help, but
you get a great starting point from which to branch out.

1. Open your preferred internet browser.

2. Goto help.agi.com.
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3. Click STK Programming Help.

Integrating with other applications

STK’s Integration capability enables you to automate repetitive tasks from outside the STK application, integrate
STK with other applications such as MATLAB and Microsoft Excel, develop custom applications, and leverage
the AGI Object Model collection of COM libraries from other applications. Follow these steps to learn more about
these possibilities.

1. Click Select the Right Technology in the table of contents of the STK Programming Help.
2. Select Integrate Technologies.
3. Select clickable decision tree on the Integrate With Other Applications topic page.

4. Take some time to view the page and click some of the icons.

There are many clickable decision trees available in STK Programming Help. You can use the trees to
quickly locate help pages that you need to be successful when integrating with STK.

Automating repetitive tasks

To automate repetitive tasks in STK, you can use HTML, Connect, and STK Objects to build tools that are
accessible from within STK. You can find more information on this in the STK Programming Help by following
these steps:

1. Under Select the Right Technology, click Automate Tasks.
2. Select clickable decision tree on the Automate Repetitive Tasks topic page.

3. Take some time to view the page and click some of the icons.

Extending AGI products

AGI provides a variety of ways to extend its products. These extensibility mechanisms come under two distinct
categories: user interface extensibility and engine extensibility. You can find more information on these in the
STK Programming Help by following these steps:
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1. Under Select the Right Technology, click Extend AGI Products.

2. Click clickable decision tree on the Extend AGI Products Using Plugins and Custom User Interfaces topic
page.

3. Take some time to view the page and click some of the icons.

Visualizing in STK

STK X enables developers to add advanced STK 2D and 3D visualization and analytical capabilities to
applications with little effort. You can find more information on this in the STK Programming Help by following
these steps:

1. Inthe table of contents, go to Library Reference > Controls > STK X.

2. Take some time to familiarize yourself with the contents of this page.

Using core libraries
The STK API consists of two major subsystems: Connect and the STK Object Model.
1. Inthe STK Programming Help, click Using Core Libraries in the table of contents.
2. Note the advantages and disadvantages of using the Connect and Object Model libraries.

Choosing either Connect or Object Model should be driven by the requirements of the application and your
needs as a developer. However, this need not be an exclusive choice. You can use Connect commands in a
COM application side by side with Object Model code.

Learning STK Object Model naming conventions
The STK Object Model contains naming conventions for classes, interfaces, and enumerations.
1. Inthe STK Programming Help, go to Library Reference > STK Object Model > Naming Conventions.

2. Note the various naming conventions described in the Naming Conventions Used in the Various Core
Libraries topic.

3. Click the certain abbreviations link.
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4. Note the abbreviations most commonly used in the names of classes, interfaces, and other types in the
STK Object Model.

Using model diagrams

As a serious programmer, you can use diagrams to see how the STK traffic flow is connected. That way, you
know what's to the right, left, above, and below, all while deep linking to the individual IAg interface pages.

1. Inthe STK Programming Help, go to Using Core Libraries > STK Object Model > STK Objects > Diagrams.
Click STK Object Model Diagram (PDF) in the STK Objects Object Model Diagrams topic.

Zoom in closer to the page for clarification.

Take some time to look at the STK 10.0 Object Model Diagrams PDF.

Close the STK Object Model Diagram (PDF) when finished.

o g kw0 b

Keep the STK Programming Help open.

Launching MATLAB

MATLAB is a programming and numeric computing platform used by millions of engineers and scientists to
analyze data, develop algorithms, and create models.

1. Launch MATLAB.
2. Select the Home tab when MATLAB opens.
3. Click Layout in the MATLAB Toolstrip.

4. Select Default in the Select Layout menu. This makes it easier to follow the tutorial. If you're familiar with
MATLAB and have a setup you prefer, keep it.

Creating a new script

MATLAB script files are program files with the .m extension. In these files, you can write groups of commands
that you want to execute together. Scripts do not accept inputs and do not return any outputs. They operate on
data in the workspace. Scripts are the simplest kind of program file because they have no input or output
arguments. After creating a script file for this tutorial, you can use it later to practice with.
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Select the Home tab in the MATLAB Toolstrip.

Click New Script.

Select the Editor tab in the MATLAB Toolstrip.

Open the Save drop-down menu.

Select Save As....

Browse to the folder where you will save the .m file (e.g., C:\Users\username\Documents\MATLAB).
Type STK_Matlab in the File name field.

Ensure Save as type is set to MATLAB Code files (UTF-8) (*.m).

© ©® N o Ok O Db

Click Save.

Writing comments in your script
Write comments by preceding the line with the % symbol.

1. Inthe MATLAB Editor, type or copy and paste the following comment onto line 1:
%Task1

2. Press Enter on your keyboard.

Locating STK Object Model and MATLAB code snippets

Code snippets demonstrate tasks that are commonly encountered when working with the STK Object Model.
1. Return to the STK Programming Help.

2. Goto Using Core Libraries > STK Object Model > MATLAB Code Snippets.

Creating an STK instance

The AgStkObjectRoot Object is the top-level object in the Object Model hierarchy. The AgStkObjectRoot object
provides methods and properties to load scenarios, create new ones, and access the Object Model Unit
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preferences. From the AgStkObjectRoot object, you can access all other objects and collections exposed by the
Object Model.

1. Locate Initialization under the subheading "How do | ..." on the MATLAB Code Snippets topic page.
2. Select Start STK and get a reference to IAgStkObjectRoot.

3. Type or copy and paste the following code to the STK_Matlab.m script onto lines 2 through 4.

% Create an instance of STK
uiApplication = actxserver('STK12.Application');
uiApplication.Visible = 1;

Press Enter.

Place your cursor in front of % Task1.

Click Section Break in the MATLAB Toolstrip.

Place your cursor before %Task1.

Click Run and Advance in the MATLAB Toolstrip.

© ©® N o O A

Look at the MATLAB Workspace.

You created a variable called uiApplication and started an instance of STK. You also made the STK splash
screen visible.

10. AGIrecommends that you save your MATLAB script after completing each task section.

Using MATLAB IntelliSense and STK Programming Help

The second part of the Start STK and get a reference to IAgStkObjectRoot snippet shows an example of how
to expose the STK object root. Manually enter this information in the MATLAB Command Window for
familiarization. MATLAB can work with STK using IntelliSense.

Selecting a root of the Application Model
Use IntelliSense to select an application root of the STK Object Model.
1. Putyour cursor in the Command Window.
Type the following: root = uiApplication.; make sure to include the period (.).

Press the Tab key on your keyboard after the period (.). IntelliSense will show you possible selections.

N

Return to the STK Programming Help.
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5. Type or paste IAgUiApplication in the search field located in the upper-right corner. Case doesn't matter.
6. PressEnter.

7. Select AgUiApplicationLib~IAgUiApplication in the search results. IAgUiApplication represents a root of the
Application Model.

Exposing the STK object root

Looking at the IAgUiApplication page, most of what you see in IntelliSense matches the Public Methods and
Properties.

1. Scroll down the IAgUiApplication Interface help topic page to Public Properties.
2. Select Personality2, which returns a new instance of the root object of the STK Object Model.

You could have searched for any of the IntelliSense selections. Searching for Personality2 would have
taken you directly to the help page and its description.

Return to the Command Window.

Press the Tab while the cursor is just after the period (.) of the root = uiApplication. command.
Select Personality2 in IntelliSense.

Press Enter.

Place a semicolon after Personality?2.

Press Enter.

Add this whole line (root=uiApplication.Personality2;) to your MATLAB script on line 6.

2 © ® N o O AW

0. Look atthe MATLAB Workspace. You've exposed the STK object root, so you can start creating a
scenario.

Scripting for a new scenario

You will use your MATLAB script to interact with STK. You've launched STK via the MATLAB interface. Now
create a new scenario, set the scenario time period, and reset the animation time.
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1. Inthe STK_Matlab.m script, type or copy and paste the following comment on lines 7 and 8:

% %
% Task2

2. Press Enter. This adds a section break and the task identifier at the same time. You will do this for all
subsequent tasks.

3. Return to MATLAB Code Snippets under Using Core Libraries > STK Object Model in the STK
Programming Help.

4. Locate SCENARIO MANAGEMENT (under Scenario) on the MATLAB Code Snippets topic page.
5. Select Create a new Scenario.

6. In MATLAB, type or copy and paste the following to the STK_Matlab.m script onto lines 9 and 10.

% IAgStkObjectRoot root: STK Object Model Root
root.NewScenario('Example_Scenario');

7. Press Enter.

Using the IAgStkObjectRoot Interface

IAgStkObjectRoot Interface represents the automation interface supported by the root object of the Automation
Object Model.

1. Return to the STK Programming Help.

2. Type or copy and paste "IAgStkObjectRoot" in the Search field.
3. Press Enter.

4. Select STKObjects~IAgStkObjectRoot in the search results.

5

. Select NewScenario in the Public Methods list.

Creating a new scenario
The NewScenario Method creates a new scenario.
1. There is no syntax specifically for MATLAB, so look at the syntax for [Visual Basic .NET].

2. Select ScenarioName in the Visual Basic .NET syntax.
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The NewScenario method expects a string that is the scenario name. In the line you added to Task 2, you
set the scenario name as Example_Scenario.

Set the analysis start and stop times
1. Return to MATLAB Code Snippets.
2. Locate SCENARIO MANAGEMENT on the MATLAB Code Snippets topic page.
3. Select Change scenario time period.

4. Type or copy and paste the following to the STK_Matlab.m script onto lines 11 and 12.

% |AgStkObjectRoot root: STK Object Model Root
root.CurrentScenario.SetTimePeriod('Today’, "‘Tomorrow");

5. Press Enter.

e CurrentScenario Property (IAgStkObjectRoot) returns a scenario object or null if you have not loaded
a scenario yet.

e SetTimePeriod Method (IAgScenario)SetTimePeriod Method (IAgScenario) sets the scenario time
period. It expects a start time and stop time of the scenario period.

Resetting the scenario animation time

1. Return to MATLAB Code Snippets.

2. Locate SCENARIO MANAGEMENT on the MATLAB Code Snippets topic page.
3. Select Reset the scenario time.

4. Type or copy and paste the following to the STK_Matlab.m script onto lines 13 and 14:

% |AgStkObjectRoot root: STK Object Model Root
root.Rewind;

5. Press Enter. You are using Rewind Method (IAgAnimation) to stop and reset the animation.
6. Place your cursor in front of %Task2.

7. Click Run and Advance in the MATLAB Toolstrip.
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https://help.agi.com/stkdevkit/index.htm#DocX/STKObjects~IAgScenario~SetTimePeriod.html

Looking at STK, a new scenario named Example_Scenario (ﬁ) is open and the time has been reset in the
Current Scenario Time field of the Animation toolbar.

Inserting a Target object

To create a new object such as a Target (E) object, use AGESTKODbjectType Enumeration. Not every object in
STK has an associated snippet, so you might need to do some editing. Target (E), Place (@ ), and Facility (

ﬂ) objects contain the same properties. They're seen as different object classes. In this instance, since there
isn't a snippet to insert a new Target object into the scenario, use the Facility object code and make some simple
changes to the code.

1. Return to your MATLAB script.

2. Type or copy and paste the following comments onto lines 15 and 16:
% %
%Task3

Press Enter.

Return to MATLAB Code Snippets.

Locate FACILITY on the MATLAB Code Snippets topic page.

Select Create a facility (on the current scenario central body).

N o o oo

Type or copy and paste the following to the STK_Matlab.m script onto lines 17 and 18.

% |AgStkObjectRoot root: STK Object Model Root
target = root.CurrentScenario.Children.New('eTarget', 'MyTarget');

8. Press Enter.

The snippet code is: facility = root.CurrentScenario.Children.New('eFacility’, '‘MyFacility');. You are
swapping out the variable eFacility for eTarget and changing the name to 'My Target'.

Retrieving the current scenario

The CurrentScenario property returns a Scenario (ﬁ) object or null if no scenario has been loaded yet.
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Return to the STK Programming Help.

Enter "CurrentScenario” in the Search field.

Press Enter.

Select STKObjects~1AgStkObjectRoot™CurrentScenario in the search results.

Go to Visual Basic.NET syntax in the CurrentScenario Property (IAgStkObjectRoot) topic page.

o o wbd 2

Select IAgStkObject.

Retrieving children of an object

IAgStkObiject Interface represents the instance of an STK object. Children Property (IAgStkObject) returns a
collection of direct descendants of the current object.

1. Go to Public Properties on the IAgStkObject Interface topic page.
2. Select Children.
3. Go to Visual Basic.NET syntax in the Children Property (IAgStkObject) topic page.

4. Click IAgStkObjectCollection.

Retrieving a collection of STK objects
IAgStkObjectCollection Interface represents a collection of STK objects.
1. Go to Public Methods in the IAgStkObjectCollection Interface topic page.

2. Select New.

Creating an STK object
New Method (IAgStkObjectCollection) creates an STK object using a specified class and instance name.
1. Go to the Visual Basic.NET syntax on the New Method (IAgStkObjectCollection) topic page.

2. Click AGESTKObjectType.
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AgESTKODbjectType Enumeration

The AGESTKODbjectType Enumeration topic page shows STK objects (members) with their values and

descriptions. When using the AGQESTKObjectType Enumeration to insert a new Target (E) object, you can use
the member name eTarget or the value 23. In this case, you are using eTarget and setting the Target object's
name to MyTarget. This is another way to use the STK Programming Help. On your own, you might have to take
some time working your way through the pages to find what you're looking for.

Placing the Target object

Place the Target object at a specific location.

Assigning the location
Use a MATLAB code snippet to assign the location of the Target.
1. Returnto MATLAB Code Snippets.
2. Locate FACILITY in the MATLAB Code Snippets page.
3. Click Set the geodetic position of the facility.
4

. Type or copy and paste the following to the STK_Matlab.m script onto lines 19 through 21.

% |AgTarget Interface provides access to the properties and methods used in defining a
target object.

% Latitude, Longitude, Altitude
target.Position.AssignGeodetic(50, 100, 0)
5. Press Enter.
» Position Property (IAgTarget) gets the position of the target.
e |AgPosition Interface provides access to the position of the object.
» AssignGeodetic Method (IAgLLAPosition) assigns the position using geodetic representation.

6. In the script, place your cursor in front of % Task3.

7. Click Run and Advance in the MATLAB Toolstrip.
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Checking the location in STK

1.

5.

Bring STK to the front to view MyTarget (E) in the 2D and 3D Graphics windows.
Right-click MyTarget (E) in the Object Browser.

Select Properties (IEI )-

Note the Latitude, Longitude, and Altitude on the Basic > Position page.

If you have an Internet connection and are using Terrain Server, Altitude will have a value higher than 0 km.
That's because you placed the Target object on the surface of the terrain. If you are not using the Terrain

Server, the Target object will be on the surface of the WGS84 ellipsoid.

Click Cancel to close MyTarget's properties (IEI).

Inserting a Satellite object

1.
2.

ccccc

©® N O G h ®

Return to your MATLAB script.

Type or copy and paste the following comments onto lines 22 and 23:
%%
%Task4

Press Enter.

Return to MATLAB Code Snippets.

Locate SATELLITE in the MATLAB Code Snippets page.

Select Create a satellite (on the current scenario central body).

Return to your MATLAB script.

Type or copy and paste the following to the STK_Matlab.m script onto lines 24 and 25.

% |AgStkObjectRoot root: STK Object Model Root
satellite = root.CurrentScenario.Children.New('eSatellite’', 'MySatellite');

Press Enter.
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Learning about Connect

The Connect module provides you with an easy way to connect with STK and work in a client-server
environment. You can use the library shipped with Connect to build applications that communicate with STK.
This library contains functions, constants, and other messaging capabilities that you can use to connect third-
party applications to STK.

1. Return to the STK Programming Help.

2. Goto Using Core Libraries > Connect.

This is a great place to learn about Connect. Take some time to become familiar with the links on this page.

Propagating your satellite via Connect

Just like you did while using the STK Object Model and MATLAB Code Snippets, you can use the MATLAB
Connect Code Snippets help topic to become familiar with Connect. Use Connect to propagate your Satellite (

% ) object.There are several propagators in STK (e.g., Two-Body, J2 Perturbation, J4 Perturbation, SGP4,
etc.).

1. Go to Using Core Libraries > Connect > Connect Code Snippets.

. Locate Satellite in the MATLAB Connect Code Snippets topic page.

2
3. Select Set initial state of satellite and propagate.
4. Return to your MATLAB script.

5

. Type or copy and paste the following to the STK_Matlab.m script onto lines 26 and 27.

root.ExecuteCommand('Units_Set * Connect Distance "Kilometers™); %Default Connect
Units are meters

root.ExecuteCommand('SetState */Satellite/MySatellite Classical TwoBody
"UseAnalysisStartTime" "UseAnalysisStopTime" 60 ICRF "UseAnalysisStartTime" 6678.14 0 28
180 0 180");
6. Press Enter.

o ExecuteCommand Method executes a custom Connect action.

e Units_Set sets units of measure. You're using Units_Set because Connect's distance unit defaults to
meters and you require kilometers.
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Setting the Satellite state

Learning about the SetState Connect command
Look at the Alphabetical Listing of Connect Commands to get information on the SetState command.
1. Return to the STK Programming Help.

2. Goto Library Reference > Connect Command Library.

3. Note the links in the Connect Command Listings page.

4. Select Alphabetical Listing of Connect Commands. The Alphabetical listing includes all Connect
commands, regardless of their groupings.

5. Click "S" at the top of the Alphabetical Listing page.

6. Locate and select the SetState Classical command.

7. Scroll through the SetState Classical page and note the following:
e Syntax will help you understand the input values of your SetState command.
e The description chart explains each input and its associated unit.

* Inthe Examples section, there are several examples that you can copy and edit for your particular
scenario.

Using MATLAB to set the Satellite state
1. Return to your MATLAB script.

2. Using SetState syntax, set the following values in the SetState Connect command that you entered into
your MATLAB script.

Option Value
SemiMajorAxis 7200
Eccentricity 0
Inclination 90
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ArgOfPerigee 0
RAAN 0

MeanAnom 0
The SetState command in MATLAB should match the following:

root.ExecuteCommand('SetState */Satellite/MySatellite Classical TwoBody
"UseAnalysisStartTime" "UseAnalysisStopTime" 60 ICRF "UseAnalysisStartTime" 72000900 0
0");

Place your cursor in front of % Task4.

Click Run and Advance in the MATLAB Toolstrip.

Bring STK to the front to view MySatellite in the 2D and 3D Graphics windows.
Open MySatellite's (%) properties (IEI).

Note and match the property settings and values to your SetState Connect command.

© N o O kO

Click Cancel when finished.

Creating access intervals between MySatellite and MyTarget

Use the STK Object Model to create access intervals from MySatellite (%) to MyTarget (E).

Entering the access commands into MATLAB

Use your MATLAB script to enter access computation commands.
1. Return to your MATLAB script.
2. Type or copy and paste the following comments onto lines 28 and 29:
% %
%Taskb
3. Press Enter.
4. Returnto STK Programming Help.

5. Goto Using Core Libraries > STK Object Model > MATLAB Code Snippets.
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Locate ACCESS on the MATLAB Code Snippets topic page.
Select Compute an access between two STK Objects (using IAgStkObject interface).

Return to your MATLAB script.

© o N &

Type or copy and paste the following to the STK_Matlab.m file onto lines 30 through 33.

% Get access by STK Object

access = satellite. GetAccessToObject(target);
% Compute access
access.ComputeAccess();

10. Press Enter.

Computing and checking the access intervals
Run the latest MATLAB commands and check the access calculation results in STK.

e GetAccessToObject Method (IAgStkObiject) returns an IAgStkAccess object. In this instance, you're
creating an access from the Satellite object to the Target object.

» ComputeAccess Method (IAgStkAccess) recomputes the access between two objects.
1. Inthe script, place your cursor in front of % Task5.
2. Click Run and Advance in the MATLAB Toolstrip.

3. Bring STK to the front. You can see access lines over Asia in the 2D Graphics window.

Retrieve the access data

You created access intervals between the Satellite (% ) object and the Target (E) object. An easy way to
extract and see those times is to create an interval collection of access start and stop times.

Scripting access interval retrieval in MATLAB

Write a MATLAB script task to get the access interval times from STK.
1. Return to your MATLAB script.

2. Type or copy and paste the following comments onto lines 34 and 35:
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%%
% Task6
Press Enter.
Return to MATLAB Code Snippets.
Locate ACCESS in the MATLAB Code Snippets page.
Select Compute and extract access interval times.

Return to your MATLAB script.

©® N o g h ®

Type or copy and paste the following to the STK_Matlab.m script onto lines 36 through 40.

% IAgStkAccess access: Access calculation
% Get and display the Computed Access Intervals
intervalCollection = access.ComputedAccessintervalTimes;
% Set the intervals to use to the Computed Access Intervals
computedintervals = intervalCollection.ToArray(0, -1);

9. Press Enter.

e ComputedAccessintervalTimes Property (IAgStkAccess) returns a list of the computed access
interval times.

« IntervalCollections Property (IAgCrdnintervalsVectorResult) is a collection of interval collections.

e ToArray Method (IAgintervalCollection) returns a two-dimensional array of intervals beginning ata
given position and having a specified number of rows.

e SpecifyAccessintervals Method (IAgStkAccess) specifies a list of intervals to use for the access
calculation.

Retrieving the access interval times

Run Task 6 of your MATLAB script to retrieve the access inteval times.
1. Inthe script, place your cursor in front of % Task6.
2. Click Run and Advance in the MATLAB Toolstrip.
3. Inthe MATLAB Workspace, double-click computedintervals.

4. When the computedintervals cell opens, expand column 1 and column 2 so you can read the access data;
your data will have different values. Column 1 shows the start times of the accesses and column 2 shows
the stop times.

5. When finished, close the cell.
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Investigating data providers

STK generates reports and graphs using selected data providers for the specific report or graph style. You can
view data providers, both groups and individual elements, when using the Report & Graph Manager inside of
STK. The STK Programming Help contains details of data provider groups, individual elements, and report and
graph styles.

1. Type or copy and paste the following to the STK_Matlab.m script onto lines 41 and 42:
%%
%Task7

2. Press Enter.

3. Return to STK Programming Help.

4. Goto Library Reference > Data Providers Reference.

In the Data Providers by Object page, you can spend a lot of time looking at an object's data providers, both
groups and elements.

Extracting data providers

Your scenario is 24 hours long. The Satellite (%) object data provider group named "Passes" contains
extensive data about the satellite's orbit for each pass. The data provider group "Precision Passes" contains, for
specific times, the following:

e Precision pass number - This number has two parts: the integer pass number for the given time and the
fraction of the orbit from the ascending node for that time.

e Precision path number - This is the satellite's orbit path number, which will remain at the value of 1 until the
ground track repeats, at which time the number will increase to 2, and so on..

Use MATLAB to extract these data.

1. Goto Using Core Libraries > STK Object Model > MATLAB Code Snippets in the STK Programming Help.
2. Locate DATA PROVIDERS on the MATLAB Code Snippets topic page.

3. Select Getting Data for a Single Point in Time.
4

. Return to your MATLAB script.
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5. Type or copy and paste the following to the STK_Matlab.m file onto lines 43 through 48

% IAgStkObjectRoot root: STK Object Model root
% |AgSatellite satellite: Satellite object

% Change DateFormat dimension to epoch seconds to make the data easier to handle in
MATLAB

root.UnitPreferences.ltem('DateFormat').SetCurrentUnit('EpSec');
satPassDP = satellite.DataProviders.ltem('Precision Passes').ExecSingle(2600);

pass = cell2mat(satPassDP.DataSets.GetDataSetByName('Precision Pass
Number').GetValues);

6. Press Enter.

Setting date format and elements

1. Look at the code from line 46: root.UnitPreferences.ltem('DateFormat').SetCurrentUnit('EpSec');
e UnitPreferences Property (IAgStkObjectRoot) provides access to the Global Unit table.

 Item Property (IAgUnitPrefsDimCollection) returns IAgUnitPrefsDim, for which you give a dimension
name or an index. The data provider is DateFormat.

e SetCurrentUnit Method (IAgUnitPrefsDimCollection) sets unit preferences. You are using epoch
seconds, or EpSec.

2. Return to the STK Programming Help.
3. Goto Using Core Libraries > STK Object Model > STK Util > Dimensions and Units.
4. Scroll down to DateFormat in the STK Object Model Unit Preferences page.

Your scenario's default date format is Gregorian UTC (UTCGQ). As stated in the code snippet, changing the
DateFormat dimension to epoch seconds to makes the data easier to handle in MATLAB. Since your
scenario is 24 hours long, STK expresses the scenario end time as 86400 EpSec. Thus, a scenario UTCG
time of 30 Jun 2023 08:11:49.699 will now appear as 15109.699 EpSec. This is easier to read and use in
MATLAB.

5. Look at Available Units. The Epoch Seconds element is EpSec.
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Selecting satellite data providers
1. Return to your MATLAB script.

2. Look at the code from line 47: satPassDP = satellite.DataProviders.ltem('Precision Passes').ExecSingle
(2600);

» DataProviders Property (IAgStkObject) returns the object representing a list of available data

providers for the object. In this case, it is a Satellite (%) object.

» ExecSingle Method (IAgDataPrvTimeVar) computes the data given a specific time. SingleTime uses
the DateFormat Dimension, which you set to EpSec.

Return to STK Programming Help.
Go to Library Reference > Data Providers Reference.

Select Satellite in the Data Providers by Object page.

o o oo

Select Precision Passes in the Available Data Providers chart.

Retrieving the Precision Pass data
1. Return to your MATLAB script.

2. Look at the code from line 48: pass = cell2mat(satPassDP.DataSets.GetDataSetByName('Precision
Pass Number').GetValues);

e cell2mat converts a cell array into an ordinary array in MATLAB.
e DataSets Property (IAgDrResult) returns a collection of datasets.

» GetDataSetByName Method (IAgDrDataSetCollection) returns the element for a given name, which
in this case is the Precision Passes data provider element Precision Pass Number.

» GetValues Method (IAgDrDataSet) retrieves an array of values of the elements in the dataset.
3. Place your cursor in front of %Task7.
4. Click Run and Advance in the MATLAB Toolstrip.

5. Look at the pass value (e.g., 1.4276) in the MATLAB Workspace.
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Summary

You began by viewing a small portion of the STK Programming Help pages. Next, using MATLAB code snippets,
you performed the following:

¢ Created a connection between MATLAB and the STK Application

¢ Exposed the STK object root

» Created a new scenario

¢ Inserted and positioned a Target object

¢ Inserted and propagated a Satellite object

¢ Calculated accesses between the Satellite object and the Target object
» Extracted access data from STK into MATLAB

» Used data providers to changes time units from UTCG to EpSec

o Extracted a satellite precision pass value from STK into MATLAB
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Part 13: Integrating STK with Python

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

You will be analyzing the behavior of a satellite when it has contact with a ground site. The task will be repetitive
and you consider methods of automating the process and extracting the data. Knowing that you can integrate
STK with other tools you decide to explore the process.

Solution

Analysis in STK can be integrated and automated with code. You decide to run the process with Python. Using
the resources on the STK Help and Github, you explore how to model a mission with a script.

From this tutorial you will learn how to:
¢ Connect STK to a programming interface
¢ Build a mission through a script

e Extract data from STK

Familiarize yourself with the STK Programming Interface Help

Before attempting to code anything, take a moment to familiarize yourself with the STK Programming Interface
Help system (https://help.agi.com/stkdevkit/index.html).

You will find a wealth of information within the STK Programing Interface Help system, including integration
tutorials, code snippets, decision trees, and library references.

Within the Using Core Libraries directory, you will find additional information on using the STK Object Model and
Connect.
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STK Programming Help

Y Welcome to STK Programming Interface Help
= \What's New
m Migration Guide
= Tytorials, Code Samples, Code Snippets, and Online Resources
m Select the Right Technology
= Using Core Libraries
m STK Object Model
= Connect
m Development Environments
® | ibrary Reference
[ Getting Help

The STK Object Model section listed under Using Core Libraries contains useful code snippets in various
programming languages. It also contains information on the various COM libraries that make up the STK Object
Model. This information includes useful diagrams that help visualize how the STK Object Model is structured.

In the Connect section of Using Core Libraries, you will find useful Getting Started information outlining the
basics of Connect command and response formats. The section also contains useful code snippets that
demonstrate the syntax for various Connect commands.

Creating an STK scenario

There are several ways to open Jupyter Notebooks. You will try opening it inside STK. You may download the
script linked above or follow below. First, create an STK scenario.

1. Create a new STK scenario.

2. Click Create a Scenario .
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3. Enter the following in the New Scenario Wizard:

Option Value
Name STK_Python_Training
Start Time Default Start Time
Stop Time Default Stop Time

4. Click OK .

Integrating STK and Python
Launch the Python Scripting Interface.

1. Click View on the STK menu bar.

2. Select Toolbars.

3. Select Integrated Jupyter Notebooks for Python.

4. Examine the three buttons. The first button from the left opens the interface, the second opens the Github,
and the final one opens the Programming Help.

5. Click Launch Python Scripting Interface ('= )-
6. If not specified, click the ellipsis button (E|) in the Python Interpreter Path field to set the Python install path.

7. If not specified, click the ellipsis button (E|) in the Path to script or folder field to set the folder location
where you would like to save your script. By default it will be saved to your C:<user
path>\Documents\STK 12\PythonScripts.

8. Clear the Create new script on open check box. In this lesson, you will use a notebook file available in your
install or from download.

9. Click Launch.

10. Browse to the installed Python_Jupyter_STK_Training.ipynb file located at STK Install
Folder\Data\Resources\stktraining\scripts.Save the file to the path specified in the Path to script or folder
option above.
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Setting up your workspace

You will be using Jupyter notebooks. You will add cells and enter your script into sections and run them. You
may also use the completed script by adding or writing in any missing lines of code. If you are building your script
from scratch, use the following commands and paste them into the notebook cell:

1. Set up your workspace.
# STK library imports
from agi.stkl2.stkdesktop import STKDesktop
from agi.stkl2.stkobjects import *
from agi.stkl2.stkutil import *
from agi.stkl2.vgt import *
# if using astrogator uncomment the below
# from agi.stkl2.stkobjects.astrogator
# if using aviator uncomment the below
# from agi.stkl2.stkobjects.aviator
# Python helper library imports
import os

2. Connect to the STK instance. Use the appropriate scrip below depending on how you connect to STK.

Use STK_PID environment variable when using the Jupiter Notebook plugin and have multiple instances of
STK running.

STK_PID = os.getenv('STK _PID")
stk = STKDesktop.AttachToApplication(pid=int(STK_PID))

Use STKDesktop.AttachToApplication() without reference to STK_PID when running a single instance of
STK. It does not matter if you are in a notebook or not.

stk = STKDesktop.AttachToApplication()

3. Grab a handle on the STK application root.

\nsys Page 198 of 292

ssssssssssssssssssssssssss



Recall that the AgStkObjectRoot object is at the apex of the STK Object Model. The associated
IAgStkObjectRoot interface will provide the methods and properties to load or create new scenarios and
access the Object Model Unit preferences. Through the stk command you have a pointer to the
IAgUiApplication interface; however, the STK Python API provides a direct handle to the IAgStkObjectRoot
via the Root property in STKDesktop or the NewObjectRoot() method in STKEngine.

root = stk.Root

4. Check that the root object has been built correctly and check the type(). The output will be
agi.stk.stkobjects.AgStkObjectRoot.

type(root)

5. Once the above lines are entered into the cell, click Run . This will create a new STK window.

Connecting and designing a new scenario

Now that you have launched STK via the Python interface, see if you can create a new scenario and set the time
period via Python. Create a new scenario and analysis period and reset the animation time.

1. Click insert cell below to add a new cell.

2. Copy the following code to create a new scenario.

# 1. Define a scenario object.
scenario = root.CurrentScenario
3. Copy the following code to set the analysis period.

# 2. Set the analytical time period.

scenario.SetTimePeriod('Today', '+24hr")

4. Copy the following code to reset the animation time.
# 3. Reset the animation time to the newly established start time.
root.Rewind();

5. Click Run.
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Inserting and Configuring objects

With a new scenario created, it's time to populate the scenario with objects. Use the STK Python API and the
STK Connect commands, via the ExecuteCommand method, to create a facility and a LEO satellite.

1. Click insert cell below to add a new cell.

2. Copy the following code to add a target object to the scenario. Casting the object returned from the New()
method allows for better intellisense in your IDE but is optional; the object returned will be AgTarget at
runtime even without the case.

# 1. Add a target object to the scenario.

target = AgTarget(scenario.Children.New
(AgESTKObjectType.eTarget, "GroundTarget"))

3. Copy the following code to move the target object to the desired location.
#2. Move the Target object to a desired location.
target.Position.AssignGeodetic(50,-100,0)

4. Copy the following code to add a satellite object to the scenario.

#3. Add a Satellite object to the scenario.

satellite = AgSatellite(root.CurrentScenario.Children.New
(AgESTKObjectType.eSatellite, "LeoSat"))

#Examine the below connect command before running. In it we will be
using the Set State Classical connect command. Rather than manually
setting the times we will use the define scenario times. Print them to
confirm.

print(scenario.StartTime)
print(scenario.StopTime)
5. Copy the following code to propagate the satellite object for the length of the scenario.

#4. Propagate the Satellite object's orbit.
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root.ExecuteCommand( 'SetState */Satellite/LeoSat Classical TwoBody "' +
str(scenario.StartTime) + '" "' + str(scenario.StopTime) + '" 60 ICRF "'
+ str(scenario.StartTime) + '" 7200000.0 0.0 90 0.0 0.0 0.0');

6. Click Run.

Computing access between objects

You now have a scenario with a Target object and a Satellite object. Determine when the Satellite object can
access the Target object.

1. Goto the STK Programming Interface Help files.

2. Locate the code needed to compute an access between two STK objects using the IAgStkObject interface.
The access is between the Satellite object and the Target object.

3. If you cannot locate the code, expand the following

a. The location of the required code snippets is STK Programming Interface > Using Core Libraries > STK
Object Model > Python Code Snippets. Locate STK Objects > Access. The required snippet is Compute
an access between two STK Objects (using IAgStkObject interface).

access = satellite.GetAccessToObject(target)
access.ComputeAccess();

4. Inthe JupyterNotebook, click insert cell below to add a new cell.

5. Enter the above text to the new cell and click Run .

Retrieve access data from STK

Now that the scenario is fully built, the final task is to extract data and perform a basic analysis. You have just
computed access between the two objects, so you can use the STK data providers to pull data out of the

scenario.
1. Click insert cell below to add a new cell.

2. Copy the following code to add calls to the access data provider. This will retrieve and view the access data
in Python.

accessDP = access.DataProviders.Item('Access Data')
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results = accessDP.Exec(scenario.StartTime, scenario.StopTime)

accessStartTimes = results.DataSets.GetDataSetByName('Start
Time').GetValues()

accessStopTimes = results.DataSets.GetDataSetByName('Stop
Time').GetValues()

print(accessStartTimes,accessStopTimes)

3. Click Run.

Retrieve the satellite altitude data from STK

1. Click insert cell below to add a new cell.

2. Copy the following code to add a call to the satellite's LLA state data provider. Retrieve and view the altitude
of the satellite during an access interval. In the following lines, note how the data providers must follow the
data provider folder, subfolder, and selection.

satelliteDP = satellite.DataProviders.Item('LLA State')
satelliteDP2 = satelliteDP.Group.Item('Fixed")
rptElements = ['Time', 'Lat', 'Lon', 'Alt']

satelliteDPTimeVar = satelliteDP2.ExecElements
(accessStartTimes,accessStopTimes, 60, rptElements)

satelliteAltitude = satelliteDPTimeVar.DataSets.GetDataSetByName
("Alt").GetValues()

print(satelliteAltitude)

3. Click Run.

Save your scenario

You have just completed the Integrating STK with Python tutorial using Jupyter Notebooks. Don't forget to save
your work. With your scenario safely saved, you can close out of STK. You can expand and automate workflows
like these for quickly building and analyzing missions.
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Part 13: Integrating STK with Excel

§ Note: Visit help.agi.com/stk/#training/Day2Overview.htm for an extended version of this lesson.
There, you can view reference images, access extra content, and follow a recording of an instructor
completing this lesson.

Problem statement

Developers, engineers and operators need to quickly and easily automate repetitive tasks from outside of the
STK application, integrate STK with other applications, such as Microsoft Excel, MATLAB, and Python, develop
custom applications and leverage the AGI Object Model collection of COM libraries from other applications. You
want to be able to create, drive and extract data from a simple STK scenario using Excel. You need to
understand access to the following Application Programming Interfaces (API): the STK Object Model and
Connect. Finally, you require a basic comprehension of STK Programming Help.

Solution

Use Excelto create a new instance of STK and expose the object root. Next, build a new scenario, populating it
with a Satellite object and multiple Target objects. Create an access between the Satellite object and a selected
Target object. Use the data providers, groups, and elements to retrieve access times from STK into Excel.
Download, install and use the STK Excel Add-in plugin. Learn the power of STK Programming Help.

STK Programming Help

The STK Programming Help offers a wide variety of options to automate and customize STK and to integrate its
technology into other applications. Only a small portion of the STK Programming Help is covered in this tutorial
but it's a great starting point.

1. Open your preferred Internet browser.
2. Go to help.agi.com.

3. Select STK Programming Help.
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Integrating STK with other applications

STK’s Integration capability enables you to automate repetitive tasks from outside the STK application, integrate
STK with other applications — such as Excel and MATLAB — develop custom applications, and leverage the AGI
Object Model collection of COM libraries from other applications.

1. Choose Select the Right Technology in the contents list on the left side of STK Programming Help.
Select Integrate Technologies.

Select clickable decision tree on the Integrate With Other Applications page.

N

Take a moment to view the page and click some of the icons.

There are multiple clickable decision trees available in STK Programming Help. You can use the trees to
quickly locate help pages that you need to be successful when using integration.

Automating repetitive tasks

To automate repetitive tasks in STK, you can use HTML, Connect, and STK Objects to build tools that are
accessible from within STK.

1. Return to STK Programming Help.

2. Choose Select the Right Technology in the contents list.

3. Select Automate Tasks.

4. Select clickable decision tree on the Automate Repetitive Tasks page.
5

. Take a moment to view the page and click some of the icons.

Extending AGI products

AGI provides a variety of ways to extend our products. These extensibility mechanisms can be divided into two
distinct areas: user interface extensibility and engine extensibility.

1. Return to STK Programming Help.
2. Choose Select the Right Technology in the contents list.

3. Select Extend AGI Products.
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4. Click clickable decision tree on the Extend AGI Products Using Plugins and Custom User Interfaces page.

5. Take a moment to view the page and click some of the icons.

There are other links throughout that aren't covered here. Take some time later on to become familiar with
them.

Visualize

STK X allows developers to add advanced STK 2D, 3D visualization and analytical capabilities to applications
with little effort.

1. Returnto STK Programming Help.
2. Choose Library Reference in the contents list.
3. Select Controls.

4. Select STK X.
5

. Take some time to familiarize yourself with the contents of this page.

Using Core Libraries
The STK API consists of two major sub-systems: Connect and the STK Object Model.
e Connectis a library of string commands for STK, originally designed to operate over a TCP/IP socket.
e The STK Object Model is an object-oriented interface to STK, built on Microsoft COM technology.
1. Return to STK Programming Help.
2. Choose Using Core Libraries in the contents list.
3. Note the advantages and disadvantages of using each library.

The choice of Connect or Object Model should be driven by the requirements of the application and the
needs of the developer. It is important to note, however, that this need not be an exclusive choice. Connect
commands can be used in a COM application side-by-side with Object Model Code.

Naming conventions

The STK Object Model contains naming conventions for classes, interfaces and enumerations.
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Return to STK Programming Help.
Choose Library Reference in the contents list.
Select STK Object Model.

Select Naming Conventions.

a 0 b~

Note the various naming conventions described on the Naming Conventions Used In the Various Core
Libraries page.

6. Select Abbreviations in the contents list.

7. Note the abbreviations most commonly used in the names of classes, interfaces and other types in the STK
Object Model.

Model diagrams

For the serious programmer, you can use diagrams to see how the STK traffic flow is connected. That way, you
know what's to the right, left, above and below, all while deep-linking to the individual IAg interface pages.

1. Return to STK Programming Help.
. Choose Using Core Libraries in the contents list.
. Select STK Object Model.
. Select STK Objects.

. Select Diagrams.

2
3
4
5
6. Select STK Object Model Diagram (PDF) on the STK Objects Object Model Diagrams page.
7. Zoom into the page for clarification if desired.

8. Take some time to look at the STK 10.0 Object Model Diagrams PDF.

9. Close the STK Object Model Diagram (PDF) when finished.

1

0. Keep STK Programming Help open.

STK Excel Add-in

The STK Excel Add-in is a set of VBA libraries, macros, forms and toolbars that let Excel users interact with STK
and STK scenarios directly from Excel. You can pull data from STK into Excel or pass certain data types from
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Excelinto STK. The STK Excel add-in may already do what you require. At the end of this tutorial, the STK Excel
Add-in tool will be used, so now is a good time to install it on your computer.

1. Go to https://www.agi.com/ in your preferred browser.
2. Click SIGN IN atthe top of the page.

3. Select Sign In in the shortcut menu.

4. Enter your credentials in the Sign In page.

5

. Click SIGNIN .

Downloads
1. After signing in, at the top of the page, select Support.
Select Downloads once the menu opens.
If presented, read the Software License Agreement. Otherwise, go to step 5.
Click ACCEPT .

On the Software Downloads page, locate Data and Auxiliary Extensions.

© oA w N

Select STK Excel Add-in (v12.0.0).

This will download the install file as a zipped folder to your designated download location.

Installing the STK Excel Add-in

1. Go to your download location.

Unzip (Extract All) the STKExcelAdd-in_v12.0.0.zip folder to your preferred location.
Open the extracted (unzipped) STKExcelAdd-in_v12.0.0 folder.

Double-click STKExcelAdd-in_v12.0.0.

If you receive a security warning, click Run .

Run the installer.

Keep STK Programming Help open.

® N O g r @ N

Close any open folders and web pages that your desire.
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Configuring Excel
Enable the Developer tab and the STK Excel Add-in.
1. Launch Excel.

2. Click Blank workbook once Excellaunches.

Excel Developer Tab

Turn on the Developer tab in Excel if you want to create a macro, export and import XML files or insert controls.
If it's not already turned on, complete the following steps.

1. Right-click anywhere on the ribbon.

2. Select Customize the Ribbon...

3. Select Main tabs (if necessary) under Customize the Ribbon shortcut menu in the Excel Options dialog box.
4. Select the Developer check box.
5

. Click OK.

Turning on the STK Excel Add-in
1. Select the Developer tab.

2. Click Excel Add-ins .

3. Select the Stk Add-in 12 X64 check box in the Add-ins dialog box.
4. Click OK.
5

. Close Excel. This is required.
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Creating an Excel Workbook

1. Launch Excel.
Click Blank Workbook.
Select the File menu when the workbook opens.
Click Save As in the contents list on the left.
Select Browse.
Select Desktop in the Save As dialog box.
Select New folder in the menu bar.

Rename New folder to STK_Excel.

© ©® N o g k0 Dd

Click Open .

10. Type STK_Excel_Workbook in the File name: field.
11. Open the Save as type: shortcut menu.

12. Select Excel Macro-Enabled Workbook.

13. Click Save.

Form Control Button
1. Select the Developer tab.
Click Insert .
Click Button (Form Control) in the shortcut menu.
Hold down your left mouse button and draw out a small box (2 cells by 2 cells) in the Excel workbook.

Type Launch_STK in the Macro name: field when the Assign Macro tool dialog box opens.

o ok wbd

Click New .
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Change the Button's Name

1. Bring the Excel workbook to the front.
2. Highlight the button name (e.g. Button 1) in the button.

3. Type Launch STK.

Creating an STK Instance from Excel

You will use the Excel script file to build a simple STK scenario from which you will extract data into Excel. You
can use VB script or the STK object model and for automation you can use your preferred method. STK Connect
will be demonstrated in this tutorial. All the components of Integration are fully documented, and AGI maintains a
GitHub repository of Code samples to help you get started with the STK Object Model (located here:
https://github.com/AnalyticalGraphicsinc/STKCodeExamples). There is a learning curve, so start with

STK Programming Help.

1. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.

2. Create global variables by Typing or copying and pasting the following code inside the Visual Basic editor
above Sub Launch_STK (). This will create global variables.

Dim app
Dim root
Dim scenario

3. Create a new instance of STK. Type or copy and paste the following Code within Sub Launch_STK().

' TASK 1
' Create new instance of STK using the CreateObject Method

Set app = CreateObject("STK.Application")
app.Visible = True
' Expose the STK application root using the Personality2 Property

Set root = app.Personality2

s
4. Click Save STK_Excel_Workbook.xlsm (Ctrl+ S) ().
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Understanding Task 1
Set app = CreateObject("STK.Application")

The CreateObject Method expects a string, in this case STK.Application.
1. Bring STK Programming Help to the front.
Choose Library Reference in the Contents list.
Select Application Object Model.
Select STK Ul Application.
In Classes, Select AgUiApplication on the Project Overview page.
In Interfaces, select IAgUiApplication on the AgUiApplication Object page.

In Public Methods, select CreateObject on the IAgUiApplication Interface page.

©® N O g R DN

In Syntax, look at the [Visual Basic .NET] Syntax on the CreateObject Method (IAgUiApplication) page.

Making STK Visible
app.Visible = True

Visible Property (IAgUiApplication) makes the main window visible.
1. Select Library Reference in the contents list.
2. Select Application Object Model.
3. Select STK Ul Application.
4. Select Properties.
5

. Select Visible Property (IAgUiApplication).

Exposing the STK Application Root
Set root = app.Personality2

Personality2 Property (IAgUiApplication) returns a new instance of the root object of the STK Object Model.
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Select Library Reference in the contents list.
Select Application Object Model.
Select STK Ul Application.

Select Properties.

a 0 b~

Select Personality2 Property (IAgUiApplication).

Running the Sub Routine

You can run the sub routine by clicking the Launch STK button or by selecting the sub routine and clicking the
green Run button.

1. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.

—
2. Click Save STK_Excel_Workbook.xlsm (Ctrl+ S) ().

3. Click inside the Sub Launch_STK () code.

4. Click Run Sub/UserForm (F5) ( b ).

The STK application window appears.

Creating a New STK Scenario

After launching STK, create a new scenario and set the time period.
1. Return to the Excel workbook.
2. Click Insert in the Developer tab.
3. Click Button (Form Control) in the Form Controls window.

4. While in the Excel workbook, hold down your left mouse button and draw out a new button below the
Launch STK button.

Type Create_Scenario in the Macro name: field when the Assign Macro dialog box opens.
Click New .

Return to the Excel workbook.

© N O O

Change the name of Button 2 to Create Scenario.
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9. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.

10. Type or copy and paste the following Code within Sub Create_Scenario ().

' TASK 2

' Create a new scenario.
root.NewScenario("New_Scenario")

Set scenario = root.CurrentScenario

' Set the analytical time period.

notUsed = scenario.SetTimePeriod("Today", "+24hr")
' Reset the animation time.

notUsed = root.Rewind()

You will create a new scenario called New_Scenario.

Sub Create Scenario()

' TASK 2

' Create a new scenario.

root.NewScenario ("New Scenario™)

Set scenario = root.CurrentScenario

' Set the analytical time period.

notUsed = scenario.SetTimePeriod ("Today™, "+24hr")
' Reset the animation time.

notUsed = root.Rewind/()

End Suk

Task 2 Code

—
11. Click Save STK_Excel_Workbook.xlsm (Ctrl+ S) ().

Understanding Task 2

This section will show you another way to use STK Programming Help.

Understanding NewScenario Method
NewScenario Method (IAgStkObjectRoot) creates a new scenario and expects a scenario name as a string.

You use this method in line 3 of Task 2: root.NewScenario ("New_Scenario")
1. Return to STK Programming Help.
2. Type NewScenario in the search field.
3. Click Enter.

4. Select STKObjects~IAgStkObjectRoot™NewScenario.
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Understanding CurrentScenario Property

CurrentScenario Property (IAgStkObjectRoot) returns a Scenario object or null if no scenario has been loaded
yet.

You use this method in line 4 of Task 2: Set scenario = root.CurrentScenario
1. Return to STK Programming Help.
2. Type CurrentScenario in the search field.
3. Click Enter.

4. Select STKObjects~IAgStkObjectRoot™CurrentScenario.

Understanding SetTimePeriod()

SetTimePeriod Method (IAgScenario) sets the Scenario time period. startTime/stopTime use DateFormat
Dimension.

You use this method in line 6 of Task 2: notUsed = scenario.SetTimePeriod("Today", "+24hr")
1. Return to STK Programming Help.
2. Enter SetTimePeriod in the search field.
3. Click Enter.

4. Select STKObjects~IAgScenario™SetTimePeriod.

Understanding Rewind()
Rewind Method (IAgAnimation) is used to stop and reset the animation.

You use this method in line 8 in Task 2: notUsed = root.Rewind()
1. Returnto STK Programming Help.
2. Type Rewind in the search field.
3. Click Enter.
4

. Select STKObjects~IAgAnimation~™Rewind.C
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Summary of Task 2

In Task 2, you are creating a Scenario object named New_Scenario and setting its analysis time from midnight
local time based on your time zone (Today) and running the scenario for 24 hours. Then you are essentially
clicking the red Reset button in the Animation Toolbar of STK to reset your scenario time.

STK Programming Help Search Examples

These were two examples of using STK Programming Help. When you are looking at Code snippets and such,
in the search window, you can type something from the Code such as Personality2 and it will provide choices to
select from. It would take a long time to browse the STK Programming Help throughout this tutorial, so
hyperlinks are used to simplify and speed things up. However, practice makes perfect, so feel free to search on
your own.

Running Both Sub Routines
1. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.
Click Save (Ctrl+ S) () in STK_Excel_Workbook.xlsm.
Bring the Excel workbook to the front.
Click Launch STK.

Click Create Scenario once STK opens.

o a0 k0w N

Bring STK to the front.

Viewing the Scenario object properties
1. Right-click on New_Scenario (ﬁ) in the Object Browser.

2. Select Properties (IEI).

3. Note the Analysis Period Start: and Stop: times when the Properties Browser opens.

4. Click Cancel to close the New_Scenario's (ﬁ) properties (IEI).
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5. Look at Current Scenario Time in the Animation Toolbar. You set it for midnight local time (Today). You will
see that the code reset it to the equivalent UTCG date and time.

6. Return to the Excel workbook.

Configuring Target1 Objects

Populate the scenario by inserting 25 Target (E) objects.

1. Type the following column headers into Excel:

Cell Value
F1 Target Name
G1 Latitude
H1 Longitude
2. Selectcell F2.
3. Enter Target.
4. Select cell G2.
5.

Copy and paste the following Excel RAND function into the Formula Bar:
=(RAND()-0.5)*180

6. Click Enter . The Excel RAND function returns a random number between 0 and 1. This Code will return a
random number between -90 and 90.

7. Select cell H2.

(0]

. Copy and paste the following Excel RAND function into the Formula Bar:
=(RAND()-0.5)*360

9. Click Enter . This Code will return a random number between -180 and 180. Your values will be different
from the image.
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Creating Multiple Targets and Random Latitudes and Longitudes
1. Selectcell F2.
Hold the Shift key and select cell H2.

Place your cursor on the small black box located at the lower right corner of cell H2.

N

Hold down your left mouse button and drag the black box to cell H26 and release your mouse button. This
will create 25 targets and 25 random latitudes and longitudes (your values will be different than the
example).

—
5. Click Save (Ctrl+ S) () while in the Excel workbook.

Inserting the Targets into STK

Insert the targets into STK using Target (E) objects.

—

. Click Insert in the Developer tab.
2. Click Button (Form Control) in the Form Controls window.

3. While in the Excel workbook, hold down your left mouse button and draw out a new button below the Create
Scenario button.

Type Insert_Targets in the Macro name: field of the Assign Macro dialog box.
Click New .
Return to the Excel workbook.

Change the name of Button 3 to Insert Targets.

© N o o =

Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.
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9. Type or copy and paste the following Code within Sub Insert_Targets().

' TASK 3

' Add a target object to the scenario.

For i = 2 to 26

Dim target

Set target = root.CurrentScenario.Children.New(23, Range("F" & i).Value)

' Move the Target object to a desired location.

notUsed = target.Position.AssignGeodetic(Range("G" & i).Value, Range("H" &
i).value, 0.0)

Next

10. Click Save (Ctrl+ S) () in STK_Excel_Workbook.xIsm.

Understanding Task 3

Review the following sections to learn more about each line of Task 3 and discover resources in the STK
Programming Help.

Understanding how to loop through rows in the code

You are looping through rows 2 to 26 of your Excel workbook. You create a new Target object on each line for 25
targets total.

You use aloopinline 3 of Task 3: Fori=2to0 26

Understanding the CurrentScenario Method

You use the CurrentScenario Method in line 5 of Task 3: Set target = root.CurrentScenario.Children.New(23,
Range("F" & i).Value)

You will navigate to the CurrentScenario Method in the STK Programming Help for more information.
1. Return to STK Programming Help.
2. Type currentscenario in the search field.
3. Click Enter.

4. Select STKObjects~IAgStkObjectRoot™CurrentScenario from the search results.
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5. Select IAgStkObject in the Visual Basic .NET Syntax list.

6. Select Children in Public Properties.

Children Property

Children Property (IAgStkObject) returns a collection of direct descendants of the current object.
1. Select IAgStkObjectCollection from the Visual Basic .NET Syntax list.

2. Select New In Public Methods.

New Method

New Method (IAgStkObjectCollection) creates an STK object using specified class and instance name.
1. Select AGESTKObjectType from the Visual Basic .NET Syntax list.

AgESTKODbjectType Enumeration shows the object type enumerations, associated value and the STK
objects.

2. Scroll down the Member list until you locate eTarget. To insert a new Target (E) object, you can use
eTarget or the value 23. Your code uses the value 23.

Next, STK wants a string for the name. You want the name in cell F2. To use all the target names, in VBA,
you use Range. You want cell F and the ampersand (&) allows you to concatenate strings. It will startin F2
and finish in F26.

Assigning Locations of objects

In short, the Position Property gets the position of the target. The AssignGeodetic Method is a helper method to
assign the position using the Geodetic representation. Learn more about the Position Property (IAgTarget) and
the AssignGeodetic Method (IAgPosition) in the STK Programming Help.

You use both of these method in line 7 of Task 3: notUsed = target.Position.AssignGeodetic(Range("G" &
i).Value, Range("H" & i).Value, 0.0)

Within the AssignGeodetic method:
* Range("G" & i).Value will read cells G2 though G26 for the latitudes.

¢ Range("H" & i).Value, 0.0) will read cells H2 though H26 for the longitudes. The altitude is 0.0 for all the
targets which will place them on top of the WGS84 ellipsoid if you don't have terrain or on top of the terrain if
you're using terrain such as Terrain Server. In the Code, Excel converts the value 0.0 is converted to 0#.
(Don't worry about it.)
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Running all three sub routines

1. Bring the Excel workbook to the front.

2. Click Launch STK in the Excel workbook.

3. Click Create Scenario once STK opens.

4. After the scenario is created, click Insert Targets .
5

. Bring STK to the front.

You created an instance of STK, created a scenario with a 24 hour analysis period and inserted 25 random
Target objects around the Earth.

Inserting a Satellite Object into STK

You have launched STK, created a new scenario, set the time period and inserted 25 randomly placed Target (

E) objects. Now you will insert and propagate a Satellite (%) object.

1. Return to the Excel workbook.

2. Click Insert in the Developer tab.

3. Click Button (Form Control) in the Form Controls window.

4. While in the Excel workbook, hold down your left mouse button and draw out a new button below the Insert
Targets button.

5. Type Insert_Satellite in the Macro name: field of the Assign Macro dialog box.

6. Click New .

7. Bring the Excel workbook to the front.

8. Change the name of Button 4 to Insert Satellite.

9. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.
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10. Type or copy and paste the following Code within Sub Insert_Satellite ().

' TASK 4
' Add a Satellite object to the scenario.

Dim satellite

Set satellite = root.CurrentScenario.Children.New(18, "LeoSat")

' Propagate the Satellite object's orbit.

root.ExecuteCommand ("SetState */Satellite/LeoSat Classical TwoBody
UseScenarioInterval 60 ICRF ""UseAnalysisStartTime"" 7200000.0 0.0 90 0.0
0.0 0.0")

—
11. Click Save (Ctrl+ S) () in STK_Excel_Workbook.xIsm.

Understanding Task 4

Review the following sections to learn how each line of Task 4 works.

Understanding the Children Property in Task 4

You use the Children property to insert a Satellite (%) object in this case. This code uses the value 18 which
loads a Satellite (%) object into your scenario called LeoSat. Previously, you used similar code to insert a
Target (E) object into the scenario.

You used this property in line 4 of Task 4: Set satellite = root.CurrentScenario.Children.New(18, "LeoSat")

Understanding the ExecuteCommand() Method

You use the ExecuteCommand Method to propagate the Satellite (%) object. In general, the method executes
a custom CONNECT action. Learn more about the connect command ExecuteCommand Method
(IAgStkObjectRoot) in the STK Programming Help.

You used this method in line 6 of Task 4: root.ExecuteCommand ("SetState */Satellite/LeoSat Classical
TwoBody UseScenariolnterval 60 ICRF ""UseAnalysisStartTime"" 7200000.0 0.0 90 0.0 0.0 0.0")

SetState Connect Command

Look at the Alphabetical Listing of Connect Commands to understand the SetState connect command.
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Return to STK Programming Help.

Choose Library Reference in the Contents list.

Select Connect Command Library.

Click Alphabetical Listing of Connect Commands from the Connect Command Listings page.
Click S at the top of the Alphabetical Listing page.

Select the SetState Classical command.

N o ok b2

Scroll through the SetState Classical page and note the following:
e Syntax will help you understand the input values of your SetState command.
e The description chart explains each input and its associated unit.

» Inthe Examples section, there are multiple examples that can be copied and edited for your particular
scenario.

Running all four sub routines
1. Return to the Excel workbook.
Click Launch STK.
Click Create Scenario once STK opens.
After the scenario is created, click Insert Targets .

After the targets are inserted, click Insert Satellite .

o a0k wbd

Bring STK to the front.

You created an instance of STK, a scenario with a 24 hour analysis period, inserted 25 random Target (E)

objects around the Earth and inserted and propagated a Satellite (%) object.

Creating an Access

Determine when the LeoSat (%) can access Target1 (E).
1. Return to the Excel workbook.

2. Click Insert inthe Developer tab.
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3. Click Button (Form Control) in the Form Controls window.

4. While in the Excel workbook, hold down your left mouse button and draw out a new button below the Insert
Satellite button.

5. Type Compute_Access in the Macro name: field of the Assign Macro dialog box.
6. Click New .
7. Bring the Excel workbook to the front.
8. Rename Button 5 to Compute Access.
9. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.
10. Type or copy and paste the following Code within Sub Compute_Access ().

' TASK 5

' Compute Access between the satellite and the target

Dim sat

Set sat = root.GetObjectFromPath("Satellite/LeoSat")

Dim tarl

Set tarl = root.GetObjectFromPath("Target/Targetl")
Dim access

Set access = sat.GetAccessToObject(tarl)

'Compute access

access2 = access.ComputeAccess()

Understanding Task 5

Review these sections to understand more about Task 5.

Understanding GetObjectFromPath()

In short, the method gets the object instance that matches the path provided. Learn more about the
GetObjectFromPath Method (IAgStkObjectRoot) in the STK Programming Help.

You use this method in lines 4 and 6 from Task 5:
Set sat = root. GetObjectFromPath("Satellite/LeoSat")

Set tar1 = root.GetObjectFromPath("Target/Target1")
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Understanding the GetAccessToObject()

In short, the method returns an IAgStkAccess object to compute access to. Learn more about the
GetAccessToObject Method (IAgStkObject) in the STK Programming Help.

You use this method in line 8 from Task 5: Set access = sat.GetAccessToObject(tar1)

Understanding the ComputeAccess() Method

In short, the ComputeAccess() recomputes the access between two objects. Learn more about the
ComputeAccess Method (IAgStkAccess) in the STK Programming Help.

You use this method in line 10 in Task 5: access2 = access.ComputeAccess()

Data Providers

The content of a report or graph is generated from the selected data providers for the report or graph style. You
can view data providers, groups and elements when using the Report & Graph Manager inside of STK. Data
providers are also broken out in detail in STK Programming Help.

1. Return to STK Programming Help.

2. Select Library Reference in the Contents list.
3. Select Data Providers Reference.
4.

On the Data Providers by Object page, you can spend a lot of time looking at an object's data providers,
groups and elements.

5. Keep this page open.

Retrieve and View the Access Data in Excel

You created an access from LeoSat (% ) to Target1 (E). Retrieve and view the access data in Excel.
1. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.

2. Type or copy and paste the following Code at the bottom of the Sub Compute_Access|().
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' TASK 6

' Pull the data of interest out of the access object
Dim dp

Set dp = access.DataProviders("Access Data")

Dim results

Set results = dp.Exec(scenario.StartTime, scenario.StopTime)
accessNumber = results.DataSets(0@).GetValues()
accessStart = results.DataSets(1).GetValues()
accessStop = results.DataSets(2).GetValues()
accessDuration = results.DataSets(3).GetValues()

' Create columns

Range("J1") = results.DataSets(@).ElementName
Range("K1") = results.DataSets(1).ElementName
Range("L1") = results.DataSets(2).ElementName
Range("M1") = results.DataSets(3).ElementName

' Write the data into Excel.

For i = @ To UBound(accessNumber)

Range("J" & i + 2) = accessNumber(i)
Range("K" & i + 2) = accessStart(i)
Range("L" & i + 2) = accessStop(i)
Range("M" & i + 2) = accessDuration(i)
Next

—
3. Click Save STK_Excel_Workbook.xlsm ().

Understanding Task 6

Review the sections to learn about the different methods and properties in Task 6. Also, you will discover
resources in the STK Programming Help to understand these methods and properties further.

Understing the DataProviders Property

The DataProviders Property returns the object representing a list of available data providers for the object. Learn
more about the DataProviders Property (IAgStkAccess) in the STK Programming Help.

You use this property in line 4 of Task 6: Set dp = access.DataProviders("Access Data")
1. Return to STK Programming Help.

2. Select Access on the Data Providers by Object page. This page provides data providers available for the
Access object.

3. Select Access Data in the Available Data Providers list. Access Data is the specified data provider.
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4. Select Access in the Data Provider Variants list.

5. Look at the Data Provider Elements list to understand the following code.

Understanding the Exec() Method

The Exec Method computes the data within a specified Start and Stop time. Learn more about the Exec Method
(IAgDataPrvTimeVar) in the STK Programming Help.

You use this method in line 6 of Task 6: Set results = dp.Exec(scenario.StartTime, scenario.StopTime)

Understanding the DataSets() Property and the GetValues Method

The DataSets() Property returns a collection of data sets within a specified interval. The GetValues retrieves an
array of values of the elements in the dataset. In this instance, you're creating an access from the satellite to the
target based on the scenario start and stop times.

When pulling data from the data provider elements list, it follows the sequence as seen in the list. For example,
the first element, Access Number, is 0 (zero). Start Time is 1 (one), Stop Time is 2 (two) and Duration is 3
(three). In the code, accessNumber = results.DataSets(0).GetValues() simply means that you are you are
pulling the results from the data provider (Access Data) and then the data provider element Access Number.

You can learn more about the DataSets Property (IAgDrlInterval) and the GetValues Method (IAgDrDataSet) in
the STK Programming Help.

You use this property and method in lines 7 to 10 of Task 6:
accessNumber = results.DataSets(0).GetValues()
accessStart = results.DataSets(1).GetValues()
accessStop = results.DataSets(2).GetValues()

accessDuration = results.DataSets(3).GetValues()

Understanding the ElementName Property

You use the DataSets() Property again, but you pair that property with a new one. The ElementName Property
returns the name of the dataset. In Task 6, you are writing the element names as headers for columns J1
through M1. Learn more about the ElementName Property (IAgDrDataSet) in the STK Programming Help.

You use this property in lines 12 to 15 of Task 6:

Range("J1") = results.DataSets(0).ElementName
Range("K1") = results.DataSets(1).ElementName
Range("L1") = results.DataSets(2).ElementName
Range("M1") = results.DataSets(3).ElementName
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Understanding filling the data in your table

You use a loop to add data to your table in line 17 to 21 in Task 6:
Fori=0 To UBound(accessNumber)

Range("J" & i + 2) = accessNumber(i)

Range("K" & i + 2) = accessStart(i)

Range("L" & i + 2) = accessStop(i)

Range("M" & i + 2) = accessDuration(i)

You will loop through all the data that it returns and write it to the appropriate cell.

Run all five sub routines

1. Bring the Excel workbook to the front.

2. Click Launch STK.

3. Click Create Scenario once STK opens.

4. After the scenario is created, click Insert Targets .

5. Afterthe targets are inserted, click Insert Satellite .

6. After the satellite is inserted, click Compute Access . Your data will look similar to but different than the
following example.

Format cells

Excelformats the start and stop times differently than SKT (e.g. day, month, year, time). You can select the cells
containing the start and stop times, right-click on the selection, open the Format Cells option and set the format
to dd mmm yyyy hh:mm:ss.000. Or you can use the following Code.

1. Bring the Microsoft Visual Basic for Applications - [Module 1 (Code)] window to the front.

2. Type or copy and paste the following Code at the bottom of the Sub Compute_Access().
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Selection.NumberFormat = "dd mmm yyyy hh:mm:ss.000"
ActiveSheet.Columns("L").Select
Selection.NumberFormat = "dd mmm yyyy hh:mm:ss.000"

ActiveSheet.Columns("K").Select

—
Click Save STK_Excel_Workbook.xlsm (Ctrl+ S) ().
Bring the Excel workbook to the front.

Click Compute Access . Your data will look similar to but different than the following example.

Click Save ().

o a koW

STK Excel Add-in

At the beginning of the tutorial, you downloaded and installed the STK Excel Add-in. Use that now.

1. Select the Add-ins tab.

Attaching the Excel Workbook to STK
Since you already have a running instance of STK, you can attach Excelto your scenario.

1. Select cell P in the Excel workbook. You want an empty cell plus three empty cells to the right. You will be
choosing four elements.

2. Click Create or Attach to STK 12 (|:|) from the Custom Toolbars.
3. Select Attach to an existing STK 12 application instance.

4. Click OK to close the information window.

5. Click Extract Data From an STK 12 Data Provider ) to open the Generate Data Provider Report tool.
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Selecting your data providers

1. Select Satellite/LeoSat from the object list.

2. Expand (#) LLA State (Data Provider) in the Data Providers: list.

3. Expand (#) Fixed.

4. Select the following data provider elements.

* Time
o Lat

e Lon
o Alt

5. Use the default Start Time and Stop Time values.

6. Change Step (sec): to 3600. This will make the data easier to read.

7. Click Generate .

8. Close the Generate Data Provider Report tool.

9. You can expand columns P/Q/R/S in the Excel workbook if desired to see all of the data.
You can see the Time, Latitude, Longitude, and Altitude of the satellite in one hour increments over the 24
hour analysis period.

Summary

You began by viewing a small portion of the STK Programming Help pages. Then you performed the following:
e Downloaded and installed the STK Excel Add-in.
¢ Opened Excel and enabled the Developer tab and turned on the STK Excel Add-in.
¢ After closing and then opening Excel, you created an Excel Macro-Enabled Workbook (*.xIsm).
» Created the first button and code which launched an instance of STK.

¢ Created the second button and code to create a new Scenario object with a run time of 24 hours and reset
the scenario to the new analysis time period.
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¢ In the Excelworkbook, you created three columns: Target Name, Latitude and Longitude. In the Latitude
column, you set a random number formula that entered values between -90 and 90. In the Longitude
column, you set a random number formula that entered values between -180 and 180. You created 25
random targets.

e Created the third button and code which loaded 25 random Target objects into the scenario.
¢ Created a fourth button and code which propagated a LEO Satellite in the scenario.

e Created a fifth button and code that computed access between the Satellite object and a Target object and
imported the access times into Excel.

e Changed the fifth button code to format the access times to match the format in STK.

¢ Used the STK Excel Add-in to import selected LLA Data Provider Elements concerning the Satellite object
into Excel.
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